
 

Oracle® Argus Insight
User’s Guide  

Release 7.0 

E22886-01

April 2011



Oracle Argus Insight User's Guide, Release 7.0  

E22886-01

Copyright © 2011 Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on 
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your 
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, 
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse 
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is 
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If 
you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on 
behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data 
delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As 
such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and 
license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of 
the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software 
License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not 
developed or intended for use in any inherently dangerous applications, including applications which may 
create a risk of personal injury. If you use this software in dangerous applications, then you shall be 
responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure the safe use 
of this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of 
this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks 
of their respective owners.

This software and documentation may provide access to or information on content, products, and services 
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all 
warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and 
its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of 
third-party content, products, or services.



iii

Contents

User’s Guide,  i

Preface ...............................................................................................................................................................   viii

Audience.....................................................................................................................................................    viii
Documentation Accessibility ...................................................................................................................    viii
Conventions .................................................................................................................................................    ix

1 Introduction 

Argus Insight Overview..........................................................................................................................   1-1
Argus Insight Overview....................................................................................................................   1-1

Argus Insight Components .......................................................................................................   1-1
Argus Insight Process Flow.......................................................................................................   1-2

2 Upgradability and Compatibility 

About Upgradability and Compatibility .............................................................................................   2-1
Upgrade Path......................................................................................................................................   2-1
Product Compatibility.......................................................................................................................   2-2
Copy Configuration ...........................................................................................................................   2-2

Upgrading to the Argus Insight 7.0 Multi-tenant Environment..........................................   2-2
Exporting the Configuration Data to Argus Insight 7.0........................................................   2-4

3 Getting Started 

Using Argus Insight.................................................................................................................................   3-1
Getting Started....................................................................................................................................   3-1

Single Sign On .............................................................................................................................   3-2
Logging In ....................................................................................................................................   3-3
Changing the Password .............................................................................................................   3-4
Changing the Default Home Page............................................................................................   3-4
Configuring the Argus Insight Application............................................................................   3-5
Entering Dates in Various Argus Insight Fields.....................................................................   3-5
Getting Help ................................................................................................................................   3-7
Logging Out.................................................................................................................................   3-7



iv

4 Creating Queries 

Creating Queries.......................................................................................................................................   4-1
QBE.......................................................................................................................................................   4-1

Creating a New QBE...................................................................................................................   4-2
Assign group-level permissions on the saved QBE...............................................................   4-6
Working with the Last Modified or Executed QBE ............................................................    4-37
Working with Saved QBEs .....................................................................................................    4-39
Using QBEs with Advanced Conditions ..............................................................................    4-46

Filters.................................................................................................................................................    4-49
Using Predefined Filters .........................................................................................................    4-51
Creating Custom Filters ..........................................................................................................    4-58
Working with the Last Modified or Executed Value Set ...................................................    4-65
Working with Saved Filters and Value Sets.........................................................................    4-67
Using Filters with Advanced Conditions.............................................................................    4-73

Advanced Conditions.....................................................................................................................    4-76
Creating a New Advanced Condition ..................................................................................    4-76
Working with the Last Modified or Saved Advanced Condition.....................................    4-88
Working with Saved Advanced Conditions ........................................................................    4-90

Library ..............................................................................................................................................    4-97
Associated Reports Library ....................................................................................................    4-97
Query Library ...........................................................................................................................    4-99

5 Working with Case Series 

Working with Case Series.......................................................................................................................   5-1
General Usage Information ..............................................................................................................   5-2

Case Series Hyperlink to Medical Review ..............................................................................   5-2
Freezing Case Series Data..........................................................................................................   5-3

Working with the Last Generated Case Series...............................................................................   5-5
Saving the Case Series ................................................................................................................   5-7
Viewing Case Series Generation Criteria within the Query Interface ................................   5-7
Viewing the Case Series Generation Criteria in a Single Page.............................................   5-8
Modifying the Case Series .........................................................................................................   5-8
Deleting a Case from a Case Series ..........................................................................................   5-9

Working with Saved Case Series ..................................................................................................    5-10
Searching for a Saved Case Series .........................................................................................    5-11
Making a Case Series Active ..................................................................................................    5-11
Modifying a Case Series..........................................................................................................    5-11
Merging Case Series ................................................................................................................    5-12
Importing a Case Series from an External Source...............................................................    5-13
Deleting a Case Series..............................................................................................................    5-14
Viewing the Details of the Query that Generated the Case Series ...................................    5-15

Sharing Case Series with Argus Safety Web...............................................................................    5-15
Exporting Case Series to Excel ......................................................................................................    5-16

6 Generating Standard Reports   

General Report Usage Information ......................................................................................................   6-1



v

Using Reports .....................................................................................................................................   6-2
Executing Reports .......................................................................................................................   6-2
Event-Level Reporting ...............................................................................................................   6-4
Report Scheduling.......................................................................................................................   6-5

Standard Reports ...................................................................................................................................    6-10
Reports - Cover Page ......................................................................................................................    6-10
Compliance Reports........................................................................................................................    6-12
Configuration Reports....................................................................................................................    6-14
General Reports ...............................................................................................................................    6-14
Management Reports......................................................................................................................    6-16
Pharmacovigilance Reports ...........................................................................................................    6-18

7 Creating Custom Reports  

Creating Custom Reports........................................................................................................................   7-1
General Report Writer Information.................................................................................................   7-1
Creating a New Report......................................................................................................................   7-2

Using Case Series Criteria and Case Series Name in new Report. ......................................   7-6
Using Case Series Criteria and Name with Other Objects....................................................   7-6

Editing Reports................................................................................................................................    7-11
Filtering Data ............................................................................................................................    7-12
Sorting Data ..............................................................................................................................    7-13
Summarizing Data ...................................................................................................................    7-14
Formatting Data in Cells .........................................................................................................    7-16
Performing Calculations .........................................................................................................    7-16

Changing the Report Layout .........................................................................................................    7-17
Creating a Chart .......................................................................................................................    7-18
Grouping by Row Headings ..................................................................................................    7-19
To Ungroup a Report...............................................................................................................    7-20
Creating Crosstab Reports......................................................................................................    7-21
Running the Report in Specific Formats...............................................................................    7-25

Saving and Accessing Saved Reports...........................................................................................    7-26
Saving Reports..........................................................................................................................    7-27
Accessing Report Writer Library ...........................................................................................    7-28

Using SMQs in Report Writer .......................................................................................................    7-28
Using SMQs ..............................................................................................................................    7-29

Using Case Annotations.................................................................................................................    7-31
Using Case Annotations..........................................................................................................    7-32

8 Using Cubes  

Using Cubes ..............................................................................................................................................   8-1
Cubes Available in Argus Insight....................................................................................................   8-1

Compliance Cubes ......................................................................................................................   8-2
Submission Statistics ..................................................................................................................   8-2
Management Cubes ....................................................................................................................   8-3
Administration Statistics............................................................................................................   8-3
Pharmacovigilance Cubes..........................................................................................................   8-4



vi

Clinical Trial Analysis ................................................................................................................   8-4
Medical Analysis.........................................................................................................................   8-5
Overdose-Pregnancy-Interaction..............................................................................................   8-6

Working with Cubes..........................................................................................................................   8-8
Executing a Cube ........................................................................................................................   8-8
Performing Drill Operations ..................................................................................................    8-10
Filtering Data ............................................................................................................................    8-11
Removing the Filter .................................................................................................................    8-12
Replacing Rows and Columns ...............................................................................................    8-12
Grouping Multiple Rows and Columns by a Dimension or Category ............................    8-13
Creating Charts ........................................................................................................................    8-15
Exporting the Cube Output to Specific Formats .................................................................    8-17
Changing Measures .................................................................................................................    8-18
Modifying a Cube ....................................................................................................................    8-19
Deleting a Cube ........................................................................................................................    8-21
Setting Access Permissions.....................................................................................................    8-21
Creating Demand Cubes.........................................................................................................    8-22
Demand Cube Life Span .........................................................................................................    8-24
Saving Cubes Views ................................................................................................................    8-25
Viewing Saved Cubes..............................................................................................................    8-27
Refreshing Cubes .....................................................................................................................    8-27

9 Multi Tenancy 

Assumptions and Constraints................................................................................................................   9-1
Data Segregation ......................................................................................................................................   9-2

Module-wise Impact ..........................................................................................................................   9-2
Enterprise Short Name in Argus Insight ........................................................................................   9-4

Single Sign On ..........................................................................................................................................   9-4
Login and Navigation ..............................................................................................................................   9-5

Description ..........................................................................................................................................   9-5
Changes to Power Queries and Case Series ........................................................................................   9-6

Importing a Case Series.....................................................................................................................   9-7
Modifying a Case Series ....................................................................................................................   9-7

Importing a Case Series ..........................................................................................................................   9-8
Modifying a Case Series .........................................................................................................................   9-8
Exporting a Case Series ...........................................................................................................................   9-8
Global Homepage ....................................................................................................................................   9-8
Application Access Portlet......................................................................................................................   9-8
Global Enterprise Management Portlet ...............................................................................................   9-9
Global User Management Portlet.......................................................................................................    9-12
Common Profile Switches ...................................................................................................................    9-12
ETL Scheduler ........................................................................................................................................    9-15
Changes to Reports ...............................................................................................................................    9-15

Report Changes in the Argus Insight User Interface .................................................................    9-15
Report Changes in the Cognos Environment .............................................................................    9-15
Changes in Custom Reports ..........................................................................................................    9-16



vii

Report Changes while Saving and Accessing Report Writer Reports through Cognos Query 
Studio and Argus Insight   9-16

Changes to Cubes ..................................................................................................................................    9-17
Changes in Standard Cubes and Demand Cubes ......................................................................    9-17

Glossary



viii

Preface

Audience
This document is intended for all Argus Insight administrators.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services
To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer 
Assistant will relay information between the customer and Oracle Support Services at 
1.800.223.1711. Complete instructions for using the AT&T relay services are available at 
http://www.consumer.att.com/relay/tty/standard2.html. After the 
AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support 
Services engineer will handle technical issues and provide customer support according 
to the Oracle service request process.
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Conventions
The following text conventions are used in this document:

Convention Description

Note A Note identifies information you should be aware of before 
proceeding with the current task.

Bold Text Bold text is used to emphasize words such as does not and must. 
It is also used to identify user interface elements such as buttons, 
dialog boxes, check boxes, combo boxes, drop-down lists, labels, 
option (radio) buttons, tabs, text boxes, etc.

Italic Text Italic text identifies information that may appear on the screen 
(such as error message) or information the user must provide.

UPPERCASE TEXT Uppercase text identifies keyboard keys. For example, SHIFT, 
ENTER, CTRL, etc.

Bold Underline Identifies a link indicating that additional information is available.

Initial Capitals Initial capitals are used to identify modules, applications, proper 
nouns, etc.
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1Introduction

Argus Insight Overview
This manual describes the various components of Argus Insight and explains the 
interaction between them.

Argus Insight Overview
This topic explains the typical workflow followed in Argus Insight to generate a report.

■ Argus Insight Components

■ Argus Insight Process Flow

Argus Insight Components
In Argus Insight, you can generate a report in either of the following ways:

■ Use a query to retrieve a specific set of cases (Case Series) from the datamart and 
then run a predefined report for those cases. Use the following Argus Insight 
components to retrieve the Case Series:

– Query By Example (QBE)

– Filters

– Advanced Conditions

■ Run one of the following reports on the Case Series to create and store these in the 
Reports Library:

– Built-in Standard Reports

– Custom Reports

■ Create custom reports and analyze the data using the Report Writer, Cubes and 
Dashboard Indicators.

■ Use Report Writer, Cubes and Dashboard Indicators to:

– Directly query the datamart

– Generate reports from the datamart using the Dashboard Indicators 
component. Dashboard Indicators are pre-configured by the administrator.
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The following table describes the various components of Argus Insight:

Argus Insight Process Flow
The following flowchart depicts the set of steps that are typically followed in Argus 
Insight to generate a report. Please refer to your company's guidelines for the exact 
workflow for generating reports and analyzing data in Argus Insight.

Note: The Report Writer is primarily used to directly query the 
datamart and create custom reports. However, you can apply the 
active Case Seriesfilter on the reports to reduce the data set and 
improve report performance. Please note, that the Case Series might 
become obsolete each time the datamart is refreshed by running an 
ETL. This is because new cases with similar attributes might get 
added to the datamart.

Component Description

Query by Example 
(QBE)

Lets you create simple queries by entering specific values in fields on a form that 
looks substantially like the Argus Safety case form

Filters Lets you create queries by selecting a set of predefined fields and specifying 
multiple values in a field

Advanced 
Conditions

Lets you create complex queries by selecting any of the various different fields in 
the datamart and applying Boolean and Set operations on them

Case Series A listing of cases that match the query criteria

Standard Reports Predefined reports built into Argus Insight These reports are grouped into these 
categories: Compliance, Management, Pharmacovigilance, Configuration, and 
General Typically, these reports are run on the Case Series

Report Writer Lets you directly query the datamart and create custom reports by selecting any 
datamart fields as report columns; in the report output, you can apply filters, 
create nested groupings, and perform operations such as sort, total, count, and 
drill

The custom reports you create can be stored in the Report Writer Library or added 
to the Argus Insight application; you can run the stored reports on a Case Series

Cubes Lets you run complex queries on the datamart and statistically analyze, 
drill-down, and explore the results

Argus Insight has six predefined Cubes: Reporting-Compliance, Workflow, 
Pharmacovigilance-Detail, Pharmacovigilance-General, 
Pharmacovigilance-Clinical, and Pharmacovigilance-Interaction

Dashboard Indicators Special reports that provide an insight into key parameters that let you monitor 
product performance and workflow efficiency Dashboard Indicator reports are 
pre-configured by the administrator and are generated directly from the datamart
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The following table describes the tasks shown in the process flow diagram.

Task Description

Log on to Argus 
Insight

Log on to the Argus Insight application.

Create a Query Depending on the complexity of the query, use these Argus Insight 
components to create a query:

■ Query by Example (QBE) - to create simple queries based on the fields in 
Argus Case Form

■ Filters - to create queries based on multiple values in a set of predefined 
fields

■ Advanced Conditions - to create complex queries by directly selecting 
datamart fields and applying Boolean and Set operations on them

Execute the Query to 
Generate a Case 
Series

Execute the query to have the system search the entire datamart and retrieve a 
list of cases (Case Series) that match the criteria you specified while creating 
the query.

Generate Standard 
Reports on the Case 
Series

Select and run a built-in Standard Report. You can limit this report to only run 
on the Case Series.

Generate Custom 
Reports on the Case 
Series

Select and run a custom report you created and stored in the Report Writer 
Library. You can limit this report to only run on the Case Series.

Query the Datamart Use the Report Writer, Cubes, or Dashboard Indicators, to directly query the 
datamart and generate the required report.

■ Use the Report Writer to create new reports

■ Perform data analysis using Cubes

■ View the Dashboard Indicator Reports
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2Upgradability and Compatibility

About Upgradability and Compatibility
It is essential for any software to be upgradable to higher versions as well as 
compatible with multiple versions. This chapter describes about the upgrade and 
compatibility of Argus Insight.

Upgrade Path
You can upgrade directly to this version of Insight from Argus Insight version 5.1. 
After completing the upgrade, you must execute an initial ETL. 

Argus Insight 5.1 single-tenant users can upgrade to Argus Safety 7.0 multi-tenant 
environment. 

The Argus Insight 5.1 single-tenant users can upgrade to Argus Safety 7.0 
single-tenant users by using the Migration Utility. This utility overwrites any 
configuration data existing for an enterprise. It is necessary for all such upgrade that 
Argus Safety be upgraded to 7.0.

The upgrade path is to be as follows - 

 i. Upgrade Argus Safety application to Argus Safety 7.0 (this step is required only for 
multi tenant environment).

 ii. Install Argus Insight 7.0 application (in multi tenant mode if Argus Safety is 
installed in multi tenant mode).

 iii. Create the enterprise in Argus Insight

 iv. Run the Migration Utility for that enterprise.  

 v. Run the Initial ETL.

The Migration Utility supports copying the entire Argus Insight specific configuration 
(including Case Series Freezing data) from a single tenant Argus Insight 5.1 
application to Argus Insight 7.0 single/multi tenant application after setting an 
Enterprise ID. 

It is possible to set an appropriate Enterprise ID during the configuration copy.

User-specific configuration data is copied only for those users in an enterprise who 
also exists in Argus Safety for that enterprise.

Existing customers should configure the User Roles section.
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Global Profile switches cannot be updated by the migration utility.

Product Compatibility
This version of Insight is compatible with the following products:

■ Argus Safety 7.0

■ Argus Safety 6.0*

■ Argus Safety 5.1*

This version of Insight has also been tested for SSL compatibility.

Copy Configuration
The Copy Configuration utility copies the entire Argus Insight-specific configuration 
from a single-tenant Argus Insight 5.1 application to a multi-tenant Argus Insight 7.0 
application, after setting an Enterprise ID. The Enterprise ID can be created during the 
Copy Configuration phase. 

The utility copies all the enterprise data from one Multi-tenant enterprise to another 
multi-tenant enterprise in Argus Insight, including the ones which are marked as 
’Inactive’.

Migrating Custom Reports to Argus Insight 7.0 is a manual step.

You can Import configuration information from the following Insight versions and 
export it to Argus Insight 7.0 through the Copy Configuration utility:

■ Argus Safety 5.1 and 6.0 users in single-tenant environment can be upgraded to 
either the Argus Insight 7.0 Multi-tenant environment or to the Argus Insight 7.0 
Single-tenant environment. 

For such upgrades, a pre-requisite is to first ensure that the Argus Safety 
application is upgraded to version 7.0. 

■ A password-encryption utility is also available for user migration from Argus 
Insight 5.1 to Argus Insight 7.0.

Upgrading to the Argus Insight 7.0 Multi-tenant Environment
Execute the following steps to upgrade to Argus Insight 7.0:

■ Upgrade your current Argus Safety application to the Argus Safety 7.0 
Multi-tenant environment. 

■ Install the Argus Insight 7.0 application in Multi-tenant mode.

■ Create the enterprise in Argus Insight.

Note: The versions listed with the asterisk (*) denote that they are 
available for only single-tenant installations. Therefore, multi-tenant 
features such as Global Enterprise Management and Global User 
Management are available only from Argus Safety 7.0 onwards.

Note: For Argus Safety 5.1 and 6.0, Argus Insight users will sync up 
with Argus Safety users after the Incremental ETL is completed.
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■ Run the Copy Configuration utility for that enterprise.

■ Run the Initial ETL.
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Exporting the Configuration Data to Argus Insight 7.0
You can import all the Configuration Data from the following Argus Insight versions 
and export them to Argus Insight 7.0:

■ Single tenant to single tenant. 

■ Multi-tenant to multi-tenant - All the enterprises data is copied including the 
enterprises which are marked "Inactive".

■ Source enterprises are mapped to target enterprises based on enterprise short 
name.

■ User-specific configuration data is copied only for those users in an enterprise who 
exist in Argus Safety as well for that enterprise.

■ Configuration of those Enterprises which does not exist in Target system is not 
brought-in.

■ Configuration of additional enterprise that exists in Target system is not 
overwritten.
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3Getting Started

Using Argus Insight
Argus Insight, formerly called Power Reports is a highly optimized reporting module 
that compliments Argus Safety. The Argus Insight Extract Transfer and Load (ETL) 
engine extracts data from the Argus Safety database and populates a data warehouse in 
a format that allows efficient querying. The various query, drill-down, and output 
components of Argus Insight let you analyze your safety, workflow, or product data 
from all angles and produce reports that provide immediate business impact and 
maximum efficiency in decision-making.

This chapter describes the tasks performed when logging into Argus Insight.

Getting Started
The following tasks help you get started with Argus Insight.

To launch the web-based Argus Suite of Products:

1. Open the Web browser.

2. Type the Argus Web URL (Universal Resource Locator) in the address bar.

The system uses the Secure Socket Layers to support third-party digital certificates for 
secure transmissions at the system level. The System Administrator configures the 
URL is configured by the System Administrator.

The system opens the login screen.
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Single Sign On
Be aware of the following:

■ Users can have single-sign on capabilities. With Single Sign On (SSO), users’ log-in 
authentication is done using a centralized authentication system. With this, users 
do not need to enter their log-in credentials for each application they access, every 
single time. Cognos uses the Power Reports namespace.

■ The Administrator defines access to various modules in User Maintenance. If a 
user is assigned to more than one group, the system provides the user with the 
highest access level.

– Based on module access rights, the system enables / disables the application 
buttons access rights in the Menu Structure.

– Group access permissions are assigned in Web Admin.

■ A user with access to Argus or Insight can launch the application modules. The 
system does not ask the user to enter a password again for the PR or Argus 
modules. This also applies when the user launches other applications.

■ In User Maintenance, the administrator can link the Argus Safety and Argus 
Insight Mart databases. When a user logs into the system, the system identifies the 
available application modules for each Argus Instance.

■ When the user clicks the application modules, the system opens a New dialog 
where the other application (Argus Insight or Argus Safety) can be worked on.

■ When the user launches another application through Argus,or vice versa, the 
application module buttons do not appear in the new dialog windows because the 
user is already logged into the earlier application.

■ The initial login screen is the launching dialog forall other modules.
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■ Logout is available only on the Parent Application dialog. Logging out of the Main 
application dialog closes all child dialogs without saving information in the child 
applications.

Logging In
The Argus Insight installation program automatically creates an account for the 
system administrator and assigns the default user name and password as 
administrator and password, respectively. The administrator account cannot be 
deleted. This ensures that the system administrator can always log on to the system. In 
a given session, only one system administrator can log on to the system.

We recommend that you change the administrator password after logging on to Argus 
Insight for the first time. You can access Argus Insight through Argus Safety. This 
feature has been introduced to enable you to use a single login id and password for all 
Argus Modules. The modules that are enabled when you login to Argus Safety depend 
on your access right to various Argus modules.

Users can access Argus Insight directly by using the Argus Insight application URL. 
Argus Insight checks if Enterprise ID is already present in the request coming to it. If 
the Enterprise ID exists, it opens Argus Insight for that enterprise.

To log on to Argus Insight as an administrator:

1. Start Internet Explorer.

2. Type the Argus Insight Universal Resource Locator (URL) in the address bar.

3. Press Enter. The Argus Insight login screen appears.

4. Type in the Username and Password.
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5. Click Login. The Argus Insight home page appears.

Changing the Password
Use the following procedure to change the password.

1. Click Tools on the global toolbar. The Administration Tools page appears with the 
Personal Options tab displayed.

2. In the Old Password text box, enter the existing password.

3. In the New Password text box, enter a new password. Your new password must 
be different than your old password.

4. Re-enter the new password in the Confirm Password text box.

5. In the New Password text box, enter a new password. Your new password must 
be different than your old password.

6. Click OK. The system saves the new password.

Changing the Default Home Page
Use the following procedure to change the default Home page.

1. Click the Tools button on the global toolbar. The Administration Tools page 
appears with the Personal Options tab displayed.

2. Select a home page from the Homepage drop-down list box.

Note: Type in username as administrator and password as password 
to log in as the administrator.

Note: Argus Insight passwords are case sensitive. The password 
requirements are configured by the Administrator.
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3. Click OK. The system changes the default home page to the selected page.

Configuring the Argus Insight Application
You may need to configure Argus Insight and change certain factory defaults to 
conform to the specific business requirements of your organization. Use the following

TheAdministration Toolschapter has information on configuring the following:

■ Personal Options - password, default home page, overwrite confirmation, and 
group membership of users.

■ List Maintenance - profile switches, countries, workflow mappings with Argus, 
and categories.

■ Security - creating, modifying, and enabling/disabling user groups and accounts.

■ ETL Scheduler - configuring ETL.

■ Dashboard Indicators - assigning specific dashboard reports to users and 
applying filters to dashboard reports.

■ Audit Log - monitoring user activities on the system.

Entering Dates in Various Argus Insight Fields
Throughout Argus Insight, you are required to enter dates in several fields. Fields that 
accept full dates appear in the dd-mmm-yyyy format. You can enter the month using 
numbers instead of three letters. When you enter a valid month number, the system 
automatically converts the number to letters corresponding to that month. For 
example, 03 for the month automatically gets converted to MAR.

You can enter partial dates in certain fields. Fields that accept partial dates appear in 
the ??-???-0000 format. For reporting purposes, missing days of the month are 
approximated to the 15th of the month and missing months are approximated to the 
month of June

Valid partial dates must comprise either a year, or a year and a month. If you enter the 
day, you also need to enter the month.

The following fields in the QBE form, which is similar to the Argus Case form, accept 
partial dates.

Tip: You can set any page as the default home page, by clicking the 
Home Page button on the global toolbar.

You can make changes to the Personal Option tab page to configure 
the password, default home page, overwrite confirmation, and group 
membership of users.

Tip: To enter the current date in a datefield, press the = key on the 
keyboard
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The following table lists some examples of partial dates.

QBE Form Tab Field

Patient Date of Birth

Other Relevant History

Start Date

Other Relevant History

Stop Date

Lab Data

Date

Patient > Parent Date of Birth

Product Expiration Date

Dosage Regimen

Start Date/Time

Dosage Regimen

Start Date/Time

Summary of all regimens

First Dose

Summary of all regimens

Last Dose

Product > Vaccine 
History

Date

Product > Device Date Explanted

Date Implanted

Expiration Date

Event Onset Date

Stop Date

Event > Death Death Date

Event > Hospitalized Start Date

End Date

Date to be Entered Partial Date Formats
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Getting Help
Click the Help button on the global toolbar to access the Online Help. You can find 
information by using the Contents, Index, or Search tabs in the Online Help.

Logging Out
Use the following procedure to log out.

1. Click Logout on the global toolbar. A confirmation dialog box appears.

2. Click OK. The system logs you out. The Argus Insight logout screen appears.

March, 2005 Enter any one of 
these sequences:

■ 0032005

■ 00305

■ ???305

■ ??305

■ /32005

■ /305

■ 00MAR2005

■ 00MAR05

■ ??32005

■ ??MAR2005

■ /MAR2005

2005 Enter any one of 
these sequences:

■ 00002005

■ 000005

■ ??2005

■ ??05

■ //2005

■ //05

■ ?? ???2005

■ ?? ???05
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4Creating Queries

Creating Queries
In Argus Insight, you use queries to search the datamart and retrieve a set of cases 
(Case Series) with similar attributes. Based on your reporting requirements, your 
querying criteria may be as simple as a few Argus case form fields with specific values 
or as complex as a SQL query that uses Boolean/Set operations between various 
datamart fields.

This chapter explains how to use the Argus Insight querying tools and in what 
situations. Depending on how complex or detailed a query you want to create, you can 
use these Argus Insight querying tools:

■ QBE

■ Filters

■ Advanced Conditions

■ Library

QBE
If you are familiar with the Argus case form, you may choose Query by Example (QBE) 
to create simple queries. For a QBE, the querying criteria consists of specific values 
entered in the fields on the QBE form, which looks substantially like the Argus case 
form. For example, your QBE may consist of the values in these fields:

Note: You may be allowed to enter more than 4000 characters in text 
box, but the query search is limited to the first 4000 characters.

QBE Form Tab > Field Value 
Entered/Selected

General > Country of Incidence United States

Products > Product Name Algoheal Injection

Events > Event Description to be Coded Injection site rash

Events > Seriousness Criteria Hospitalized
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When you execute this QBE, the system retrieves only those cases where the values of 
Country of Incidence, Product Name, CodedEvent Description, Event Description to 
be Coded and Seriousness Criteria are the same as specified in your QBE.

These topics explain how to work with QBE:

■ Creating a New QBE

■ Working with the Last Modified or Executed QBE

■ Working with Saved QBEs

■ Using QBEs with Advanced Conditions

Creating a New QBE
Begin creating a QBE by entering values in the QBE form. The QBE form has a 
tab-based interface consisting of eight multiple section tabs.

The first seven tabs in the QBE form let you enter the query criteria about a specific 
aspect of a case:

The eighth tab in the QBE form, Advanced Conditions, lets you integrate a QBE with 
an Advanced condition stored in Argus Insight. You can also convert a QBE into an 
Advanced Condition. The Using QBEs with Advanced Conditions topic explains this 
in detail.

While specifying the query criteria in Query By Example page (QBE form), Argus 
Insight provides the functionality of Type Ahead in few fields. Type Ahead 
functionality offers you to type-in a value and the like values are displayed in the list 
box. It also enables you to select the desired value from the list of values. The fields 
having this functionality are as follows:

QBE Form Tab Type of Information to Enter

General Lets you enter querying criteria based on general, study, reporter, and 
literature information about the case

Patients Lets you enter querying criteria based on information about the patient, lab 
data, other relevant history, and the patient's parent

Products Lets you enter querying criteria based on product information and dosage 
regimens

Events Lets you enter querying criteria based on information about the event and 
its seriousness criteria

Analysis Lets you enter querying criteria based on information about case analysis 
and imputability

Activities Lets you enter querying criteria based on case activity information, such as 
contact logs, action items, and case lock/archive dates

Additional Info Lets you enter querying criteria based on additional information about the 
case such as references

Note: For more sophisticated queries, use Filters or Advanced 
Conditions.

Accidental Exposure Action Taken Action Type Age Groups Age Units
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Type Ahead 

You can use the type-ahead functionality to select data suggestions by double-clicking 
on a textbox to display all the suggestions for a field in a list of values. Alternatively, 
you can also you can type-in a value and suggestions are displayed for the typed 
value.

Use the following procedure to create a new QBE and work with it. To log out of 
Argus Insight:

1. Start the new QBE. In Argus Insight, select Create Query > Query By Example > 
New. The Query By Example page (QBE form) appears; the General tab page is 
displayed.

2. Specify the querying criteria. Enter values in the fields within the various tab 
pages, as appropriate.

Refer to these pages for descriptions of all the fields in the various tab pages of the 
QBE form:

Anatomical Locations Attachment 
Classification

Birth Type Case Classification Causality Category

Condition Type Contact Type Delivery Types Device 
Subcomponents

Device Type

Dosage Frequency Dosage Units Ethnicity Event Frequency Event Intensity

Event Outcome Fetal Outcome Formulation Gender Group 
(Activities:contact 
log)

Group (Action item) Intermediary Locked or Closed By Manufacturers Occupations

Package Units, Reference Type Report Media Report Type Reporter Type

Routes of 
Administration

User 
(Activities:contact 
log)

User (Action item)
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■ General Page

■ Patient Page

■ Products Page

■ Events Page

■ Analysis Page

■ Activities Page

■ Additional Info Page

3. Examine the QBE result.

4. Click Execute. While the system searches for matching cases, the following dialog 
box is displayed.

■ If the system does not find any cases that match the querying criteria, the 
following screen is displayed. Click Cancel to return to the QBE form, modify 
the criteria and execute the QBE again.

■ If the system finds cases that match the query criteria, a list of such cases is 
displayed in the Active Case Series page.

Note: The QBE field labels are displayed as per the field labels 
configured in Argus

Tip: While entering values in a tab, if you wish to clear all the values 
you entered, click the Clear Tab button. If you wish to clear all the 
values you entered in all the tabs, click the Clear All button.
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5. Examine the Case Series. If the Case Series is too large, you may want to modify 
the QBE by specifying additional field values in the QBE form to narrow down the 
Case Series. Alternatively, if you find the Case Series to be appropriate, you can 
save the QBE to the system.

6. To return to the QBE form, click View Query in the Active Case Series page. The 
Active Query by Example page appears.

7. If required, modify the QBE and examine the result again or proceed to save the 
QBE.

8. Save the QBE to the system.

9. Use the Category list box to assign a category to the QBE you are going to save. A 
category indicates the reporting aspect to which your QBE pertains: Compliance, 
Configuration, General, Management, or Pharmacovigilance. Specifying the 
category also helps you in searching the relevant QBEs from a list of all the QBEs 
saved in the system.

10. Type a description of the QBE in the Description text box. For example, you can 
describe the type of cases the QBE retrieves.

11. Click Save As in the ActiveQuery By Example page. The Save QBE dialog box 
appears.

Note: When you save the modifications to a QBE or execute a QBE, 
the system assigns the Active status to the QBE. Therefore, when you 
return to the QBE form after executing the QBE, the page title changes 
to ActiveQuery By Example. The field values you specified in the 
QBE form before executing are retained. See the Working with the Last 
Modified or Executed QBE topic for details on Active QBEs.
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12. Type the name of the QBE in the Name text box.

13. Click OK. The system refreshes the Query By Example page. Note that the 
following new elements appear on the page.

■ The page title changes to Query By Example.

■ The Active Query Name field in the upper-right corner of the page now 
displays the name of the QBE you specified while saving the QBE.

■ Two new buttons appear at the bottom of the page: Save and Permissions.

Assign group-level permissions on the saved QBE
Use the following procedures to assign group-level permissions to a saved QBE

To assign group-level permissions to a saved QBE:

1. Click the Permissions button. The Permissions dialog box appears. A list in this 
dialog box displays the names of all the groups (except the Administrator group) 
that the system administrator has created.

Note: A name cannot contain any of the following: % " ' ^ ~,;|#`

Note: All the QBEs that you save to the system are listed in the 
Query By Example - Library page. The Working with Saved QBEs 
topic explains how to work with saved QBEs.

Tip: If you make modifications to the field values after you have 
saved the QBE to the system, use the Save button to save the changed 
field values.
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Use the list box next to a group name to assign permissions to the group members 
on the QBE you have created. You can select from these options:

2. Click OK. The system saves the permission settings.

3. Execute the QBE.

4. Click Execute. The system retrieves the list of cases that match the QBE criteria 
and displays it in the Active Case Series page.

After generating the Case Series, you can manually modify it or save it. See the 
Working with Case Series chapter for more information on working with Case 
Series.

General Page  
The General page differs from what you might be used to seeing in Argus in the 
following ways:

■ You can specify only one follow-up date

■ You can specify only one case classification

■ You can specify information only about one reporter

■ You need to scroll down the page to view all the fields available.

Permission Description

No Access (Default) No group members will be able to access the QBE

R Group members will be able to only view the QBE

R/W Group members will be able to view and modify the QBE

R/W/D Group members will be able to view, modify, and delete the QBE

R/W/D/P Group members will be able to view, modify, delete, and assign 
permission on the QBE
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The following table describes the various fields in the General page. The field 
values you specify are used as the query criteria to retrieve matching cases.

Section Field Description

General Information Report Type Use this list box to select the case source that the query 
should look for in cases.

Country Use this list box to select the country of incidence that the 
query should look for in cases.

Initial Receipt Date In this date field, enter the date when you company first 
became aware of the case.

Central Receipt Date In this date field, enter the date on which the Central Safety 
received the case.

Case Status Use this list box to select the workflow state that the query 
should look for in cases.

Follow-up Received In this date field, enter the follow-up information receipt 
date that the query should look for in cases.

Safety Received In this date field, enter the date on which follow-up 
information was received by Central Safety.

Significant Check this checkbox to retrieve cases that had a significant 
follow up.

Aware Date In this date field, enter the most recent significant follow-up 
date or initial receipt date (if there are no follow ups), that 
the query should look for in cases.
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StudyInformation Study Num Click the Select button associated with this text box to 
select the study protocol number, study number and center 
id that the query should look for in cases.

See theSelecting the Study Numbersection for details.

Study Type Select the study type that the query should look for in cases.

Other Study ID In this text box, enter any other ID that can be relevant to 
the study.

Study Week In this text box, enter the week number of the study during 
which the adverse event occurred. The query will only look 
for such cases.

Study Visit In this text box, enter the visit number of the study during 
which the adverse event occurred. The query will only look 
for such cases.

Study Blinding Status Use this list box to select the study blinding status that the 
query should look for in cases.

Study Broken Date In this date field, enter the date on which the study was 
broken. The query will only look for cases with matching 
study broken date.

Section Field Description
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Reporter Information Reporter Sal. Enter the reporter salutation that the query should look for 
in cases.

Reporter First Name Enter the reporter's first name to look for in cases.

Reporter Middle Name Enter the reporter's middle name to look for in cases.

Reporter Last Name Enter the reporter's last name to look for in cases.

Reporter Suffix Enter the reporter's suffix to look for in cases.

Health Care 
Professional

Select an option from this list box to include a query 
criterion based on whether the reporter is a health care 
professional.

Reporter Occupation Use this list box to select the reporter's occupation that the 
query should look for in cases.

Reporter Address In this text area, enter the report address that the query 
should look for in cases.

Reporter Institution In this text box, enter the reporter's institution that the 
query should look for in cases.

Reporter Department In this text box, enter the reporter's department that the 
query should look for in cases.

Reporter City In this text box, enter the reporter's city that the query 
should look for in cases.

Reporter State In this text box, enter the reporter's state that the query 
should look for in cases.

Reporter Postal Code In this text box, enter the reporter's postal coded that the 
query should look for in cases.

Reporter Country ID In this text box, enter the reporter's country ID that the 
query should look for in cases.

Reporter Phone 
Number

In this text box, enter the reporter's phone number that the 
query should look for in cases.

Reporter Alternate 
Phone

In this text box, enter the reporter's alternate phone number 
that the query should look for in cases.

Reporter Fax Number In this text box, enter the reporter's fax number that the 
query should look for in cases.

Reporter ID In this text box, enter the reporter ID that the query should 
look for in cases.

Reporter's Reference # In this text box, enter the reporter's reference number that 
the query should look for in cases.

Reporter Email 
Address

In this text box, enter the reporter's email address that the 
query should look for in cases.

Reporter Type Use this list box to select the reporter type that the query 
should look for in cases.

Report Media Use this list box to select the report media that the query 
should look for in cases.

Intermediary Use this list box to select the intermediary that the query 
should look for in cases.

Report Sent to 
Regulatory Authority 
by Reporter

Select the Yes, No, Unknown, or Ignore option button, as 
appropriate, to indicate whether the query should look for 
cases where the reporter has already informed a regulatory 
authority about the event.

Reporter Protect 
Confidentiality

Check this checkbox to have the query retrieve only those 
cases where reporter information is specified as 
confidential.

Section Field Description
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Selecting the Study Number  
Argus Insight lets you select the Study Protocol #, Study Num and Center ID fields in 
the Study Information section, by selecting the study number from the Clinical Study 
Lookup dialog box.

Use the following procedure to select a clinical study:

To select a clinical study:

1. Click the Select button associated with the Study Num field. The Clinical Study 
Lookup dialog box appears.

2. Enter the first few letters of the project name, study ID, or study center name in 
their respective text boxes.

3. Click Search. The system searches for the specified search strings. The Clinical 
Study Lookup dialog box displays the search result in a grid format.

Literature 
Information

Literature Journal In this text box, enter the literature journal name that the 
query should look for in cases.

Literature Author In this text box, enter the literature author name that the 
query should look for in cases.

Literature Title In this text box, enter the literature title that the query 
should look for in cases.

Literature Vol In this text box, enter the literature volume that the query 
should look for in cases.

Literature Year In this text box, enter the literature publication year that the 
query should look for in cases.

Literature Pgs In this text box, enter the journal page number in which the 
article appeared. The query will look for this information in 
cases.

Tip: If you are not sure about the information you are looking for, as 
an alternative, click search to list all the associated data for Study 
Num.

Section Field Description
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4. Select a study from the Clinical Studies listed.

5. Click Select in the Clinical Study Lookup dialog box. The Study Protocol # , 
Study Num (*) and Center ID(*) fields in the Study Information section of the 
QBE form are automatically selected.

Patient Page  
The Patient page has two views: Patient and Parent.

The Patient view differs from what you might be used to seeing in Argus in the 
following ways:

■ You can specify information only about one lab data element

■ You can specify details of only one relevant history

You need to scroll down the page to view all the fields available.

The following table describes the various fields in the Patient view of the Patient page. 
The field values you specify are used as the query criteria to retrieve matching cases.

Note: The Study Num and Center ID are optional fields.
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Section Field Description

Patient Information Patient Sponsor 
Identifier

In this text box, enter the study sponsor's ID. The query will 
look for this information in cases.

Patient Subject # In this text box, enter the patient subject number that the 
query should look for in cases.

Patient First Name In this text box, enter the patient's first name that the query 
should look for in cases.

Patient Last Name In this text box, enter the patient's last name that the query 
should look for in cases.

Patient MI In this text box, enter the patient's middle initials that the 
query should look for in cases.

Patient Initials In this text box, enter the patient's initials that the query 
should look for in cases.

Patient 
Randomization 
Number

In this text box, enter the patient randomization number 
that the query should look for in cases.

Patient Protect 
Confidentiality

Check this checkbox to retrieve those cases where patient 
information is marked as confidential.

Number of Patients In this text box, enter the number of patients.

Patient Address In this text box, enter the patient's address that the query 
should look for in cases.

Patient City In this text box, enter the patient's city that the query should 
look for in cases.

Patient State In this text box, enter the patient's state that the query 
should look for in cases.

Patient Postal Code In this text box, enter the patient's postal code that the query 
should look for in cases.

Patient Country In this text box, enter the patient's country that the query 
should look for in cases.

Patient Date of Birth In this date field, enter the patient's date of birth that the 
query should look for in cases.

Patient Age In this text box, enter the patient's age that the query should 
look for in cases.

Patient Age Units Select the age unit for the value you specified in the Patient 
Age text box.

Patient Age Group Select the patient age group that the query should look for 
in cases.

Patient Gender Select the patient gender that the query should look for in 
cases.

Patient Weight In this text box, enter the patient weight that the query 
should look for in cases. Select the lbs or kg option button, 
as appropriate.

Patient Height In this text box, enter the patient's height that the query 
should look for in cases. Select the in or cm option button, 
as appropriate.

Patient Ethnicity Select the patient's ethnicity that the query should look for 
in cases.

Patient Occupation Select the patient occupation that the query should look for 
in cases.
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This Parent view differs from what you might be used to seeing in Argus in the 
following ways:

Pregnancy Select the Yes, No, Unknown, N/A, or Ignore option button, 
as appropriate, to indicate whether the query should look 
for cases where the patient's pregnancy status is specified. 
This field is available only if you specify the patient gender 
as Female

Pregnancy 
Information Date of 
Last Menstrual Per.

In this date field, enter the date of last menstrual period that 
the query should look for in cases.

Lab Data Lab Data Test Name Click the associated Select button to select the lab test that 
the query should look for in cases. See theSelecting Lab 
Testsection for more information.

Lab Data Result In this text box, enter the lab data result that the query 
should look for in cases.

Lab Data Normal 
Low

In this text box, enter the lab data normal low value that the 
query should look for in cases.

Lab Test Date In this date field, enter the lab test date that the query 
should look for in cases.

Lab Data Result Unit Enter the lab data result unit for the value you specified in 
the Lab Data Result field.

Lab Data Normal 
High

In this text box, enter the lab data normal high value that 
the query should look for in cases.

Other Relevant 
Information

Relevant History 
Start Date

In this date field, enter the relevant history start date that 
the query should look for in cases.

Relevant History 
Condition Type

Select the relevant history condition type that the query 
should look for in cases.

Relevant History 
Notes

In this text box, enter the relevant history notes that the 
query should look for in cases.

Relevant History 
Stop Date

In this date field, enter the relevant history stop date that 
the query should look for in cases.

Relevant History 
Condition

Click the associated Encode button to select the relevant 
history condition by using the MedDRA browser. The query 
will look for the encoded term.

See theUsing the MedDRA Browser section for details.

Relevant History 
Continues

Check this checkbox to retrieve cases where the relevant 
history condition is continuing/ongoing.

Patient Relevant Tests In this text area, enter the relevant patient tests that the 
query should look for in cases.

Section Field Description
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■ You can specify details of only one relevant history

■ You can specify details of only one medical history

The following tables describes the various fields in the Patient view of the Patient 
page. The system uses the field values you specify the query criteria to retrieve 
matching cases.

Section Field Description

Parent Parent Initials In this text box, enter the parent's initials that the query 
should look for in cases.

Parent Age In this text box, enter the parent's age that the query 
should look for in cases.

Parent Age Unit Select the age unit for the value you specified in the 
Parent Age text box.

Parent Gender Select the parent gender that the query should look for in 
cases.

Parent LMP In this date field, enter the parent's LMP date that the 
query should look for in cases. This field is available only 
if the parent gender is specified as Female.

Parent Weight In this text box, enter the parent's weight that the query 
should look for in cases. Select the lbs or kg option 
button, as appropriate.

Parent Height In this text box, enter the parent's height that the query 
should look for in cases. Select the in or cm option 
button, as appropriate.

Parent Breast feeding Check this checkbox to retrieve cases where parent is 
breast feeding.
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Selecting a Lab Test  
Use the following procedure to select a Lab Test:

1. Click the Select button associated with the Lab Data Test Name field. The Lab 
Test Name dialog box appears.

2. Type a few initial letters of the test name.

3. Click Search. The matching test names appear in a list.

Other Relevant 
Information

Relevant History 
Start Date

In this date field, enter the relevant history start date that 
the query should look for in cases.

Relevant History 
Condition Type

Select the relevant history condition type that the query 
should look for in cases.

Relevant History 
Notes

In this text box, enter the relevant history notes that the 
query should look for in cases.

Relevant History 
Stop Date

In this date field, enter the relevant history stop date that 
the query should look for in cases.

Relevant History 
Condition

Click the associated Encode button to select the relevant 
history condition by using the MedDRA browser. The 
query will look for the encoded term.

See theUsing the MedDRA Browsersection for details.

Relevant History 
Continues

Check this checkbox to retrieve cases where the relevant 
history condition is continuing / ongoing.

Section Field Description
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4. Select the required test name.

5. Click Select. The test name appears in the Lab Data Test Name field in the QBE 
form.

Using the MedDRA Browser  
Use the following procedure to use the MedDRA Browser to search and select 
MedDRA terms for an event.

1. Click the Encode button associated with the QBE tabs to launch MedDRA 
browser. The MedDRA Browser appears.
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2. Enter the first few letters of the SOC, HLGT, HLT, PT, or LLT term in the respective 
text box. If you want the system to search for the specified word in the entire event 
term, check the Full Search checkbox.

3. Press Tab. The system searches for the specified word in the event terms. The 
MedDRA Browser displays the search result in a column below the text box in 
which you entered the text string.

4. Select the required event term from the search result. The SOC, HLGT, HLT, PT, 
and LLT fields in the MedDRA Browser display the respective terms for the 
selected event. The fields that are highlighted in the colors listed below have the 
following significance.

Note: The output returned by the MedDRA browser for the Patient, 
Product and Analysis tabs of QBE is the Preferred Term (PT). The 
Events tab of QBE provides output for multiple options. You can 
select and search the required term(s), based on the Seriousness 
Criteria.

Note: The Special Category drop-down list displays all the SMQs 
that can be selected. The selected SMQ searches across PT and LLT 
levels of the MedDRA dictionary.

The Special Category drop-down list is hidden in MedDRA 10. The 
MedDRA SMQs drop-down list is hidden in versions lesser than 
MedDRA 9.
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5. Check the SOC, HLGT, HLT, PT, and LLT checkboxes to populate the 
corresponding fields in the QBE form.

6. Click Select.

7. The selected codes for the selected event are displayed in the respective fields in 
the QBE form.

Products Page  
The Products page differs from what you might be used to seeing in Argus in the 
following ways:

■ You can enter information only about one product

■ You can specify details of only one dosage regimen

■ You need to scroll down the page to view all the fields available.

If the row color is... This signifies...

Yellow The selected hierarchy is the primary SOC path.

Grey The selected hierarchy is not the primary SOC path.
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The following table describes the various fields in the Products page. The field values 
you specify are used as the query criteria to retrieve matching cases.
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Section Field Description

Product Information Product Name Click the associated Select button to use the Product Browser to 
specify the product as the query criteria.

Selecting the product name automatically populates the Product 
Name, Product Generic Name, and Company Drug Code fields in 
the QBE form.

See theUsing the Product Browsersection for details.

Product WHO Drug 
Code

Click the associated Encode button to use the Drug Coding Browser 
to specify the WHO drug name as the query criteria.

See theUsing the WHO Drug Browsersection for details.

Product Type Select the Suspect, Concomitant, Treatment, or Ignore option 
button, as appropriate, to indicate whether the query should look 
for cases where product type is specified.

Product 
Manufacturer

Select the product manufacturer that the query should look for in 
cases.

StudyDrug Click the associated Select button to use the Study Drug Lookup 
dialog box to specify the study drug name as the query criteria. Use 
this field to retrieve clinical trial cases with the selected study drug.

See theUsing the Study Drug Lookupsection for details.

ATC Code Enter the Anatomical, Therapeutic, Chemical (ATC) classification 
code that the query should look for in cases.

ATC Description Enter the Anatomical, Therapeutic, Chemical (ATC) classification 
description.

Drug Formulation Select the drug formulation that the query should look for in cases.

Drug Concentration Enter the drug formulation that the query should look for in cases. 
Select the concentration unit from the Drug Product Concentration 
Units ID list box.

Drug Primary 
Indication

Click the associated Encode button to use the MedDRA Browser to 
specify the drug primary indication event term as the query 
criteria.

See theUsing the MedDRA Browsersection for details.

Drug Interaction Select the Yes, No, Unk, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where drug 
interaction status is specified.

Drug 
Contraindicated

Select the Yes, No, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where drug 
contraindication status is specified.

Dosage Information Dosage Regimen 
Start Date

In this date field, enter the dosage regimen start date that the query 
should look for in cases.

Dosage Regimen 
Stop Date

In this date field, enter the dosage regimen start date that the query 
should look for in cases.

Dosage Regimen 
Ongoing

Check this checkbox to retrieve cases where the dosage regimen is 
ongoing.

Dosage Regimen 
Outside Therapeutic 
Range

Check this checkbox to retrieve cases where the dosage regimen is 
outside therapeutic range.

This means that the drug has not been used in accordance with the 
label or has been used for outside the Therapeutic Range. Consult 
your Administrator for further company-specific information on 
the use of this field.
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Dosage Regimen 
Duration

In this text box, enter the dosage regimen duration in minutes as 
the query criteria.

OR

Click Calculate to view the duration calculator, to calculate the 
dosage regimen duration in minutes or duration value bands.

1. Click the associated Calculate button to convert hours, days, 
weeks, months, or years to minutes

2. Enable the Duration value band option.

3. Select the duration band and its value from the drop-down 
lists. These ranges are configured by the administrator through 
List Maintenance.

4. Click Select to confirm the operation. The values are displayed 
in the Products page.

Dosage Regimen 
Accidental Exposure

Select the area of accidental exposure as the query criteria.

Dosage Regimen 
Dose No.

In this text box, enter the drug dose number as the query criteria.

Dose In this text box, enter the drug dose received by the patient as the 
query criteria.

Dose Units Use this list box to specify the units for the value you specified in 
the Dose field.

Frequency Use this list box to specify the dosage frequency as the query 
criteria.

Dosage Regimen 
Dose Description

In this text box, enter the dose description based on the values you 
specified in Dose, Dose Units, and Frequency fields.

Regimen Daily Dose In this text box, enter the daily dose based on the values you 
specified in Dose and Frequency fields.

Regimen Daily 
Dosage Unit

Select the same option you selected in the Dose Units list box.

Total Regimen 
Dosage

daily dose, duration, and frequency

Total Dosage 
Regimen Unit

Select the total dose regimen unit based on the values you specified 
in Dose, Dosage Regimen Duration, and Frequency fields.

Dosage Regimen 
Route of 
Administration

Select the route of dosage administration as the query criteria.

Section Field Description
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Using the Product Browser  
Use the following procedure to explain how to select a product by using the Product 
Browser.

1. Click the Select button associated with the Product Name field. The Product 
Browser appears.

Dosage Regimen 
Route (Parent)

Select the route of dosage administration of the parent as the query 
criteria.

Dosage Regimen 
Package ID

Enter the package ID as the query criteria.

Dosage Regimen 
Package Units

Select the package units.

Dosage Regimen 
Batch/Lot #

Enter the batch/lot number as the query criteria.

Expiration Date Enter the product expiration date as the query criteria.

Drug First Dose Enter the earliest dosage regimen start date as the query criteria.

Drug Last Dose Enter the latest regimen stop date as the query criteria.

Drug Duration of 
Administration

Enter the duration of drug administration as the query criteria.

This duration is the difference between the first and last dose for all 
dosage regimens.

Total Drug Dosage Enter the total drug usage duration as the query criteria.

Drug Product Total 
Dose Unit

Enter the total dosage unit as the query criteria.

This is based on the daily dose, duration and frequency.

Product Event Delay Enter the time between the event onset and the fist dose

Product Event 
Latency

Enter the time between the event onset and the last dose

Drug Cumulative 
Dose

Enter the total dose for the drug

Drug Info Action 
Taken

Select the action taken to mitigate the adverse event

Other Information Check the Drug Abuse, Drug Overdose, and Tampering 
checkboxes

Drug Taken 
Previously

Select the Yes, No, Unk, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where drug was 
taken previously.

Drug Dechallenge Select the Yes, No, Unk, N/A or Ignore option button, as 
appropriate, to indicate whether the query should look for cases 
where drug dechallenge status is specified.

Drug Dechallenge 
Date

Enter the drug dechallenge date as the query criteria.

Drug Rechallenge Select the Yes, No, Unknown, N/A or Ignore option button, as 
appropriate, to indicate whether the query should look for cases 
where drug rechallenge status is specified.

Drug Rechallenge 
Start Date

Enter the rechallenge start date as the query criteria.

Drug Rechallenge 
Stop Date

Enter the rechallenge stop date as the query criteria.

Section Field Description
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2. Enter the first few letters of the product ingredient, family name, product name, or 
trade name in the respective text box. If you want the system to search for the 
specified string in the entire product information, check the Full Search checkbox.

3. Press Tab. The system searches the database for the specified search string. The 
Product Browser displays the search result in a column below the text box in which 
you entered the search string.
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4. Select an item from the search result list. The details for the selected item are 
displayed in all the Product Browser fields.
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5. Select the required product name and trade name, as appropriate. The selection is 
highlighted in the Product Browser.

6. Click Select. The Product Name, Product Generic Name, Company Drug Code, 
Drug Formulation, Drug Concentration and Drug Product Concentration Units ID 
fields in the QBE form are automatically populated with the details of the selected 
product.

Using the WHO Drug Browser  
Use the following procedure to select a WHO drug product by using the WHO Drug 
Browser.

1. Click the Encode button associated with the Product Name field. The WHO Drug 
Browser appears.



Creating Queries

Creating Queries 4-27

2. Select the Product Type as the drug search criteria. The default value is All.

3. Enter the first few letters of the ATC code, ATC description, Code, or Description 
in the respective text box. Check the Ingredient checkbox to search for the drugs 
(whose drug ingredients) match the ingredients in the List Maintenance. Click the 
SOUNDEX checkbox to search for drugs, where the exact spelling of the drug is 
unknown. Example: Enter antiviral in the ATC description field to view the list of 
drugs starting with the phonetics closest to anti. This returns a list of drugs closest 
to the phonetic representation (the way it sounds) of the word.

4. Select either the Drug Code or Medicinal Prod ID radio button as one of the drug 
search criterion. The default selection is Drug Code.

5. Select either the Trade Name or Ingredient radio button as one of the drug search 
criterion. The default selection is Trade Name. You can also select multiple trade 
names in the same WHO Drug selection dialog. If multiple trade names are to be 

Note: The WHO Drug Browser that appears will depend on the 
configuration settings for your account by the administrator.

The browser categories (B or C) are not displayed in the browser 
window.

The primary difference between the two browsers is the availability of 
the following fields in WHO Drug Browser:

■ Product Type: This is the product type.

■ Medicinal Prod ID: This is the unique medicinal product id.

■ MAH: This is the name of the manufacturer.

■ Ingredients: This is the product substance name.
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added, the Add & Close button is enabled. Click this button to add the selected 
multiple trade names and ingredients into the Drug Detail section.

6. Enter the Formulation and Country details for the drug to be searched.

7. If you want the system to search for the specified string in the entire product 
information, check the Full Search checkbox.

8. Click Search. The system searches the database for the specified search string. The 
WHO Drug Browser displays the search result in a grid format.

9. Select the required WHO drug. The selected item is highlighted.
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10. Click Select. The Product Name, Product WHO Drug Code, Generic Name, ATC 
Code and ATC Text fields in the QBE form are populated with the selected WHO 
drug code.

Using the Study Drug Lookup  
Use the following procedure to select a study drug:

1. Click the Select button associated with the Study Drug field. The Study Drug 
dialog box appears.

Note: All the Ingredients for the WHO Drug browser are 
concatenated and displayed in the Generic Name for the WHO Drug 
separated by a ","
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2. Enter the first few letters of the study drug name in the Study Drug dialog box.

3. Click Search. The system searches the database for the specified search string. The 
Study Drug dialog box displays the search result in a grid format.

4. Select the required study drug from the search result list.

5. Click Add & Close. The system populates the Study Drug field with the selected 
study drug.

Events Page  
The Events page differs from what you might be used to seeing in Argus in that details 
of only one event can be specified. You must scroll down the page to view all the 
available fields.
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The following table describes the various fields in the Events page. The field values 
you specify are used as the query criteria to retrieve matching cases.

Section Field Description

Event Information Event Description as 
Reported

In this text box, enter the reported event description that the 
query should look for in cases.

Event Diagnosis Flag Select the Yes, No, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where event 
diagnosis flag is set.

Event Description to 
be Coded

Tab out from this field to use the MedDRA Browser to specify 
an event term as query criteria.

See theUsing the MedDRA Browsersection for details. The 
MedDRA event terms for the selected term are displayed in 
the Seriousness Criteria section. The query is restricted to the 
terms displayed.

Event Past History Select the Yes, No, Unknown, or Ignore option button, as 
appropriate, to indicate whether the query should look for 
cases where event past history is specified.

Event Onset Date In this date field, enter the event onset date that the query 
should look for in cases.

Event Onset from 
Last Dose

In this text box, enter the event onset duration from last dose 
as the query criteria.

Event Stop Date In this date field, enter the event stop date that the query 
should look for in cases.

Event Duration In this text box, enter the event duration that the query 
should look for in cases.

Event Onset Latency In this text box, enter the event onset latency duration that 
the query should look for in cases.

Time to Onset from 
First Dose

In this text box, enter the duration from first dose to the event 
onset as the query criteria.

OR

Click the associated Calculate button to view theDuration 
Calculatoras displayed in the Products Tab Dosage 
Information.
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Analysis Page  
The Analysis page has two views: Case Analysis and AFSSaPS. Analysis information 
about Regulatory Information (notification log), MedWatch Information, BfArM 
Information, and EU devices is not available. For more sophisticated queries, use 
Filters or Advanced Conditions.

Time to Onset from 
Last Dose

In this text box, enter the duration from last dose to the event 
onset as the query criteria.

OR

Click the associated Calculate button to view theDuration 
Calculatoras displayed in the Products Tab Dosage 
Information.

Event Intensity Select the event intensity option that the query should look 
for in cases.

Event Frequency Select the event frequency option that the query should look 
for in cases.

Related to Study 
Conduct (As 
Reported)

Use this list box to select the Yes, No, Unknown, or N/A 
option, as appropriate, to indicate whether the query should 
look for cases where the event is related to a study.

Event Treatment 
Received

Select the Yes, No, Unknown, or Ignore option button, as 
appropriate, to indicate whether the query should look for 
cases where patient received treatment for the event.

Outcome of Event Select the event outcome that the query should look for in 
cases.

Event Receipt Date In this date field, enter the event receipt date that the query 
should look for in cases.

Event Reported 
Serious

Select the Yes, No, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where case 
seriousness status is specified.

Event Lack of 
Efficacy

Check this checkbox to retrieve cases where Event Lack of 
Efficacy is selected.

Event Progression of 
Disease

Check this checkbox to retrieve cases where Event 
Progression of Disease is selected.

Event Withdrawal 
Reaction

Check this checkbox to retrieve cases where Event 
Withdrawal Reaction is selected.

Seriousness Criteria Seriousness Criteria 
checkboxes

Check one or more associated checkboxes to specify the 
seriousness criteria that the query should look for in cases.

Event Term fields Click the associated Encode button to use the MedDRA 
Browser to specify event terms as query criteria.

See theUsing the MedDRA Browsersection for details.

Section Field Description
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The following table describes all the fields in the Case Analysis view. The field values 
you specify are used as the query criteria to retrieve matching cases.

Section Field Description

Narrative Narrative In this text box, enter the case narrative that the query should 
look for in cases.

Case Comment In this text box, enter the case comment that the query should 
look for in cases.

Local Evaluator 
Comment

In this text box, enter the local evaluator' comment that the 
query should look for in cases.

Abbreviated 
Narrative

In this text box, enter the abbreviated case narrative that the 
query should look for in cases.

Company Comment In this text box, enter the company's comment that the query 
should look for in cases.

Evaluation in Light 
of Similar Events

In this text box, enter the evaluation comment that takes in to 
consideration similar events that have occurred in the past. The 
query will look for the specified text in cases.
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The following table describes all the fields in the AFSSaPS page. The field values you 
specify are used as the query criteria to retrieve matching cases.

Other Information Case Seriousness Select the Yes, No, or Ignore option button, as appropriate, to 
indicate whether the query should look for cases where case 
seriousness status is specified.

Case Seriousness 
Notes

In this text box, enter the case seriousness notes that the query 
should look for in cases.

Company Agent 
Causality

Select the Yes, No, Unknown, or Ignore option button, as 
appropriate, to indicate whether the query should look for 
cases where the company agent causality status is specified.

Company Agent 
Causality Notes

In this text box, enter the company agent causality notes that 
the query should look for in cases.

Case Listedness Select the case listedness status that the query should look for 
in cases.

Case Assessment 
Listedness Notes

In this text box, enter the case assessment listedness notes that 
the query should look for in cases.

Case Outcome Select the case outcome that the query should look for in cases.

Company 
Diagnosis/Syndrome

Click the associated Encode button to use the MedDRA Browser 
to specify the company diagnosis as query criteria. See 
theUsing the MedDRA Browsersection for details.

Company 
Diagnosis/Syndrome 
Notes

In this text box, enter the company diagnosis notes that the 
query should look for in cases.

Section Field Description
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Activities Page  
The Activities page differs from what you might be used to seeing in Argus in the 
following ways:

Section Field Description

Case Event 
Imputability Details

Preferred Term Click the associated Select button to use the MedDRA 
Browser to specify the Event Preferred Term as query 
criteria.

See theUsing the MedDRA Browsersection for details.

Agent Select the suspect product that the query should look for in 
cases.

Chronology Select the imputability chronology code that the query 
should look for in cases.

Semiology Select the imputability semiology code that the query 
should look for in cases.

Bibliography Select the imputability bibliography code that the query 
should look for in cases.

Imputability Select the imputability score that the query should look 
for in cases.
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■ You can specify information only about one contact log

■ You can specify information only about one action item

■ Routing search is not applicable

The following table describes all the fields in the Activities page. The field values you 
specify are used as the query criteria to retrieve matching cases.

Section Field Description

Contact Log Contact Log Date In this date field, enter the contact log date that the query 
should look for in cases.

Contact Log Code Select the contact log code that the query should look for in 
cases.

Contact Log Group Select the contact log group that the query should look for in 
cases.

Contact Log 
Description

In this text area, enter the contact log description that the 
query should look for in cases.

Contact Log 
Responsibility

Select the user responsible for the contact log. The query will 
look for the user name you select.

Contact Log Date 
Sent

In this date field, enter the sent date for the contact.

Action Items Date Open In this date field, enter the action item opening date that the 
query should look for in cases.

Action Type Select the action type that the query should look for in cases.

Group Select the responsible group that the query should look for in 
cases.

Due Date In this date field, enter the action item due date that the query 
should look for in cases.

Description In this text area, enter the action item description that the 
query should look for in cases.

User Select the user responsible for the action item. The query will 
look for the specified user name.

Completed In this date field, enter the action item completion date that 
the query should look for in cases.
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Additional Info Page  
This Additional Information page differs from what you might be used to seeing in 
Argus in the following ways:

■ You can specify information only about one note

■ No attachments are permitted

■ You can specify information only about one reference

The following table describes all the fields in the Additional Information page. The 
field values you specify are used as the query criteria to retrieve matching cases.

Working with the Last Modified or Executed QBE
This topic explains how to view the QBE you last modified or executed.

The system assigns the Active status to a QBE when you save modifications to it or 
execute it. Unless you save the modifications to another QBE or execute another QBE, 
the last QBE you modified or executed remains Active. This is helpful in situations 
when you want to access a frequently used QBE.

Use the following procedure to view an Active QBE.

1. Select Create Query > Query by Example > Active.

Case Lock/Archive Locking Date In this date field, enter the case lock date that the query 
should look for in cases.

Archive Date In this date field, enter the case archive date that the query 
should look for in cases.

Closed By Select the user that closed the case.

Section Field Description

References Reference ID # In this text box, enter the referenced case ID that the query 
should look for in the cases.

Reference Type Select the reference type that the query should look for in 
cases.

Reference Notes In this text area, enter the reference notes that the query 
should look for in cases.
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2. The Active Query by Example page displays the QBE form for the last QBE you 
executed.

If the Active QBE was saved to the system before executing, the name of the QBE 
appears next to the Active Query Name and Name label. However, if the Active QBE 
was not saved to the system before executing, the text <Not Saved> is displayed next 
to the Active Query Name label.

From the Active Query by Example page, you can perform the following tasks:

Modifying the field values in the QBE form for an Active QBE or saving the Active 
QBE with a different name changes the Active QBE to reflect the most recent changes. 
The Active QBE also changes in case you modify the field values in the QBE form and 
execute the QBE without saving the QBE form modifications.

Task Description

Modify the values in 
the QBE form

If required, you can modify the field values in the QBE form. See theCreating a New 
QBEtopic for information on entering values in the QBE form.

While entering values in a tab, if you wish to clear all the values you entered, click the 
Clear Tab button. If you wish to all values you entered in all the tabs, click the Clear 
All button.

Use the Save button to save the changed field values. This button is only available for 
a saved Active QBE.

Save Active QBE 
with another name

Click Save As to save the Active QBE with a different name.

The QBEs that you save to the system are listed in the Query By Example - Library 
page. TheWorking with Saved QBEstopic explains how to work with saved QBEs.

Convert QBE to 
Advanced Condition

Click Convert to Advanced Condition to convert the QBE to an Advanced Condition. 
TheUsing QBEs with Advanced Conditionstopic explains how to do this.

Assign Permissions Click Permissions to set the group-level access permissions on the QBE. See 
theCreating a New QBEtopic for information on setting permissions.

The Permissions button is only available for saved Active QBEs.

Change the 
Description of the 
Active QBE

You can change the description of the Active QBE by modifying the text displayed in 
the Description text box.

Click Save to store the changed description.

Execute the Active 
QBE

Click Execute to generate a Case Series by using the Active QBE.
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Working with Saved QBEs
The Query By Example - Library page lists all of the QBEs saved to the system. Use 
the following procedure to access this page.

1. Select Create Query > Query by Example > Library. The system opens the Query 
By Example Library page.

The Query By Example - Library page displays a list of the saved QBEs in a grid 
format. The descriptions of the grid columns follow.

Searching for a Saved QBE  
Use the following procedure to search for a saved QBE:

1. Specify the search criteria, as appropriate:

■ To search for a QBE by its name, type the QBE name in the Name text box.

■ To search for a QBE by its description, type the first few words of the 
description in the Description text box. The system searches for the specified 
search string in all QBE descriptions.

■ To search for a QBE by its date of modification, enter the modification date in 
the first Last Modified date field. You can also specify a date range by typing 
the start and end dates in the first and second date fields, respectively.

■ To search for a QBE by its author, select the author name from the User Full 
Name list box.

Column Description

Name Displays the name of the QBE you specified while saving

Description Displays the QBE description you entered while saving

Last Modified Displays the date when the QBE was last modified

User Full Name Displays the name of the user who created the QBE

Category Displays the category you assigned to the QBE while saving it

Report Name The icon indicates that a report is associated with the QBE

See theAssociating a QBE with a Reportsection below for more information
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■ To search for a QBE by its category, select the category from the Category list 
box.

2. Click Search. Based on your search criteria, the system displays the search result in 
a list.

3. You can sort the search result list by clicking the sort icon next to the column 
headers in the list.

4. To clear the search result and display all the saved QBEs in the list, click the Clear 
button.

Creating a New QBE  
Instead of selecting Create Query > Query By Example > New, you can directly open 
a new QBE form by clicking New in the Query By Example - Library page.

Modifying a Saved QBE  
Use the following procedure to modify a saved QBE:

1. Select a QBE from the list of QBEs in the Query By Example - Library page.

2. Click Modify. The Query by Example page displays the QBE form for the selected 
QBE. You can modify the field values in the QBE form and save the changes by 
clicking Save. You can also save the selected query by another name by clicking 
Save As in the QBE form.

Deleting a Saved QBE  
Use the following procedure to delete a saved QBE.

1. Select a QBE from the list of QBEs in the Query By Example - Library page.

2. Click Delete. The Delete QBE dialog box appears.

3. Click OK to delete the QBE. The system deletes the selected QBE; the Query By 
Example - Library page appears.

Associating a QBE with a Report  
Argus Insight lets you associate a QBE to a particular Standard Report and schedule a 
time when the report needs to be generated and sent to another user through email. 
This is helpful in situations when you need to generate the latest Case Series and run a 
report on it each time the datamart is refreshed. Instead of manually executing the 
QBE to generate the latest Case Series and running the report, you can use the report 
association functionality of Argus Insight.
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Use the following procedure to associate a QBE with a Standard Report:

1. In the Query By Example - Library page, select the QBE that you wish to associate 
with a Standard Report.

2. Associate the QBE with a Standard Report.

3. Click Associate. The Scheduled Report Groups window appears. This window 
displays the information of all the report groups that have been scheduled by the 
logged-in user.

Note: The user who is scheduling reports should have an enterprise 
login configured in Cognos to schedule the report.

It is not possible to associate multiple reports with a query by a user. If 
user associates multiple reports against the same query, the 
scheduling information is overwritten by the latest schedule 
mentioned by the user.
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4. Click New. It enables you to either do Report Association Only or to perform 
Report Scheduling.

5. Schedule the report.

6. Click the Scheduling tab. The Reports Scheduling page appears.

7. Enter the Name and Decription of the report.

8. Use the Frequency list box to specify how often you wish to have the system run 
the selected QBE and generate the selected report. The options available are: Once, 
Daily, Weekly, Monthly, Quarterly, and Yearly.

9. Specify the start time in the Time field.

10. Based on the option you selected in the step above, specify the instant when you 
want the report generated as described in the table below.
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11. In the Start Date and End Date fields, enter the start and end dates for this 
activity, respectively.

12. Specify the email recipients of the report you scheduled.

13. In the Email Address text box, type the email address of the report recipient. If 
there are multiple recipients, use a semicolon to separate their email addresses.

14. Type the subject line in the Subject text box.

15. Type the email body text in the Body text box.

16. Select the report(s) from under Available Reports and click Add. The selected 
reports are displayed under Selected Reports. 

17. Click the selected report(s) under Selected Reports. The prompts are loaded in the 
right pane.

Frequency Option 
Selected Additional Scheduling Information to Specify

Once In the Date text box that appears, enter the date when you want to have the 
report generated.

Daily In the Time text box that appears, enter the time when you want to have the 
report generated. The time must be entered in the HH:MM AM/PM format. 
Hours should be between 1 and 12.

Weekly From the Day of Week option button group that appears, select the day of week 
on which you want to have the report generated. Also, specify the time in the 
Time text box.

Monthly Use the Day list box to select the day of the month on which you want to have 
the report generated. Also, specify the time in the Time text box.

Quarterly Quarterly reports are generated on the first day of the quarter. In the Time text 
box, enter the time when you want to have the report generated on the first day 
of the quarter.

Yearly In the Date and Time text boxes, specify the date and time when you want to 
have the yearly report generated.
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18. Enter the sub title for the report pre-filter and click OK. 

19. Click OK in the Reports Scheduling window. In case of Association only, the 
scheduling steps are not required.

20. Click OK. The system associates the QBE with the selected report and saves the 
scheduling information; Query By Example - Library page appears. The icon 
displayed in the Report column indicates that the QBE is associated with a report.
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Executing a Saved QBE  
Use the following procedure to execute a saved QBE.

1. Select a QBE from the list of QBEs in the Query By Example - Library page.

2. Click Execute. The system executes the QBE; the Active Case Series page appears.

3. If a report is associated with the saved QBE, click on Execute button. The Active 
Case Series page and Pre Filter page of the associated report is displayed.

4. Enter the prompts value in the Pre Filter page.

5. Click on the Execute button to generate the report.

6. After generating the Case Series, you can manually modify it or save it. See 
theCase Serieschapter for more information on working with Case Series.

Executing a Saved QBE on the Active Case Series  
Just as the system assigns the Active status to a QBE when you save modifications to it 
or execute it, the last saved or generated Case Series becomes the Active Case Series.

Use the following procedure to narrow down the list of cases in the Active Case Series. 
You may want to run an existing QBE on an Active Case Series instead of creating and 
running a new QBE on the entire datamart and generating a new Case Series.

1. Generate the Case Series on which you wish to run another QBE:

■ If the Case Series on which you wish to run another QBE is not yet generated 
/ active, you can either create aNew QBEand execute it or execute a saved 
QBE as explained in the previous section. This Case Series automatically 
becomes the Active Case Series and remains so until you execute another 
query to generate a different Case Series.

Note: Refer to the Associated Library and Query Library sections in 
the Library chapter, to view the steps on how to disassociate reports in 
those libraries

Note: You can also export the Case Series results into an excel file. 
For details see Exporting Case Series to Excel. 
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■ Alternatively, if the Case Series on which you wish to run another QBE is 
already saved in the system, select Query Results > Case Series > Library. In 
the Case Series Library page that appears, select the Case Series title and click 
Make Active.

2. Select Create Query > Query by Example > Library. The Query By Example - 
Library page appears.

3. Select the query you want to run on the Active Case Series you generated in step 1.

4. Check the Limit Query to Active Case Series checkbox.

5. Click Execute. The system runs the selected QBE on the Active Case Series and 
displays the Active Case Series page. Note that the Case Series you just generated 
becomes the Active Case Series.

Using QBEs with Advanced Conditions
Advanced Conditions let you create complex queries that involve Boolean and Set 
operations among various fields. In Argus Insight, Advanced Conditions are created 
in the Advanced Conditions editor, which employs a spreadsheet-like approach for 
adding query conditions (fields and their values) and conditional operators (Boolean or 
Set).

In Argus Insight, QBE is integrated with Advanced Conditions to let you perform the 
following tasks.

■ Converting a QBE to an Advanced Condition

■ Integrating a QBE with an Advanced Condition

Converting a QBE to an Advanced Condition  
A QBE can be used to start an Advanced Condition that employs Set or Boolean 
operations between QBE form fields that have specific values. When you convert a 
QBE to an Advanced Condition, all the QBE form fields in which you entered values 
are listed in the Active Advanced Conditions Editor page as Advanced Condition 
attributes.

Use the following procedure to convert a QBE to Advanced Condition.

1. Open a QBE form by either starting a new QBE, opening the Active QBE, or 
opening a saved QBE.

2. Verify the field values you specified in the various tab pages in the QBE form.

3. Click the Convert to Advanced Condition button. The Active Advanced 
Condition Editor page appears; all the fields in which you specified values in the 
QBE form are listed as Advanced Condition attributes.
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4. In the Advanced Condition editor, you can build your query further by:

■ Adding additional attributes (fields) and specifying their values

■ Adding another Advanced Condition as an attribute

■ Placing runtime parameters in attributes

■ Placing parentheses to determine the query execution order

■ Specifying conditions for attributes values

■ Specifying Set and Boolean operators to join the various attributes

See the Advanced Conditionschapter for detailed information on building Advanced 
Conditions by using the options in the Advanced Condition editor.

Integrating a QBE with an Advanced Condition  
Argus Insight lets you integrate a new, active, or saved QBE with an existing 
Advanced Condition through these Set operators: Intersect, Minus, or Union. If 
required, you can integrate your QBE with multiple Advanced Conditions. The 
multiple Advanced Conditions can have Set or Boolean operations between them.

Use the following procedure to integrate a QBE with existing Advanced Conditions:

1. Open a QBE form bystarting a new QBE, opening the Active QBE, or opening a 
saved QBE.

2. Verify the field values you specified in the various tab pages in the QBE form.

3. Click the Advanced Conditions tab in the QBE form. The Advanced Condition 
tab page displays the Advanced Condition editor.
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4. Use the Operator list box to specify the Set operator you want to use to integrate 
the QBE and the Advanced Condition. You can select one of these options: 
Intersect, Minus, Union.

5. Select the Advance Condition you want to integrate with the QBE.

6. Click the icon on the left bar. A context menu appears. In the context menu, all the 
Advanced Conditions which are stored in the system and are accessible to the user 
are organized by categories.

7. In the context menu, browse to the appropriate category and select the required 
Advanced Condition. The selected Advanced Condition appears as a row in the 
Advanced Condition editor.
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8. If required, add other Advanced Conditions. Click the icons on the left bar to 
insert another Advanced Condition above or below the existing Advanced 
Condition.

9. Type parentheses in the ( and ) columns to determine the order of execution for the 
selected Advanced Conditions.

10. Use the list box in the Operator column to specify the operators between the 
selected Advanced Conditions. You can select from these options: AND, OR, 
Intersect, Minus, and Union.

11. Save the integrated query by clicking Save As.

12. Click Execute to run the integrated QBE and generate the Case Series. The Active 
Case Series page appears; the Case Series is displayed. See the Case Series chapter 
for more information on working with Case Series.

Filters
WhileQBElets you create queries by specifying unique field values in the various tab 
pages of the QBE form, Filters let you create queries by specifying multiple or a range 
of values (in numeric or date fields) for each field in a set of fields displayed on a 
single page. Therefore, you may choose Filters in situations when your querying 
criteria is based on multiple values or a range of values in fields.

Argus Insight provides five predefined Filters. Each predefined Filter comprises of a 
set of specific datamart fields called filter elements. The following table lists the five 
predefined Filters and the elements associated with them.

Tip: You can change the structure of thequery by changing order of 
rows in the editor. Use the following procedure to To do this, select a 
row and click the Up or Down buttons to move the row upwards or 
downwards.

Note: See the Advanced Conditions chapter for detailed information 
on creating Advanced Conditions by using the options in the 
Advanced Condition editor.

Note: You can convert the integrated QBE and Advanced Condition 
into a single Advanced Condition by clicking Convert to Advanced 
Condition. See Converting a QBE to an Advanced Condition for 
details.

Note: The Filters field labels are displayed as per the field labels 
configured in Argus.
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Predefined Filter 
Name Associated Elements (Fields)

Compliance Case Followup 
Receipt Date

Case Initial Receipt 
Date

Case Report Type

Country of Incidence Event Listedness/Lic 
Country

Family Name

Owned by Site Product Project/Study/Center

Related to Study 
Conduct? (As 
Reported)

Report Agency Report Form

Report Submission 
Date

Reporting Group Advanced 
Conditions

Configuration Country of Incidence Product Project/Study/Cente
r

Advanced 
Conditions

Management Case Delayed/Open Case Followup 
Receipt Date

Case Initial Receipt 
Date

Case Report Type Case Seriousness Case Status

Country of Incidence Has Followup Owned by Site

Product Reports Pending Workflow Group

Advanced 
Conditions

Pharmacovigilance ATC Code BMI Case Abbreviated 
Narrative

Case Comment Case Followup 
Receipt Date

Case Initial Receipt 
Date

Case Narrative Case Outcome Case Seriousness

Company Comment Country of Incidence Dosage Regimen 
route of 
Administration

Dose Drug Duration of 
Administration

Evaluation in Light 
of Similar Events

Event Diagnosis Flag Event Seriousness Event Term

Local Evaluator 
Comment

Onset Latency 
(minutes)

Outcome of Event

Patient Age (In Years) Patient Age Group Patient Ethnicity

Patient 
Gender/Pregnancy

Patient Relevant Tests Product

Product Type Project/Study/Cente
r

Rechallenge/Dechallen
ge

Relevant History 
Condition

Reporter Type/HCP Study Blinding Status

Time to Onset from 
First Dose

Time to Onset from 
Last Dose

Advanced Condition
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Argus Insight also lets you define custom Filters by letting you select a set of elements 
(datamart fields) and saving the selection as your own Filter.

To create a filter using queries, select a predefined or custom Filter and specify values 
(multiple or range) in the desired filter elements associated with the Filter. You can 
then execute this query (Value Set)to generate a Case Series.

The set of values you specify in the elements associated with a Filter is called a Value 
Set. For example, a particular Filter may have this Value Set:

Argus Insight lets you save Value Sets. Therefore, each Filter can have multiple Value 
Sets. The advantage of saving Value Sets is that this enables you to execute a Value Set 
later without having to select a Filter and then entering values in the associated 
elements.

The topics that follow explain how to work with Filters.

■ Using Predefined Filters

■ Creating Custom Filters

■ Working with the Last Modified or Executed Value Set

■ Working with Saved Filters and Value Sets

■ Using Filters with Advanced Conditions

Using Predefined Filters
This topic explains how to:

■ Select a predefined Filter

■ Create a Value Set for the predefined Filter by entering values in the associated 
elements

Workflow Case Delayed/Open Case Followup 
Receipt Date

Case Initial Receipt 
Date

Case Report Type Case Seriousness Case Status

Event Listedness/Lic 
Country

Event Term Family Name

Has Followup Owned by Site Product

Project/Study Workflow Group Advanced 
Conditions

Filter Element Values Specified

Country of Incidence United States and Germany

Product Name CureAll Injection and CureAll Capsule

Coded Event 
Description

Injection site rash and Aggravated Nausea

Seriousness Criteria Hospitalized and Intervention Required

Patient Age 25 to 65 years Note that ranges can only be 
specified for fields that have numeric values

Predefined Filter 
Name Associated Elements (Fields)
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■ Generate a Case Series by executing the Value Set

Selecting a Predefined Filter  
Use the following procedure to select a predefined filter.

1. Select Create Query > Filters > New Value Set. The Select Filter for New Value Set 
dialog box appears.

2. Select a predefined Filter (Compliance, Configuration, Management, 
Pharmacovigilance, and Workflow) depending on your reporting needs. For 
example, select Compliance. If there are any custom Filters saved to the system, 
you can select one of those as well

3. Click OK. The Filter Value Set page appears.

Note: The Select Filter for New Value Set dialog box displays a list 
of all the predefined as well ascustom Filters and their associated 
elements. You need to scroll down the dialog box to view all the 
Filters.
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Create a Value Set  
Use the following procedure to create a value set.

1. Specify values for the Filter elements in the various sections. Depending on the 
Filter you selected, the Filter Value Set page may contain these sections:

Note: In the Filter Value Set page, all the elements associated with 
the Filter are organized in sections. You need to scroll down the page 
to view all the sections. All the predefined Value Sets contain the 
Advanced Condition section. You can use the options in this section 
to select an existing Advanced Condition and integrate your Value Set 
with it. See theIntegrating a Value Set with an Advanced Condition 
topic for details. You can also convert the entire Value Set to an 
Advance Condition. The Converting a Value Set to an Advanced 
Condition topic explains how to do this.

Sections in the New 
Value Set Page Associated Elements (Fields)

Case Information Case Followup 
Receipt Date

Case Initial Receipt 
Date

Case Report Type

Country of Incidence Event Listedness/Lic 
Country

Family Name

Owned by Site Product Project/Study

Patient Information Patient Age Group Patient Age (In Years) BMI

Patient 
Gender/Pregnancy

Patient Ethnicity

Product Information Regimen Daily Dose Total Regimen 
Dosage

Product

Drug Primary 
Indication Code

Rechallenge/Dechallen
ge

Total Drug Dosage

ATC Code
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2. Examine the Value Set result.

3. Click Execute.

4. While the system searches for matching cases, the following dialog box is 
displayed.

Event Information Event Seriousness Event Term Onset Latency 
(minutes)

Outcome of Event Event Listedness/Lic 
Country

Related to Study 
Conduct? (As 
Reported)

Workflow 
Information

Workflow Group Has Followup Case Status

Case Delayed/Open

Miscellaneous 
Information

Lab Test/Assessment Lab Results

Report Information Reports Pending Report Agency Report Submission 
Date

Reporting Group Report Form

Note: The MedDRA browser can be accessed from the Create Query 
> Filters New Value Set > Pharmacovigilance | Workflow categories. 
The MedDRA browser for Pharmacovigilance | Workflow filter 
categories supports the following options specific to Filters: All 
hierarchy radio-button Use this option to enable a query search based 
on all/selected hierarchical terms in MedDRA. The search output 
captured depends on the check-boxes selected in the MedDRA 
browser window. Term only radio-button Use this option to select 
multiple terms within a specific AE term. Click on the term(s) you 
want to include in your search criteria. These terms are highlighted in 
yellow. The output based on the term(s) selected in the MedDRA 
browser, is populated in the relevant section of the Filter.

Sections in the New 
Value Set Page Associated Elements (Fields)
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If the system finds cases that match the query criteria, a list of such cases is 
displayed in the Active Case Series page.

5. Examine the Case Series. If the Case Series is too large, you may want to modify 
the Value Set to narrow down the Case Series. Alternatively, if you find the Case 
Series to be appropriate, you can save the Value Set to the system.

6. To return to the Filter Value Set page, click View Query in the Active Case Series 
page. The Filter Value Set page appears.

7. If required, modify the Value Set and examine the result again or proceed to save 
the Value Set.

Tip: You may cancel the query execution at this point and return to 
the Filter Value Set page by clicking Cancel Query in the dialog box 
above.

Note: When you save the modifications to a Value Set or execute a 
Value Set, the system assigns the Active status to the Value Set. 
Therefore, when you return to the Value Set page, the Active Query 
Name label displays the name of the Filter.
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8. Save the Value Set to the system.

9. Type a description of the Value Set in the Description text box. For example, you 
can describe the type of cases the Value Set retrieves.

10. Click Save Values. The Save Value Set dialog box appears.

11. Type the name of the Value Set in the Name text box.

12. Click OK. The system refreshes the Filter Value Set page. Note that the following 
new elements appear on the page.

■ The Name label displays the name of the Value Set page you specified

■ Two new buttons appear at the bottom of the page: Save Values As and 
Permissions.

13. Assign group-level permissions on the saved Value Set.

14. Click the Permissions button. The Permissions dialog box appears. A list in this 
dialog box displays the names of all the groups (except the Administrator group) 
that the system administrator has created.

Note: All the Value Sets you save to the system are listed in the Filter 
Library page. The topicWorking with Saved Filters and Value Sets 
explains how to work with saved Value Sets.

Tip: If you make modifications to thefield values after you have 
saved the Values Set to the system, use the Save Values button to save 
the changed field values. To save the Value Set by another name, use 
the Save Values As button. To clear all the field values in the Filter 
Value Set page, click Clear.
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15. Use the list box next to a group name to assign permissions to the group members 
on the Value Set you have created. You can select from these options:

16. Click OK. The system saves the permission settings.

Executing a Value Set  
Use the following procedure to execute a Value Set.

1. Click Execute.

2. The system retrieves the list of cases that match the Value Set criteria and displays 
it in the Active Case Series page.

Permission Description

No Access (Default) No group members will be able to access the Value Set

R Group members will only be able to view the Value Set

R/W Group members will be able to view and modify the Value Set

R/W/D Group members will be able to view, modify, and delete the Value Set

R/W/D/P Group members will be able to view, modify, delete, and assign 
permission on the Value Set

Note: The author of the Value Set always has the highest level of 
permission (R/W/D/P) on it. For example, you belong to the Data 
Entry group and you assign the No Access permission level to the 
Data Entry group on a Value Set that you create. In this case, while 
you will continue to have the highest level of permission on your 
Value Set, other members in your group will not be able to access your 
Value Set.
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3. After generating the Case Series, you can manually modify it or save it. See the 
Case Serieschapter for more information on working with Case Series.

Creating Custom Filters
This topic explains how to:

■ Create a custom Filter

■ Create a Value Set for the custom Filter

■ Generate a Case Series by executing the custom Value Set

Creating a Custom Filter  
Use the following procedure to create a custom filter.

1. Select Create Query > Filters > Library. The Filter Library page appears. This 
page lists the predefined as well as custom Filters and their values sets in a control 
tree format.

2. Click the New Filter button. The Filter Elements page appears.
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3. From the Available Elements list, select an element you want to associate with the 
custom Filter.

4. Click the > button to associate the selected element with the custom Filter. The 
selected element appears in the Selected Elements list.

5. Save the Filter.

6. Use the Category list box to assign a category to the custom Filter. A category 
indicates the reporting aspect to which your Filter pertains: Compliance, 
Configuration, General, Management, or Pharmacovigilance. Specifying the 
category also helps you in searching the relevant Filters from a list of all the Filters 
saved in the system.

7. Type a description of the custom Filter in the Description text box.

Tip: To add all the elements in Available Elements list to the 
Selected Elements list, click the >> button.

To remove an element from the Selected Elements list, click the > 
button.

To remove all the elements from the Selected Elements list, click >> 
the button.



Creating Queries

Creating Queries 4-60

8. Click Save. The Save Filter dialog box appears.

9. Enter the custom Filter name in the Name text box.

10. Click OK. The system saves the custom Filter; the Filter Elements page refreshes. 
Note that the following new elements appear on the page.

11. The Name label displays the name of the saved filter.

12. The Active Query Name label in the upper-right corner of the page now displays 
the name of the Filter you specified.

13. Two new buttons appear at the bottom of the page: Save As and Permissions.

14. Assign group-level permissions on the Filter.

15. Click the Permissions button. The Permissions dialog box appears. A list in this 
dialog box displays the names of all the groups (except the Administrator group) 
that the system administrator has created.

16. Use the list box next to a group name to assign permissions to the group members 
on the Filter you created. You can select from these options:

Note: If you make modifications to the Filter elements after you have 
saved the Filter to the system, use the Save button to save the changes. 
To save the Filter by another name, use the Save As button.
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17. Click OK. The system saves the permission settings.

Creating a Value Set for a Custom Filter  
Use the following procedure to create a value set for a custom filter.

1. Click Continue in the Filter Elements page. The Filter Value Set page appears.

Permission Description

No Access (Default) No group members will be able to access the Filter

R Group members will be able to only view the Filter

R/W Group members will be able to view and modify the Filter

R/W/D Group members will be able to view, modify, and delete the Filter

R/W/D/P Group members will be able to view, modify, delete, and assign permission 
on the Filter

Note: The author of the Filter always has the highest level of 
permission (R/W/D/P) on the Filter. For example, you belong to the 
Data Entry group and you assign the No Access permission level to 
the Data Entry group on a Filter that you create. In this case, while 
you will continue to have the highest level of permission on your 
Filter, other members in your group will not be able to access the 
Filter.

Note: In the Filter Value Set page, all the elements associated with 
the Filter are organized in sections. You need to scroll down the page 
to view all the sections. If you included the Advanced Condition 
element while creating your Filter in step 2, the Filter Value Set page 
displays an additional section Advanced Condition. You can use the 
options in this section to create an Advanced Condition and integrate 
your Value Set with it. See theIntegrating a Value Set with an 
Advanced Condition topic for details. You can also convert the entire 
Value Set to an Advance Condition. The Converting a Value Set to an 
Advanced Condition topic explains how to do this.
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2. Specify values for the Filter elements. See step 2 in the Using Predefined Filters 
topic for details.

3. Examine the Value Set result.

4. Click Execute. While the system searches for matching cases, the following dialog 
box is displayed.

5. If the system does not find any cases that match the querying criteria, the 
following dialog box is displayed. Click OK in this dialog box to return to the 
Value Set form, modify the criteria, and execute the Value Set again.

6. If the system finds cases that match the query criteria, a list of such cases is 
displayed in the Active Case Series page.

Note: You may cancel the query execution at this point and return to 
the Filter Value Set page by clicking Cancel Query in the dialog box 
above.
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7. Examine the Case Series. If the Case Series is too large, you may want to add 
additional elements to the Filter or modify the Value Set. Alternatively, if you find 
the Case Series to be appropriate, you can save the Value Set to the system.

8. To return to the Filter Value Set page, click View Query in the Active Case Series 
page. The Filter Value Set page appears.

9. If required, modify the Value Set and examine the result again or proceed to save 
the Value Set.

10. Save the Value Set to the system.

11. Type a description of the Value Set in the Description text box. For example, you 
can describe the type of cases the Value Set retrieves.

12. Click Save Values. The Save Value Set dialog box appears.
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13. Type the name of the Value Set in the Name text box.

14. Click OK. The system refreshes the Filter Value Set page. Two new buttons 
appear at the bottom of the page: Save Values As and Permissions.

15. Assign group-level permissions on the saved Value Set.

Note: The name cannot contain any of the following: % " ' ^ ~,;|#`

Note: The Filter Library page displays the custom as well as 
predefined Filters and their Values Sets in a control tree format. From 
this page you can select a Value Set and directly execute it. See 
theWorking with Saved Filters and Value Sets topic for more 
information on the Filter Library page. The saved Filters also appear 
in the Select Filter for New Value Set dialog box from where you can 
select the desired filter, enter values in the New Value Set page and 
execute. See the Using Predefined Filters topic for more information.

Tip: If you make modifications to the field values after you have 
saved the Values Set to the system, use the Save Values button to save 
the changed field values. To save the Value Set by another name, use 
the Save Values As button.To clear all the field values in the Filter 
Value Set page, click Clear.
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16. Click the Permissions button. The Permissions dialog box appears. A list in this 
dialog box displays the names of all the groups (except the Administrator group) 
that the system administrator has created.

17. Use the list box next to a group name to assign permissions to the group members 
on the Value Set you have created. You can select from these options:

18. Click OK. The system saves the permission settings.

19. Click Execute. The system retrieves the list of cases that match the Value Set 
criteria and displays it in the Active Case Series page. After generating the Case 
Series, you can manually modify it or save it. See theCase Serieschapter for more 
information on working with Case Series.

Working with the Last Modified or Executed Value Set
This topic explains how to view the Value Set you last modified or executed.

The system assigns the Active status to a Value Set when you save modifications to it 
or execute it. Unless you save the modifications to another Value Set or execute it, the 

Permission Description

No Access (Default) No group members will be able to access the Value Set

R Group members will be able to only view the Value Set

R/W Group members will be able to view and modify the Value Set

R/W/D Group members will be able to view, modify, and delete the Value Set

R/W/D/P Group members will be able to view, modify, delete, and assign 
permission on the Value Set

Note: The author of the Value Set always has the highest level of 
permission (R/W/D/P) on it.
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last Value Set you modified or executed remains Active. This is helpful in situations 
when you want to access a frequently used Value Set.

Use the following procedure to view an Active Value Set,

1. Select Create Query > Filters > Active. The Filter Value Set page displays the 
Value Set you executed or modified last.

2. If the Value Set was saved to the system before executing, the name of the Value 
Set appears next to Name label. In addition, the name of the Filter appears next to 
the Active Query Name label.

3. However, if the Value Set was not saved to the system before executing, the text 
<Not Saved> is displayed next to the Name label.

4. From the Active Filter Value Set page, you can perform the following tasks:

Task Description

Modify the Active 
Value Set

If required, you can modify the Value Set by changing the field values.

While entering field values, if you wish to clear all the values you entered, click 
the Clear button.

Use the Save Values button to save the changed field values. This button is only 
available for a saved Value Set.

Save the Active 
Values Set by another 
name

Click Save Values As to save the Active Value Set by a different name.

The Value Sets you save to the system are listed in the Filters Library page. 
TheWorking with Saved Value Setstopic explains how to work with saved Value 
Sets.

Convert Active Value 
Set to Advanced 
Condition

Click Convert to Advanced Condition to convert the Active Values Set to an 
Advanced Condition. TheConverting a Value Set to an Advanced Conditiontopic 
explains how to do this.

Assign Permissions 
on the Active Value 
Set

Click Permissions to set the group-level access permissions.

The Permissions button is only available for saved Value Sets.

Change the 
Description of the 
Active Value Set

You can change the description of the Active Value Set by modifying the text 
displayed in the Description text box.

Click Save Values to store the changed description.

Execute the Active 
Value Set

Click Execute to generate a Case Series by using the Active Value Set.
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Working with Saved Filters and Value Sets
The Filter Library page lists all the predefined as well as saved custom Filters and 
their Value Sets in a control tree format. To access this page, select Create Query > 
Filters > Library.

To view the Values Sets associated with a Filter, expand the control tree for a Filter. The 
saved Value Sets are displayed below each Filter.

The descriptions of the columns in the Filter Library page follow.

Searching Saved Filters and Value Sets  
Use the following procedure to search for a saved Filter or Value Set.

1. Specify the search criteria, as appropriate:

■ To search for a Filter/Value Set by its name, type the Filter/Value Set name in 
the Name text box.

Note: When the field values for an Active Values Set are modified or 
the Active Value Set is saved by a different name, the changes in the 
Active Value Set reflect the most recent changes. The Active Value Set 
also changes in case you modify the field values and execute the Value 
Set without saving the modifications.

Column Description

Name Displays the name of the Filters and Value Sets

Description Displays the description of the Filters and Value Sets

Last Modified Displays the date when the Filters/Value Set was last modified

User Full Name Displays the name of the user who created the Filter/Value Set

Category Displays the Filter category

Value Set Displays the number of Value Sets created for a Filter

Report The report icon indicates that a report is associated with a Value Set

See theAssociating a Value Set with a Reportsection below for more 
information
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■ To search for a Filter/Value Set by its description, type the first few words of 
the description in the Description text box. The system searches for the 
specified search string in all Filter/Value Set descriptions.

■ To search for a Filter/Value Set by its date of modification, enter the 
modification date in the first Last Modified date field. You can also specify a 
date range by typing the start and end dates in the first and second date fields, 
respectively.

■ To search a Filter/Value Set by its author, select the author name from the User 
Full Name list box.

■ To search for a Filter by its category, select the category from the Category list 
box.

2. Click Search. Based on your search criteria, the system displays the search result in 
a list.

3. You can sort the search result list by clicking the sort icon next to the column 
headers in the list.

Creating a New Filter  
Click the New Filter button in the Filter Library page. See theCreating Custom 
Filterstopic for details.

Creating a New Value Set  
Instead of selecting Create Query > Filters > New Values Set to create a new Value 
Set, you can click the New Value Set button in the Filter Library page. You can create 
Value Sets for predefined as well as custom Filters by using this method. See theUsing 
Predefined Filterstopic for details.

Modifying a Filter or Value Set  
Use the following procedure to modify a Filter or Value Set.

1. Select the Value Set or the Filter from the list in the Filter Library page.

2. Click Modify. If you selected a Filter, the Filter Elements page appears. If you 
selected a Value Set, the Filter Value Set page appears.

3. Make your modifications to the Filter or Value Set, as appropriate.
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4. Click Save to save the modifications you made in the Filter Elements page. If you 
modified a Value Set, click Save Values in the Filter Value Set page to save the 
changes.

Deleting a Filter or Value Set  
You can delete the Value Sets for predefined as well as custom Filters. You can also 
delete custom Filters. However, you cannot delete the predefined Filters. When you 
delete a Filter, all its associated Value Sets are also deleted.

Use the following procedure to delete a Value Set or a custom Filter.

1. Select the Value Set or the custom Filter from the list in the Filter Library page.

2. Click Delete. The delete confirmation dialog box appears.

3. Click OK. The system deletes the selected Filter/Value Set; the Filter Library page 
appears.

Associating a Value Set with a Report  
Argus Insight lets you associate a Value Set to a particular Standard Report and 
schedule a time when the report needs to be generated and sent to another user 
through email. This is helpful in situations when you need to generate the latest Case 
Series and run a report on it each time the datamart is refreshed. Instead of manually 
executing the Value Set to generate the latest Case Series and running the report, you 
can use the report association functionality of Argus Insight.

Use the following procedure to associate a Value Set with a Standard Report:

1. In the Filter Library page, select the Value Set that you wish to associate with a 
Standard Report.

Associate the Value Set with a Standard Report.

2. Click Associate. The Scheduled Reports Group dialog box appears. This page 
displays a list of all groups of reports which were scheduled or associated with the 
query.

Note: The user who is scheduling reports should have an enterprise 
login configured in Cognos to schedule the report.
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3. Click New and a context menu appears. Select Scheduling.

4. The Reports Scheduling window appears.

5. On this window, you can schedule multiple reports at once.

6. Schedule the report.

7. This window has 3 main sections:

■ Scheduling Information - The Schedule timing and E-Mail information.

■ Available Reports - All the available reports in the system that can be 
scheduled.

■ Selected Reports - These reports are scheduled.

8. Provide a Name for your reports group along with description.

9. Use the Frequency list box to specify how often you wish to have the system run 
the selected QBE and generate the selected report. The options available are: Once, 
Daily, Weekly, Monthly, Quarterly, and Yearly.
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10. Specify the schedule time in the Time field.

11. Based on the option you selected in the step above, specify the instant when you 
want the report generated as described in the table below.

12. Specify the email recipients of the report you scheduled.

13. In the Email Address text box, type the email address of the report recipient. If 
there are multiple recipients, use a semicolon to separate their email addresses.

14. Type the subject line in the Subject text box.

15. Type the email body text in the Body text box.

16. If you want all the reports in a single mail, leave the Send separate mail for each 
report checkbox unchecked. If you check this checkbox, each report is delivered in 
a separate mail to the user.

17. From the Available reports grid, select a report and click Add button. The report 
will be selected and will appear in the Selected Reports section.

18. To remove a report from Selected Reports, click the X button against the report. 
When you click the selected report(s) in this section, its corresponding prompts are 
loaded in the right pane.

19. Enter the sub-title for the report pre-filter in the right pane and click OK.

20. Click OK in the Reports Scheduling window.

21. Click OK. The system associates the Value Set with the selected report and saves 
the scheduling information; the FilterLibrary page appears. The icon displayed in 
the Associated Report column indicates that the Value Set is associated with a 
report.

Frequency Option 
Selected Additional Scheduling Information to Specify

Once In the Date text box that appears, enter the date when you want to have the report 
generated.

Daily In the Time text box that appears, enter the time when you want to have the report 
generated. The time must be entered in the HH:MM AM/PM format. Hours should 
be between 1 and 12.

Weekly From the Day of Week option button group that appears, select the day of week on 
which you want to have the report generated. Also, specify the time in the Time 
text box.

Monthly Use the Day list box to select the day of the month on which you want to have the 
report generated. Also, specify the time in the Time text box.

Quarterly Quarterly reports are generated on the first day of the quarter. In the Time text box, 
enter the time when you want to have the report generated on the first day of the 
quarter.

Yearly In the Date and Time text boxes, specify the date and time when you want to have 
the yearly report generated.
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Executing a Value Set  
Use the following procedure to execute a Value Set.

1. Select a Value Set from the list in the Filter Library page.

2. Click Execute. The system executes the Value Set; the Active Case Series page 
appears.

3. If a report is associated with the saved QBE, click Execute. The Active Case Series 
page and Pre Filter page of the associated report is displayed.

4. Enter the prompts value in the Pre Filter page.

5. Click on the Execute button to generate the report.

After generating the Case Series, you can manually modify it or save it. See the 
Case Series chapter for more information on working with Case Series.

Note: Refer to the Associated Library and Query Library sections in 
the Library chapter, to view the steps on how to disassociate reports in 
those libraries.
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Executing a Saved Value Set on the Active Case Series  
Just as the system assigns the Active status to a Value Set when you save modifications 
to it or execute it, the last saved or generated Case Series becomes the Active Case 
Series.

Use the following procedure to narrow down the list of cases in the Active Case Series, 
you may want to run a Value Set on an Active Case Series.

1. Generate the Case Series on which you wish to run another Value Set:

■ You can generate the Case Series by Using Predefined Filters or Creating 
Custom Filters and executing a Value Set. This Case Series automatically 
becomes the Active Case Series and remains so until you execute another 
query to generate a different Case Series.

■ Alternatively, if the Case Series on which you wish to run another Value Set is 
already saved in the system, select Query Results > Case Series > Case Series 
Library. In the Case Series Library page that appears, select the Case Series 
title and click Make Active.

2. Select Create Query > Filters > Library. The Filter Library page appears.

3. Select the Value Set you want to run on the Active Case Series you generated in 
step 1.

4. Check the Limit Query to Active Case Series checkbox.

5. Click Execute. The system runs the selected Value Set on the Active Case Series 
and displays the Active Case Series page. Note that the Case Series you just 
generated becomes the Active Case Series.

Using Filters with Advanced Conditions
Advanced Conditions let you create complex queries that involve Boolean and Set 
operations among various fields. In Argus Insight, Advanced Conditions are created 
in the Advanced Conditions editor, which employs a spreadsheet-like approach for 
adding query conditions (fields and their values) and conditional operators (Boolean or 
Set).

In Argus Insight, Filters are integrated with Advanced Conditions to let you perform 
the following tasks.

■ Converting a Value Set to an Advanced Condition

■ Integrating a Value Set with an Advanced Condition

Converting a Value Set to an Advanced Condition  
A Filter Value Set can be used to start an Advanced Condition that employs Set or 
Boolean operations between elements that have multiple values. When you convert a 
Value Set to an Advanced Condition, al its fields are listed in the Active Advanced 
Conditions Editor page as Advanced Condition attributes.

Use the following procedure to convert a Value Set to an Advanced Condition

1. Create a new Value Set by either Using Predefined Filters or Creating Custom 
Filters. Alternatively, open a saved Value Set from the Filters Library page 
(seeWorking with Saved Value Sets).

2. Verify the field values you specified in the various fields in the Value Set.

3. Click the Convert to Advanced Condition button. The Active Advanced 
Condition Editor page appears; all the fields in which you specified values in the 
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QBE form are listed as Advanced Condition attributes. The fields in which you 
selected multiple values are repeated.

In the Advanced Condition editor, you can build your query further by:

■ Adding additional attributes (fields) and specifying their values

■ Adding another Advanced Condition as an attribute

■ Placing runtime parameters in attributes

■ Placing parentheses to determine the query execution order

■ Specifying conditions for attributes values

■ Specifying Set and Boolean operators to join the various attributes

See theAdvanced Conditionssection for detailed information on building 
Advanced Conditions by using the options in the Advanced Condition editor.

Integrating a Value Set with an Advanced Condition  
Argus Insight lets you integrate a Value Set with an existing Advanced Condition 
through these Set operators: Intersect, Minus, or Union. If required, you can integrate a 
Value Set with multiple Advanced Conditions. The multiple Advanced Conditions can 
have Set or Boolean operations between them.

Use the following procedure to integrate a Value Set with existing Advanced 
Conditions.

1. Create a new Value Set by eitherUsing Predefined FiltersorCreating Custom 
Filters. Alternatively, open a saved Value Set from the Filters Library page 
(seeWorking with Saved Value Sets). If you create a custom Value Set, make sure 
you include the Advance Condition element.

Note: Only those Value Sets that have the Advanced Condition 
element can be integrated with Advanced Conditions. All Value Sets 
that you create for predefined Filters contain the Advanced Condition 
element. If you wish to convert a customFilter Value Set to an 
Advanced Condition, make sure you select the Advanced Condition 
element while creating the custom Filter.
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2. In the Filter Value Set page, verify the field values you specified you specified for 
the Value Set.

3. Scroll down to the Advanced Condition section in the Filter Value Set page.

4. Use the Operator list box to specify the Set operator you want to use to integrate 
the Values Set and the Advanced Condition. You can select one of these options: 
Intersect, Minus, Union.

5. Select the Advance Condition you want to integrate with the QBE.

6. Click the context menu icon. A context menu appears. In the context menu, all the 
Advanced Conditions stored in the system are organized by categories.

7. In the context menu, browse to the appropriate category and select the required 
Advanced Condition. The selected Advanced Condition appears as a row in the 
Advanced Condition editor.

8. If required, add other Advanced Conditions. Click the icon to insert another 
Advanced Condition above the existing Advanced Condition. Click the icon to 
insert another Advanced Condition below the existing Advanced Condition.

9. Type parentheses in the ( and ) columns to determine the order of execution for the 
selected Advanced Conditions.

Tip: You can change the structure of thequery by changing order of 
rows in the editor. To do this, select a row and click the arrow button 
to move the row up or down.



Creating Queries

Creating Queries 4-76

10. Use the list box in the Operator column to specify the operators between the 
selected Advanced Conditions. You can select from these options: AND, OR, 
Intersect, Minus, and Union.

11. Save the integrated query by clicking Save As.

12. Click Execute to run the integrated Value Set and generate the Case Series. The 
Active Case Series page appears; the Case Series is displayed. See theCase 
Serieschapter for more information on working with Case Series.

Advanced Conditions
The Advanced Conditions querying tool is designed to allow the greatest flexibility in 
designing the most advanced queries. Argus Insight users can use Advanced 
Conditions to create complex queries that involve Boolean and Set operations using 
Structured Query Language (SQL).

In Argus Insight, Advanced Conditions are created in the Advanced Conditions editor, 
which employs a spreadsheet-like approach for adding query conditions (fields and 
their values) and conditional operators (Boolean or Set).

Refer to the following topics for more information on working with Advanced 
Conditions.

■ Creating a New Advanced Condition

■ Working with the Last Modified or Saved Advanced Condition

■ Working with Saved Advanced Conditions

Creating a New Advanced Condition
This topic explains how to:

■ Start a new Advanced Condition

■ Use the Advanced Condition Editor options to build your Advanced Condition

■ Generate a Case Series by executing the Advanced Condition

Starting a New Advanced Condition  
Use the following procedure to start a new advanced condition.

Note: See theAdvanced Conditions chapter for detailed information 
on creating Advanced Conditions by using the options in the 
Advanced Condition editor.

Note: You can convert the integrated Value Set and Advanced 
Condition into a single Advanced Condition by clicking Convert to 
AdvancedCondition. SeeConverting a Value Set to an Advanced 
Condition for details.

Note: The Advanced Conditions field labels are displayed as per the 
field labels configured in Argus.
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1. Start the new Advanced Condition. Select Create Query > Advanced Conditions > 
New. The Advanced Conditions Editor page appears.

2. Enter the Advanced Condition attributes (fields and values)

3. Click the context menu icon. A context menu appears. In the context menu, the 
first seven categories (Activities, Additional Info, Analysis, Events, General, 
Patients, and Products) represent the Argus case form tabs. In these categories, the 
various datamart fields that pertain to case information are organized in this 
hierarchy: Argus case form tab > sections within the tab page > Fields within the 
section. You can browse through the appropriate hierarchy and select the required 
field as an Advanced Condition attribute. 

The eighth category Reports contains attributes that pertain to the reporting 
information of a case. You can browse through the Reports category and select the 
required Advanced Condition attribute. 

The ninth category AC Library lists all the Advanced Conditions stored in the 
system. You can browse through the AC Library category and select a stored 
Advanced Condition as an attribute for the new Advanced Condition.

Note: You can also start an Advanced Condition by converting a 
Advanced Condition or a Filter Value Set to Advanced Condition. See 
these topics for details: Converting a Advanced Condition to an 
Advanced Condition and Converting a Value Set to an Advanced 
Condition.



Creating Queries

Creating Queries 4-78

4. Browse through the appropriate category hierarchy and select the required 
attribute. The selected attribute appears as a row in the editor.

5. In the Value field, enter the value for the selected attribute. Depending on the type 
of attribute you selected, the system lets you populate the Value field by using a:

■ List box to select from a set of predefined values

■ Text box to enter text strings or numerals

■ Date field to enter dates

■ Browser to select MedDRA dictionary terms, company products, WHO drugs, 
clinical study IDs, Drugs in Study (incl. Comparators) and Investigational 
Drugs.

Note: The user defined fields in Argus which have been converted as 
a look up are also available as attributes for the advanced condition 
search.
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■ Use the following procedure to use a Browser to populate the Value field, click 
the ellipsis button next to the Value field; in the context menu that appears, 
select the option corresponding to the browser name to launch the browser.

6. Specify the condition for the attribute value. Use the Conditions list box to specify 
a condition as explained below:

Note: The MedDRA browser for Create Query > Advanced 
Conditions tab, can be called for search criteria based on specific 
terms. The search criteria can be based on the specific term codes or 
descriptions depending on your requirement. Refer to the 
followingexample for more information.

1. Select the Attribute from the Advanced Condition form.

2. The Attribute chosen in the sample example is Product > Product 
Drug > Product Indication PT.The PT description of the Product 
Indication is returned to the Advanced Condition Page.

3. Select the Condition, Value and Operator depending on your 
search-criteria.

4. Click Execute to run the Advanced Condition query.

equal to - select this option if you want to 
retrieve cases where the selected attribute's 
value is equal to what the Value field 
specifies

not equal to - select this option if you want to retrieve 
cases where the selected attribute's value is not equal to 
what the Value field specifies
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7. Specify runtime parameters, as appropriate.

8. Identify the attribute row where you want to specify runtime parameters.

9. Click the ellipsis button next to the Value field. A context menu appears.

10. Select the Parameters option.

greater than - select this option if you want 
to retrieve cases where the selected 
attribute's value is greater than what the 
Value field specifies

greater than or equal to - select this option if you want to 
retrieve cases where the selected attribute's value is greater 
than or equal to what the Value field specifies

less than - select this option if you want to 
retrieve cases where the selected attribute's 
value is less than what the Value field 
specifies

ess than or equal to - select this option if you want to 
retrieve cases where the selected attribute's value is less 
than or equal to the Value that the field specifies

missing - select this option if you want to 
retrieve cases where the selected attribute's 
value has not been specified

exists - select this option if you want to retrieve cases 
where the selected attribute has any value

begins with - select this option if you want 
to retrieve cases where the selected 
attribute's value begins with what the 
Value field specifies

contains - select this option if you want to retrieve cases 
where the selected attribute's value contains what the 
Value field specifies

does not contain - select this option if you 
want to retrieve cases where the selected 
attribute's value does not contain what the 
Value field specifies

in - select this option if you want to retrieve cases where 
the selected attribute's value exists in what the Value field 
specifies

not in - select this option if you want to 
retrieve cases where the selected attribute's 
value does not exist in what the Value field 
specifies

Specify the operator. Use the Operator list box to specify 
the Boolean or Set operator through which you want to 
join the attribute with another attribute.

Add more attributes. Follow steps 2 
through 4 to add more attributes to your 
Advanced Condition. Click the icons on the 
left bar to insert another attribute above or 
below the existing attribute.

Tip: You can change the structure of the Advanced Condition query 
by changing the order of attribute rows in the editor. Use the 
following procedure to do this, select a row and click the Up or Down 
arrow buttons to move the row up or down. To delete a row from the 
editor, select the row and click the Delete icon.

Note: Argus Insight lets you create Advanced Conditions which 
when executed, ask for user-specified values for certain attributes to 
generate the Case Series. For example, you may create an Advanced 
Condition in which the Case Number or the Product name may be 
specified only at the time of execution. In this case, the Advanced 
Condition would only retrieve those cases where the Case 
Number/Product Name is as specified at the time of execution.

Creating an Advanced Condition using same field name multiple 
times requires to change the Parameter name so that while executing 
the advanced condition different parameters values can be entered.
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11. Click Parameter. The following dialog box appears.

12. Check the Multi Select checkbox if you want to pass multiple runtime values for a 
single attribute. For example, you might want to pass more than one case number 
or product name as runtime parameters.

13. Click OK. The field you configured as a runtime parameter is displayed in the 
Value text box enclosed within % symbol. For example, %Product Type% If you 
configured the field to accept multiple runtime parameters, the field name appears 
in the Value text box enclosed within %% symbol. For example, %%Product 
Type%%.

14. Type parentheses in the ( and ) columns to determine the order of execution for the 
selected Advanced Conditions, as appropriate.

15. Examine the Advanced Condition result.

16. Click Execute. While the system searches for matching cases, the following dialog 
box is displayed.

Note: Refer the Advanced Condition Creation Process section for 
further details on creating an Advanced Condition.



Creating Queries

Creating Queries 4-82

■ If you configured any runtime parameters, the Parameters dialog box appears. 
Specify the parameter values by using the options in the dialog box. Next, 
click Execute; the system retrieves the matching cases from the datamart and 
displays them in the Active Case Series page.

■ If the system does not find any cases that match the querying criteria, the 
following screen is displayed. Click View Query in this screen to return to the 
Advanced Condition Editor, modify the criteria and execute again.

■ If the system finds cases that match the query criteria, a list of such cases is 
displayed in the Active Case Series page.

17. Examine the Case Series. If the Case Series is too large, you may want to modify 
the Advanced Condition by specifying additional attributes or changing values. 
Alternatively, if you find the Case Series to be appropriate, you can save the 
Advanced Condition to the system.

The system retrieves the matching cases from the datamart and displays them in 
the Active Case Series page.

Tip: You may cancel the query execution at this point and return to 
the Advanced Condition Editor by clicking Cancel Query in the 
dialog box above.

Tip: If you select one run-time parameter and execute the search, 
you must enter a field.

If you select multiple run-time parameters and execute the search, you 
have the option to ignore the run-time parameters.
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Returning the to Advanced Condition Editor  
Use the following procedure to return to the Advanced Condition Editor.

1. Click View Query in the Active Case Series page. The Active Advanced 
Condition Editor page appears.

2. If required, modify the Advanced Condition and examine the result again or 
proceed to save the Advanced Condition.

3. Save the Advanced Condition.

Assigning a Category to an Advanced Condition  
Use the Category list box to assign a category to the Advanced Condition. A category 
indicates the reporting aspect to which your Advanced Condition pertains: 
Compliance, Configuration, General, Management, or Pharmacovigilance. 
Specifying the category also helps you in searching the relevant Advanced Conditions 
from a list of all the Advanced Conditions saved in the system.

1. Type a description of the Advanced Condition in the Description text box. For 
example, you can describe the type of cases the Advanced Condition retrieves.

2. Click Save in the Active Advanced Condition Editor page. The Save Advanced 
Condition dialog box appears.

Note: When you save the modifications to an Advanced Condition 
or execute it, the system assigns the Active status to the Advanced 
Condition. Therefore, when you return to the editor after executing 
the Advanced Condition, the page title changes to ActiveAdvanced 
Condition Editor. The field values you specified in the editor before 
executing are retained. See theWorking with the Last Modified or 
Saved Advanced Condition topic for details on Active Advanced 
Conditions.
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3. Type the name of the Advanced Condition in the Name text box.

4. Click OK. The system refreshes the Active Advanced Condition Editor page. Note 
that the following new elements appear on the page.

5. The Active Query Name field in the upper-right corner of the page now displays 
the name of the Advanced Condition you specified while saving the Advanced 
Condition.

6. Three new buttons appear at the bottom of the page: Save As, View SQL and 
Permissions.

7. Click View SQL to view the underlying SQL query for the Advanced Condition.

View SQL helps you to view and edit the underlying SQL for the Advanced 
Condition created.

Note: All the Advanced Conditions that you save to the system are 
listed in the Advanced Condition Library page. TheWorking with 
Saved Advanced Conditions topic explains how to work with saved 
Advanced Conditions

Tip: If you modify the field values after saving the Advanced 
Condition to the system, use the Save button to save the changed field 
values.
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■ Click Save SQL after editing the query.

■ Click Close.

8. Assign group-level permissions on the saved Advanced Condition.

9. Click the Permissions button. The Permissions dialog box appears. A list in this 
dialog box displays the names of all the groups (except the Administrator group) 
that the system administrator has created.

Note: When using this Save SQL functionality the Advanced 
Condition can be executed only from the Advanced Conditions library 
and the Query Library page.

The View SQL textbox can have a maximum of 4000 characters.

Tip: Revert to Original helps you to revert back to the original 
advanced condition.
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10. Use the list box next to a group name to assign permissions to the group members 
on the Advanced Condition you have created. You can select from these options:

11. Click OK. The system saves the permission settings.

12. Click Execute to generate the Case Series.

■ The system retrieves the matching cases from the datamart and displays them 
in the Active Case Series page.

■ If you configured any runtime parameters, the Parameters dialog box appears. 
Specify the parameter values by using the options in the dialog box. Next, 
click Execute; the system retrieves the matching cases from the datamart and 
displays them in the Active Case Series page. See the Case Series chapter for 
more information on working with Case Series.

Permission Description

No Access (Default) No group members will be able to access the Advanced Condition

R Group members will be able to only view the Advanced Condition

R/W Group members will be able to view and modify the Advanced Condition

R/W/D Group members will be able to view, modify, and delete the Advanced 
Condition

R/W/D/P Group members will be able to view, modify, delete, and assign permission 
on the Advanced Condition

Note: The author of the query always has the highest level of 
permission (R/W/D/P) on the query. For example, you belong to the 
Data Entry group and you assign the No Access permission level to 
the Data Entry group on a Advanced Condition that you create. In this 
case, while you will continue to have the highest level of permission 
on your Advanced Condition, other members in your group will not 
be able to access your Advanced Condition.
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Creating an Advanced Condition  
Use the following Order of precedence for the various operators selected when 
creating an Advance Condition.

Using an Intersect, Minus or Union operator results in the creation of two separate 
select clauses. Therefore, use these operators between different queries.

PL/SQL syntax should be kept in mind while creating an Advanced Condition.

PL/SQL syntax:

SELECT

table1.common_column

FROM

Table1, table2, table3

WHERE

Table1.column2 = table2.column2

AND

Table2.column3 = table3.column3

INTERSECT

SELECT

Table4.common_column

FROM

Table4, table5, table6

WHERE

Table4.column2 = table5.column2

AND

Table5.column3 = table6.column3

Now suppose you want to create an Advanced Condition as follows:

Where country = "Australia" AND Co-Drug Code w Study = "LAS+TAB" OR Co-Drug 
Code w Study = "LAS+" AND Overdose = "Yes" AND Interaction? = "Yes"

And wants to intersect the results of this Advanced Condition with the existing 
Advanced Condition

Order Operator Use

1 And Use with all fields available in Advanced 
Condition.

2 Or Use with all fields available in Advanced 
Condition.

3 Intersect Use between various queries (AC Library 
Attributes)

4 Minus Use between various queries (AC Library 
Attributes)

5 Union Use between various queries (AC Library 
Attributes)
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Where country = "United States" or country = "Australia"

Then you should create the Advanced Condition as shown in the screen shot below.

The user needs not to take care of parenthesis if the PL/SQL syntax and the order and 
precedence of operators are taken care off.

The following SQL will get generated in this case.

SELECT DISTINCTv_rpt_case.case_id

FROM v_rpt_case, rpt_product

WHERE v_rpt_case.case_id = rpt_product.case_id

AND ( (v_rpt_case.country_id = 13)

AND ( UPPER (rpt_product.co_drug_code) = 'LAS+TAB'

OR (pat_exposure IN (

SELECT product_id

FROM lm_product

WHERE UPPER (lm_product.drug_code) ='LAS+TAB')))

OR(UPPER (rpt_product.co_drug_code) = 'LAS+'

OR (pat_exposure IN (SELECT product_id FROM lm_product

WHERE UPPER (lm_product.drug_code) ='LAS+')))

AND (rpt_product.is_overdose = 1)

AND (rpt_product.interaction = 1))

INTERSECT

SELECT DISTINCTv_rpt_case.case_id

FROM v_rpt_case

WHERE v_rpt_case.case_id IN (

SELECT DISTINCT v_rpt_case.case_id

FROM v_rpt_case

WHERE (v_rpt_case.country_id = 13)

OR (v_rpt_case.country_id = 223))

Working with the Last Modified or Saved Advanced Condition
The system assigns an Active status to a Advanced Condition when you modify and 
save it or when you execute it. Unless you save the modifications to another Advanced 
Condition or execute another Advanced Condition, the last Advanced Condition you 
modified or executed remains Active. This is helpful in situations when you want to 
access a frequently used Advanced Condition.

Use the following procedure to view an active Advanced Condition,

1. Select Create Query > Advanced Condition > Active. The Active Advanced 
Conditions Editor page displays the Advanced Condition you executed or 
modified last.
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2. If the Active Advanced Condition was saved to the system before executing, the 
name of the Advanced Condition appears next to the Active Query Name and 
Name label. However, if the Active Advanced Condition was not saved to the 
system before executing, the text <Not Saved> is displayed next to the Active 
Query Name label.

From the Active Advanced Condition page, you can perform the following tasks:

Note that modifying the field values in the Advanced Condition editor for an Active 
Advanced Condition or saving the Active Advanced Condition by a different name 
changes the Active Advanced Condition to reflect the most recent changes. The Active 

Task Description

Modify the attributes 
in the Advanced 
Condition editor

If required, you can modify the attributes (fields and values) in the Advanced 
Condition editor. See theCreating a New Advanced Conditiontopic for 
information on working with the Advanced Condition editor.

Use the Save button to save the changed field values. This button is only 
available for a saved Active Advanced Condition.

Save Active 
Advanced Condition 
with another name

Click Save As to save the Active Advanced Condition by a different name.

The Advanced Conditions that you save to the system are listed in the 
Advanced Condition Library page. TheWorking with Saved Advanced 
Conditionstopic explains how to work with saved Advanced Conditions.

View the Advanced 
Condition in SQL

Click View SQL to view the underlying SQL query for the Advanced 
Condition.

In this SQL, manually replace the V_RPT_CASE with RPT_CASE. This is 
required to execute the query in the Oracle database.

Assign Permissions Click Permissions to set the group-level access permissions on the Advanced 
Condition. See theCreating a New Advanced Conditiontopic for information 
on setting permissions.

The Permissions button is only available for saved Active Advanced 
Conditions.

Change the 
Description of the 
Active Advanced 
Condition

You can change the description of the Active Advanced Condition by 
modifying the text displayed in the Description text box.

Click Save to store the changed description.

Execute the Active 
Advanced Condition

Click Execute to generate a Case Series by using the Active Advanced 
Condition.
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Advanced Condition also changes in case you modify the field values in the Advanced 
Condition editor and execute the Advanced Condition without saving the 
modifications.

Working with Saved Advanced Conditions
The Advanced ConditionsLibrary page lists all of the Advanced Conditions saved to 
the system. To access this page, select Create Query > Advanced Conditions > 
Library.

The Advanced Condition Library page displays a list of the saved Advanced 
Conditions in a grid format. The descriptions of the grid columns follow.

Searching Saved Advanced Conditions  
Use the following procedure to search for a saved Advanced Condition:

1. Specify the search criteria, as appropriate:

■ To search for an Advanced Condition by its name, type the Advanced 
Condition name in the Name text box.

■ To search for an Advanced Condition by its description, type the first few 
words of the description in the Description text box. The system searches for 
the specified search string in all Advanced Condition descriptions.

■ To search for an Advanced Condition by its date of modification, enter the 
modification date in the first Last Modified date field. You can also specify a 
date range by typing the start and end dates in the first and second date fields, 
respectively.

Column Description

Name Displays the name of the Advanced Condition

Description Displays the Advanced Condition description

Last Modified Displays the date when the Advanced Condition was last modified

User Full Name Displays the name of the user who created the Advanced Condition

Category Displays the category assigned to the Advanced Condition

Parameters Displays the name of fields for which a runtime parameters need to be 
specified while executing the Advanced Condition

Report The icon indicates that a report is associated with the Advanced Condition

See theAssociating an Advanced Condition with a Reportsection below for 
more information.
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■ To search for an Advanced Condition by its author, select the author name 
from the User Full Name list box.

■ To search for an Advanced Condition by its category, select the category from 
the Category list box.

2. Click Search.

3. Based on your search criteria, the system displays the search result in a list.

4. You can sort the search result list by clicking the sort icon next to the column 
headers in the list.

5. To clear the search result and display all the Advanced Conditions in the list, click 
the Clear button.

Creating a New Advanced Condition  
Use the following procedure to create a new Advanced Condition.

1. Click the New button in the Advanced Condition Library page.

See theCreating a New Advanced Condition topic for details.

Modifying an Advanced Condition  
Use the following procedure to modify an Advanced Condition:

1. Select the Advanced Condition from the list in the Advanced Condition Library 
page.

2. Click Modify. The Advanced Condition editor appears

3. Make your modifications to the Advanced Condition, as appropriate.

4. Click Save to save the modifications you made. Alternatively, click Save As to 
save the modified Advanced Condition by another name.

Modifying the SQL of an Advanced Condition  
Use the following procedure to modify the SQL of an Advanced Condition:

1. Go to the Advanced Conditions Library page.

2. Select a particular Advanced Condition and click Modify. The Active Advanced 
Conditions Editor screen appears.

3. Click View SQL. The Advanced Conditions SQL dialog appears.
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4. Modify the SQL as per your requirement and click Save SQL. The SQL is saved 
and the Advanced Conditions SQL dialog appears.

5. Click Close. The Advanced Conditions Library page appears.

6. Select the modified Advanced Condition and click Execute. You will get the results 
as per modified SQL.

Deleting an Advanced Condition  
Use the following procedure to delete an Advanced Condition

1. Select the Advanced Condition from the list in the Advanced Condition Library 
page.

2. Click Delete. The delete confirmation dialog box appears.

3. Click OK. The system deletes the selected Advanced Condition; the Advanced 
Condition Library page appears.

Associating an Advanced Condition with a Report  
Argus Insight lets you associate an Advanced Condition to a particular Standard 
Report and schedule a time when the report needs to be generated and sent to another 
user through email. This is helpful in situations when you need generate the latest 
Case Series and run a report on it each time the datamart is refreshed. Instead of 
manually executing the Advanced Condition to generate the latest Case Series and 
running the report, you can use the report association functionality of Argus Insight.

Note: You can not modify an Advanced Condition once you have 
added user defined SQL in that, you can modify SQL but can not add 
new items in Advanced Condition.

If you want to add new items, you have to revert the SQL to original 
by clicking on the Revert to Original button.

Note: The user who is scheduling reports should have an enterprise 
login configured in Cognos to schedule the report.
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Use the following procedure to associate an Advanced Condition with a Standard 
Report:

1. On the Advanced Condition Library page, select the Advanced Condition that 
you wish to associate with a Standard Report.

2. Associate the Advanced Condition with a Standard Report.

3. Click Associate. The Scheduled Reports Group dialog box appears. This page 
displays a list of all groups of reports which were scheduled or associated with the 
query.

4. Click New and a context menu will appear. Select Scheduling option.

5. The Reports Scheduling window will appear.

6. On this window, you can schedule multiple reports at once.

7. Schedule the report.

This window has 3 main sections:

■ Scheduling Information - The Schedule timing and E-Mail information

■ Available Reports - All the available reports in the system that can be 
scheduled.

■ Selected Reports - These reports will be scheduled.
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8. Provide a Name for your reports group along with description.

9. Use the Frequency list box to specify how often you wish to have the system run 
the selected QBE and generate the selected report. The options available are: Once, 
Daily, Weekly, Monthly, Quarterly, and Yearly.

10. Specify the schedule time in the Time field.

11. Based on the option you selected in the step above, specify the instant when you 
want the report generated as described in the table below.

Frequency Option 
Selected Additional Scheduling Information to Specify

Once In the Date text box that appears, enter the date when you want to 
have the report generated.

Daily In the Time text box that appears, enter the time when you want to 
have the report generated. The time must be entered in the HH:MM 
AM/PM format. Hours should be between 1 and 12.

Weekly From the Day of Week option button group that appears, select the 
day of week on which you want to have the report generated. Also, 
specify the time in the Time text box.



Creating Queries

Creating Queries 4-95

12. Specify the email recipients of the report you scheduled.

13. In the Email Address text box, type the email address of the report recipient. If 
there are multiple recipients, use a semicolon to separate their email addresses.

14. Type the subject line in the Subject text box.

15. Type the email body text in the Body text box.

16. If you want all the reports in a single mail, leave the Send separate mail for each 
report checkbox unchecked. If you check this checkbox, each report will be 
delivered in a separate mail to the user.

17. From the Available reports grid, select a report and click Add button. The report 
will be selected and will appear in the Selected Reports section.

18. To remove a report from Selected Reports, click the X button against the report.

19. For each selected report, you must fill the Pre-filters associated with each report. 
To do this, click on any report in the Selected Reports grid and the pre-filters will 
appear beside it. Fill them and click the OK button of Report Pre-Filters section.

20. Click OK. The system associates the Advanced Condition with the selected report 
and saves the scheduling information; the Advanced Condition Library page 
appears. The icon displayed in the Report column indicates that the Value Set is 
associated with a report.

Refer to the Associated Library and Query Library sections in the Library chapter, to 
view the steps on how to disassociate reports in those libraries.

Monthly Use the Day list box to select the day of the month on which you 
want to have the report generated. Also, specify the time in the 
Time text box.

Quarterly Quarterly reports are generated on the first day of the quarter. In the 
Time text box, enter the time when you want to have the report 
generated on the first day of the quarter.

Yearly In the Date and Time text boxes, specify the date and time when 
you want to have the yearly report generated.

Frequency Option 
Selected Additional Scheduling Information to Specify



Creating Queries

Creating Queries 4-96

Executing an Advanced Condition  
Use the following procedure to execute an Advanced Condition:

1. Select an Advanced Condition from the list in the Advanced Condition Library 
page.

2. Click Execute. The system executes the Advanced Condition; the Active Case 
Series page appears.

3. If a report is associated with the saved Advanced Condition, click on Execute 
button. The Active Case Series page and Pre Filter page of the associated report is 
displayed.

4. Enter the prompts value in the Pre Filter page.

5. Click on the Execute button to generate the report.

After generating the Case Series, you can manually modify it or save it. See the Case 
Series chapter for more information on working with Case Series.

Executing a Saved Advanced Condition on the Active Case Series  
Just as the system assigns the Active status to an Advanced Condition when you save 
modifications to it or execute it, the last saved or generated Case Series becomes the 
Active Case Series.

Use the following procedure to narrow down the list of cases in the Active Case Series, 
you may want to run an Advanced Condition on an Active Case Series.

1. Generate the Case Series on which you wish to run another Value Set:

■ You can generate the Case Series by either using QBE, Filters, or Advanced 
Conditions. This Case Series automatically becomes the Active Case Series and 
remains so until you execute another query to generate a different Case Series.

■ Alternatively, if the Case Series on which you wish to run another Value Set is 
already saved in the system, select Query Results > Case Series > Case Series 
Library. In the Case Series Library page that appears, select the Case Series 
title and click Make Active.

2. Select Create Query > Advanced Conditions > Library. The Advanced Condition 
Library page appears.

3. Select the Advanced Condition you want to run on the Active Case Series you 
generated in step 1.



Creating Queries

Creating Queries 4-97

4. Check the Limit Query to Active Case Series checkbox.

5. Click Execute. The system runs the selected Advanced Condition on the Active 
Case Series and displays the Active Case Series page. Note that the Case Series 
you just generated becomes the Active Case Series.

Library
Argus Insight provides a library that serves as a repository for all queries. This library 
comprises all the query searches performed for QBE, Filters, and Advanced 
Conditions. In addition, the Associated Library feature enables you to search for those 
queries, which have a report associated with them.

Go to Create Query>Library to view the components of the Library menu.

This chapter discusses the following components that comprise the Library menu in 
Argus Insight:

■ Associated Reports Library

■ Query Library

Associated Reports Library
The Associated Library feature enables you to view all the reports associated with a 
query.

1. Open Create Query>Library>Associated Reports Library to view a list of all the 
reports that are associated with a query.

The following screen is displayed:

Note: To use LDAP configuration in Argus Insight, your Cognos 
administrator must configure LDAP on the Cognos Server.
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The following table describes the columns in this page:

Modifying a Query in the Associated Reports Library  
Use the following procedure to modify a query in the associated library:

1. Select the query from the list in the Associated Reports Library page.

2. Click Modify.

This displays the Scheduled Reports Group page.

Column Description

Name Displays the name of the query that is associated with the 
report.

Description Displays the description of the query associated with the 
report.

Last Modified Displays the date when the query was last modified.

Query Type Displays the type of query associated with the report.

User Full Name Displays the name of the author of the query.

Category Displays the category where the query is saved.

Report Name Displays the name of the report associated with the query.

Limit Query to 
Active Case Series

Enables you to limit the query to the active case series.
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3. Select any report group and click Modify button.

4. Make the necessary modifications and click OK.

5. Click Execute to execute a report. The Execute button is available only if a group 
has just one report in it.

Deleting a Query in the Associated Reports Library  
Use the following procedure to delete a query from the associated library.

1. Select the query from the list in the Associated Reports Library page.

2. Click Delete.

3. The Delete Confirmation dialog appears.

4. Click OK.

Disassociating a Report in the Associated Reports Library  
Use the following procedure to disassociate a report from the associated report library:

1. Select the report from the list in the Associated Reports Library page.

2. Click Disassociate.

3. The Disassociate Report dialog appears.

4. Click OK.

Query Library
The Query Library feature enables you to view all the queries. Select Create 
Query>Library>Query Library to view a list of all the queries.

The following screen is displayed:
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The following table lists the descriptions of the columns in this page:

Associating a Query in the Query Library  
Use the following procedure to modify a query in the query library:

1. Select the query from the list in the Query Library page.

2. Click Associate.

This displays the Scheduled Reports Group page.

Column Description

Name Displays the name of the query.

Description Displays the description of the query.

Last Modified Displays the date when the query was last modified.

Query Type Displays the type of query.

User Full Name Displays the name of the author of the query.

Category Displays the category where the query is saved.

Report Name Displays the name of the report associated with the query.

Limit Query to 
Active Case Series

Enables you to limit the query to the active case series.
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3. Select any report group and click Modify.

4. Make the necessary modifications and click OK.

5. Click Execute to execute a report. The Execute button will be available only if a 
group has just 1 report in it.

Deleting a Query in the Query Library  
Use the following procedure to delete a query from the query library:

1. Select the query from the list in the Query Library page.

2. Click Delete.

3. The Delete Confirmation dialog appears.

4. Click OK.

Disassociating a Report in the Query Library  
Use the following procedure to disassociate a report from the query library:

1. Select the report from the list in the Query Library page.

2. Click Disassociate.

3. The Disassociate Report dialog appears.

4. Click OK.
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5Working with Case Series

Working with Case Series
When you execute a QBE, Filter, or an Advanced Condition, Argus Insight generates a 
list of cases that match the querying criteria. This list of cases is called a Case Series. 
The Case Series output is displayed in a listing format in the Active Case Series page.

The Case Series is the communication foundation between all modules of Argus 
Insight. All the predefined reports you generate in Argus Insight are run on the Case 
Series. This means that the report output contains information from only those cases 
that are part of the Case Series.

In addition to letting you generate a Case Series by using a query, Argus Insight 
enables you to:

■ Save the Case Series with a name and description for future reference.

■ Search the saved Case Series by their name, description, category, source, date of 
modification, and author.

■ Assign group level access permissions on the Case Series.

■ Combine two Case Series through Union, Intersect, or Minus set operators.

■ Import a Case Series from external sources such as TXT or CSV files.

■ Manually modify the Case Series after it has been generated.
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General Usage Information
Before working with Case Series, you should be aware of information about the 
following:

■ Case Series Hyperlink to Medical Review

■ Freezing Case Series Data

Case Series Hyperlink to Medical Review
Be aware of the following:

■ The case series dialog enables the user to open the Medical Review dialog in Read 
Only mode from the Active case Series dialog.

■ All of the reports that can be executed from Medical Review are available to the 
user.

■ Even if a Single Sign On user has no protection in Argus Safety and Blinded 
Protection is applied in Argus Insight, the user can still view the Medical Review 
screen. The Medical Review screen can display all the products of the Blinded 
security-enabled case.

■ If the user does not have access to the case from an Argus Safety perspective, the 
system presents the following message:

" <user> does not have access to the case in Argus Safety".

■ If the case the user is trying to access has been deleted since the last ETL, the 
system presents the following message:

"This case has been deleted in Argus Safety since the last ETL".

■ If the user has logged into Insight without logging through Argus, the system 
presents the following message:

"<user> is not logged into Argus."

Note: The Case Series might become obsolete each time the datamart 
is refreshed by running an ETL. This is because new cases with similar 
attributes might get added to the datamart.
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Freezing Case Series Data

Business Context  
Once the alerts are configured, customers are interested in analyzing the case series 
that is generated by the alert. The system does the following as part of the analysis:

■ Freezes the Case Series data that needs to be analyzed

■ Displays case details using either the standard reports or the CIOMS II line listing 
(available in Insight) after the regular queries, case series, and their subsets are 
completed.

Feature Details  
Be aware of the following:

■ The system allows the use to freeze a case series as follows:

– The user can freeze a custom case series when editing the case series from the 
Case Series Library page.

– The user can freeze any system-generated case series (active or inactive) (e.g., 
Using Insight queries, filters and advanced conditions) by clicking the "Freeze 
and Save" button.

The system freezes the case series and presents the user with the standard 
Case Series Save dialog. The user must enter the name of the saved case series.

■ If the user has not yet saved the case series from the active case series screen and 
clicks the Freeze and Save button, the system saves only one copy of the frozen 
case in the library. The frozen case series should then be the active case series.

■ In the Case Series Library the User can view a frozen case series by clicking the 
icon next to the case number.

Hovering over this icon shows the Date the user froze the case series.

■ The system enables the user to freeze existing cases in the case series by clicking 
the "Freeze Case Series button."

– When the user clicks this button, the system prompts the user to provide and 
additional name for the frozen case series.

– The Frozen Case Series has icon beside case number to identify it as frozen.
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■ When the user clicks "Un-freeze Case Series," the system removes the icon beside 
the case number and fetches the latest information for the cases.

– The user must provide a justification when unfreezing a case series.

– The user adds the justification to the Case Series Criteria.

* The user types a new justification when the case series is unfrozen or can 
user a pre-configured justification.

* A list maintenance item, "Case Series Un-freezing Justification," enables 
the user to configure justifications for use when unfreezing a case series.

* The Add, Modify and Delete functionality is the same as that of the Case 
Series Modification Justification UI.

– The administrator can configure the freeze case series function so that it 
reflects Insight security settings

– The user has the option of freezing and unfreezing case series by clicking the 
appropriate check boxes on the Access Right tab.

– The user cannot insert cases into a frozen case series.

– The user can delete cases from the frozen case series.

– When an Advanced Condition or query is run against a frozen case series, 
frozen data is used.

– By default, the Report Writer displays all the versions (both frozen and 
current) for a case.
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* Use the "Display Latest Data" filter if the report needs to contain only the 
current case version.

* If user selects the Active Case Series filter, then report contains only the 
Frozen case data if active case series is frozen otherwise the report 
contains the current case version if the active case series is a normal case 
series.

– The frozen case series data is available after reinitializing the ETL.

– Reports run on frozen case series data, show the following next to the case 
series name:

"The data in this report was frozen as of <particular date and time>".

Time is the database system time with the GMT offset.

■ Reports run on normal case series data, show the follow message next to the case 
series name: should

■ "The case series was last modified on <Case series modification date and time>".

■ List Maintenance items are not frozen. Therefore, some reports will have a 
mismatch of LM Items and the frozen case series data.

■ The derivation rules operate against current case data if the LM Rules are being 
modified. The frozen case series are shown if there is a change in the case data 
resulting from the derivation rules.

■ If suppress condition is checked in the derivation rule, then LM records related to 
the derivation rule will not be deleted in cases used in the frozen case data table.

■ The hyperlink for the medical review access, links to the latest data for the case.

■ Frozen case series cannot be shared with Argus Safety.

■ The following portions of the Argus Insight application do not all case data to be 
frozen:

– Dashboard

– Copy Configuration Utility

– BO and CO standard cubes

– Standard Cubes Drill Through reports

– Report scheduling

– Derivation Rules

Working with the Last Generated Case Series
This section provides information for working with the last generate case series and 
includes discussions of the following:

■ Saving a Case Series

■ Viewing Case Series Generation Criteria within the Query Interface

■ Modifying the Case Series

■ Deleting a Case from a Case Series

The system assigns the Active status to a Case Series that you generated last by 
executing a query. Only one Case Series can remain active at a time. Unless you 
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generate another Case Series or save modifications to one, the last Case Series you 
generated remains active.

To view an Active Case Series, select Query Results > Case Series > Active. The 
Active Case Series page displays the Case Series you executed, modified, or manually 
made active last.

In the Active Case Series page, the Active Query Name label displays the name of the 
saved query (QBE, Filter, or Advanced Condition) that generated the Case Series. If the 
query was not saved, the label displays the text <Not Saved>.

The Active Case Series label displays the text <Not Saved> until you save the Case 
Series by a name. Similarly, the Name label displays the text <Not Saved> until you 
save the Case Series by a name.

If the active Case Series has more than 50 cases, they are displayed in multiple pages. 
Use the arrows in the button group to navigate the Case Series pages.

The column headers in the Case Series grid can also be sorted, as shown by the circled 
icons in the following image.

You can sort the column data by clicking on the arrows displayed in the image. The 
sorted grid retains its sorting and filtering order even after being exported to Excel. To 
filter for any column, such as the Seriousness Criteria column, enter the filtering 
criteria in the textbox under the column header. The grid also supports context menus.

Note: You can also make a Case Series active by manually assigning 
it the Active status. This option works only for Case Series you have 
saved to the system. See theMaking a Case Series Active topic for 
details.
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Saving the Case Series
If you have not saved the active Case Series to the system yet, click either the Save or 
SaveAs buttons to save the Case Series to the system by assigning a name to it. You 
need to enter the Case Series description in the Description text box before saving the 
Case Series.

If you are modifying a Case Series that is already saved, click the Save button to save 
the modification or click Save As to save the Case Series by another name.

Viewing Case Series Generation Criteria within the Query Interface
Click the View Query button to the see the querying criteria in the query tool interface 
(QBE form, Values Set page, or Advanced Condition Editor) that was used to generate 
the Case Series.

This button is only available for an Active Case Series that is not saved to the system.

If you have saved your Active Case Series, then refer to the section onViewing the 
Case Series Generation Criteria in a Single Page

Setting Access Permissions
You can set group-level access permissions for the Case Series. This determines which 
user groups will be able to view, modify, or delete a Case Series.

Use the following procedure to set Case Series permissions.

1. In the Active Case Series page, click the Permissions button. The Permissions 
dialog box appears. A list in this dialog box displays the names of all the groups 
(except the Administrator group) that the system administrator has created.

2. You can set permissions only on Case Series you have saved to the system.

Use the list box next to a group name to assign permissions to the group members 
on the Case Series you have generated. You can select from these options:

Note: You can set permissions only on Case Series you have saved to 
the system.
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3. Click OK. The system saves the permission settings.

Viewing the Case Series Generation Criteria in a Single Page
Use the following procedure to view the case series generation criteria.

1. Click the View Query Criteria button to view the Case Series Generation criteria 
in a statement format within a dialog box.

Modifying the Case Series
If required, you can modify the Case series by deleting or adding cases manually. Use 
the following procedure to add a case to the Case Series:

1. Click the icon on the left bar in the Active Case Series page. The Add Case to Case 
Series dialog box appears.

Permission Description

No Access (Default) No group members will be able to access the Case Series

R Group members will only be able to view the Case Series

R/W Group members will be able to view and modify the Case Series

R/W/D Group members will be able to view, modify, and delete the Case Series

R/W/D/P Group members will be able to view, modify, delete, and assign permission on 
the Case Series

Note: The author of the Case Series always has the highest level of 
permission (R/W/D/P). For example, you belong to the Data Entry 
group and you assign the No Access permission level to the Data 
Entry group on a Case Series that you generate. In this case, while you 
will continue to have the highest level of permission on your Case 
Series, other members in your group will not be able to access your 
Case Series.
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2. In the Case Number text box, type the case number you want to add to the Case 
Series.

3. Use the Justification list box to specify a justification for modifying the Case 
Series.

4. Click OK. If the Case number you specified exists in the datamart, the system adds 
the case to the Case Series and save the changes. If the Case number you specified 
does not exist in the datamart, a message appears. Click OK to continue.

5. Click Save As to save the modified Case Series by another name. Note that if you 
have not yet saved the Case Series to the system, clicking either the Save or Save 
As buttons will prompt you to save the Case Series to the system by assigning a 
name to it.

Deleting a Case from a Case Series
Use the following procedure to delete a case from the Case Series.

1. In the Active Case Series page, select the case you want to delete.

2. Click the icon on the left bar in the Active Case Series page. The Delete Case 
Number dialog box appears.

Note: You can also type your own justification text for modifying the 
case series.
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3. Use the Justification list box to specify a justification for deleting the case.

4. Click OK. The system deletes the case from the Case Series and save the changes.

Working with Saved Case Series
The Case Series Library page lists all of the Case Series saved to the system. Select 
Query Results > Case Series > Library to access the Case Series Library page.

The Case Series Library page displays a list of the saved Case Series in a grid format. 
The descriptions of the grid columns follow.

Column Description

Name Displays the name of the Case Series

Description Displays the Case Series description

Last Modified Displays the date when the Case Series was last modified

User Full Name Displays the name of the user who generated the Case Series

Category Displays the category assigned to the Case Series

Source Displays the source of the Case Series as:

■ Internal - generated by using Argus Insight querying tools are called 
Internal

■ External - imported into Argus Insight from sources, such as TXT or CSV 
files
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Searching for a Saved Case Series
Use the following procedure to search for a saved Case Series.

1. Specify the search criteria, as appropriate:

■ To search for a Case Series by its name, type the Case Series name in the Name 
text box.

■ To search for a Case Series by its description, type the first few words of the 
description in the Description text box. The system searches for the specified 
search string in all Case Series descriptions.

■ To search for a Case Series by its date of modification, enter the modification 
date in the first Last Modified date field. You can also specify a date range by 
typing the start and end dates in the first and second date fields, respectively.

■ To search for a Case Series by its author, select the author name from the User 
Full Name list box.

■ To search for a Case Series by its category, select the category from the 
Category list box.

2. Click Search. Based on your search criteria, the system displays the search result in 
a list.

3. You can sort the search result list by clicking the sort icon next to the column 
headers in the list.

4. To clear the search result and display all the saved Case Series in the list, click the 
Clear button.

Making a Case Series Active
Use the following procedure to make a case series active.

1. In the Case Series Library page, select the Case Series you want to make Active.

2. Click Make Active. The Active Case Series label in the upper-right corner of the 
Case Series Library page displays the name of the Case Series you made Active.

Modifying a Case Series
You may want to modify an existing Case Series by adding cases to it or deleting 
existing cases. You can also change the group-level access permissions on the Case 
Series.

Use the following procedure to modify a Case Series.

1. In the Case Series Library page, select the Case Series you want to modify.

2. Click Modify. The Case Series is displayed in the Active Case Series page. See the 
Working with the Last Generated Case Series for detailed information about 
making modifications to the Case Series and setting permission.

Cases Displays the number of cases in the Case Series

Column Description



Working with Case Series

Working with Case Series 5-12

Merging Case Series
Argus Insight allows creating a new Case Series by merging two Case Series through a 
Set operator. The Set operator you select works on the Case numbers. The case 
numbers included in the merged Case Series depend on the type of Set operator you 
use:

■ Union - creates a new Case Series that consists of all the cases in both Case Series; 
common case numbers are included, and are listed only once

■ Intersect - creates a new Case Series that consists of only those case numbers that 
exist in both Case Series

■ Minus - creates a new Case Series that contains only those case numbers that are 
present in the first Case Series, but are not present in the second Case Series.

Use the following procedure to generate a merged Case Series:

1. In the Case Series Library page, click Merge. The Case Series Merge page appears.

2. Select the two Case Series you wish to merge.

3. Select the first Case Series from the Case Series # 1 list.

4. Select the second Case Series from the Case Series # 2 list.
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5. From the Action list, select the Set operator you wish to use to merge the two 
selected Case Series you selected. The two Case Series and the operator are 
selected.

6. Click Merge. The system merges the selected Case Series and displays the 
resultant Case Series in the Active Case Series page.

Importing a Case Series from an External Source
Use the following procedure to import a Case Series from anexternal sources, such as 
TXT or CSV, into Argus Insight.

1. In the Case Series Library page, click Import. The Select File for Import dialog 
box appears.



Working with Case Series

Working with Case Series 5-14

2. Click Browse to locate the external Case Series source file. Alternatively, type the 
file name with complete system path. Each case number in the file must be on a 
new line.

3. If the first row in your TXT or CSV is the column-header row, check the First row 
contains column header(s) checkbox.

4. Click OK.

5. The Import Case Series dialog box displays the status of the import operation.

6. Click OK to view the imported Case Series in the Active Case Series page.

Deleting a Case Series
Use the following procedure to delete an existing Case Series.

1. In the Case Series Library page, select the Case Series you wish to delete.

2. Click Delete. A confirmation dialog box appears.

3. Click OK. The system deletes the selected Case Series; the Case Series Library 
page appears.

Note: You can view the import operation log by clicking the View 
Log button.

Note: Case Series Import supports only Case Numbers that are 
separated by either an ENTER or a ’;’ character.
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Viewing the Details of the Query that Generated the Case Series
Use the following procedure to view the details of the query that generated a Case 
Series:.

1. In the Case Series Library page, select a Case Series.

2. Click Query Criteria. The Query Criteria dialog box displays the criteria.

Sharing Case Series with Argus Safety Web
The system enables you to share cases between Argus Safety Web and Argus Insight 
using Query Results > Make Active from Argus.

Note: For a saved Case Series, the system displays the query details 
only in an SQL-statement format within the Query Criteria dialog 
box. However, for an Active Case Series that is not yet saved to the 
system, you can view the query details within the query tool interface 
(QBEform, Values Set page, or Advanced Condition Editor) as well as 
in the SQL-statement format.
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Use the following procedure to share cases between Argus Insight and Argus Safety 
Web.

1. Login to Argus Insight with your user id and password.

2. Select Query Results > Case Series > Make Active From Argus to view the Active 
Cases in the Argus Safety Web application. The Active Case Series of Argus 
appear on the screen. The Active Case Series present in Argus are now the active 
case series in Argus Insight.

3. Save the case series using the Save or Save As feature.

Exporting Case Series to Excel
Use the following procedure to export a case series to an Excel file.

1. Create a new query from Query By Example, Filter or an Advanced Condition, or 
open a saved query from the Library of Query By Example, Filter or an Advanced 
Condition.

2. Click Execute to open the Case Series page with the list of cases.

3. Now, click Export to Excel at the lower right end of the web page.

A dialog box displays for saving or opening an excel file.

Note: You need a common user id and password for Argus Safety 
Web and Argus Insight to enable case sharing between the two 
applications.

An error message stating "Your user id is not present in Argus" 
appears if you do not have a valid user id in Argus Safety Web

Note: If there are no cases present in the active series of Argus, an 
error message appears indicating the same.

Note: Customers on Argus Safety 6.0 can share Frozen Case Series 
with Argus Insight 7.0.
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4. Click Open to open the excel file and view the Case Series results in excel. Click 
Save to save the excel file in your system for future reference.

In the excel file you can see the case Series results in Case Series tab and Case 
Series details, i.e., Name, Case Count, Description and Criteria in Case Series 
Details tab.
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6Generating Standard Reports

General Report Usage Information
Argus Insight provides built-in Standard Reports which can be run on Active Case 
Series to analyze your company's safety, workflow, and product data.

Although Standard Reports are predefined reports, you can define pre-filters before 
generating a Standard Report to have the report output display information only about 
specific type of cases. Pre-filters let you narrow down the Case Series further so that 
the system runs the report only on those cases that confirm to the pre-filter criteria. For 
example, your Case Series might consist of cases that were reported in all the countries 
for a particular product. 

However, you may only wish to see information about those cases in your report that 
were reported in the United States. In this case, you can specify a pre-filter to have the 
system display only those cases in the report output that were reported in the United 
States.

Before using Argus Insight to generate the Standard Reports, configure the browser as 
defined in the Argus Insight Installation Guide.

Note: Since a Case Series might become obsolete each time the 
datamart is refreshed by running an ETL, you may need to generate 
the Case Series again before generating a Standard Report. 

Alternatively, you can directly associate aquery (QBE, Filter, or 
Advanced Condition) to a Standard Report to avoid manual 
generation of Case Series. See the Associating a QBE with a Report, 
Associating a Value Set with a Report, and Associating an Advanced 
Condition with a Report topics for details.
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Using Reports
Before generating reports, you should be aware of information regarding the 
following:

■ Event Level Reporting

■ Report Scheduling

Executing Reports
Use the following procedure to access the Reports page for any category. For instance, 
if you select Compliance Reports, execute the following steps:

1. Select the Case Series Reports > Standard Reports >Compliance. The Standard 
Reports page displays a list of all the standard Compliance reports. The 
description of a report is displayed next to its name.

2. Select the report that you want to generate.

3. Select the Limit to Active Case Series checkbox to generate the report on the 
Active Case Series.

4. Click Execute to generate the report. A new browser window displays the 
pre-filter options in the Report Filter page. The following pre-filter elements may 
be available depending on the type of information the report displays.

Note: Select the Limit to Active Case Series checkbox before 
generating the report. This prevents the report from querying the 
entire datamart and slowing down the report output generation. Use 
the following procedure to view the Active Case Series, select Query 
Results > Case Series > Active in Argus Insight. If you want to make 
another Case Series active, select Query Results > Case Series > 
Library in Argus Insight. In the Case Series Library page that 
appears, check the Case Series you want to make active and click 
Make Active.
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■ List box - this element lets you filter the report output by specifying a single 
value from the list; for example, the country of incidence, a regulatory 
authority, or a pre-defined date range. List boxes may also contain options for 
grouping the report output; for example, grouping by age group or product 
name

■ Multiple selection lists - this element lets you filter the report output by 
multiple values you select from the list; for example, license countries or 
report types.

■ Text boxes - this element lets you filter the report output by specifying a 
numerical value for timelines or dates for date ranges. All the report pre-filter 
pages contain a text box for specifying a sub-title for the report

■ The Pre-filter page can display values in Prompts. By default, prompts on the 
Pre-filter page display values from LM tables. 

■ By default, a checkbox called Limit Prompts Values to Active Case Series is 
displayed on the Pre-filter page. You can check this checkbox to generate 
pre-filter prompts and view values limited to the cases in the case series. This 
impacts only those prompts which are populated from case tables and 
corresponding LM tables exist for that prompt. 

■ Custom prompts created by the user for ad-hoc reporting do not have the 
option of displaying values in prompts from LM tables. Custom prompts 
always display data as per the conditions (SQL) that were defined during the 
creation of the prompts.

5. Specify the pre-filter options, as appropriate.

6. Select the PDF or Excel option button to specify the report output format.

7. Click Execute in the Report Filter page. The system generates the report output 
and displays it in the selected format. You can print this report or save it to the 
system drive, if required.

8. Close the new browser window to return to the Standard Reports page.

Note: If All is selected along with other entities for a category, then 
all the items under that category are searched.
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Event-Level Reporting
Currently, Insight Reports are focused on cases. This permits event level report in 
Insight Report output.

Feature Details  
Extended reporting in the standard reports enables the user to produce event-level 
reports. To produce an event-level report, the user must click the "Limit to events 
within Query Criteria" checkbox shown in the following illustration.

■ The event group information is populated from the Event Groups.

■ The user can select multiple Event Groups.

■ If the user selects the Event groups, the system limits the output to only the Events 
selected in the Event Group definition.

■ If the user clicks "Limit to Events within the Query Criteria," the system limits 
report output to the Events chosen in the report output query criteria.

– This applies to all queries executed from QBE, Filters, or Advanced Conditions

– This applies for Event Terms for the entire hierarchy (i.e., SOC, HLGT, HLT, 
PT, LLT for the MedDRA Coded events only).

– This cannot be executed with hard-coded SQL queries.

– This feature cannot be used with a case series from Safety.

– This feature cannot be used with an imported case series.

■ If the user uses a power query to generate a case series, the following terms are 
respected as the event query in the reports:

– From QBE - Events tab - Event Coding

* System Organ Class (SOC)

* High Level Group Term

* High Level Term

* Preferred Term

* Lower Level Term

– From Filters - Event Information
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* Event Term - 

i. SOC 

ii. HLGT 

iii. HLT 

iv. PT 

v. LLT

* Preferred Term

– From Advanced Conditions -

* EVENTS:Event Information Event Body System Code

* EVENTS:Event Information System Organ Class (SOC)

* EVENTS:Event Information Event High Level Group Term Code

* EVENTS:Event Information High Level Group Term

* EVENTS:Event Information Event High Level Term Code

* EVENTS:Event Information High Level Term

* EVENTS:Event Information Preferred Term

* EVENTS:Event Information Preferred Term Code

* EVENTS:Event Information Event Low Level Term

* EVENTS:Event Information Lower Level Term

* EVENTS:Event Information Event Included Term Code

* EVENTS:Event Information Event SMQ (Broad)

* EVENTS:Event Information Event SMQ (Narrow)

* EVENTS:Primary Event Event SMQ (Broad)

* EVENTS:Primary Event Event SMQ (Broad)

– This feature is available in the following reports:

* Event term frequency listing by HLGT

* Event term frequency listing by HLT

* Event term frequency listing by PT

* Event term frequency listing by SOC

* AE count tabulation (case causality)

Report Scheduling
Report Scheduling comprises the following:

■ Scheduling Multiple Reports Against a Single Query

■ Scheduling a Report without a Query

Scheduling Multiple Reports Against a Single Query  
The system enables users to schedule multiple reports in a single query. A set of 
reports run on a weekly or periodic basis can be scheduled with the same report and 
run as a package.
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On clicking the Associate button from the query library, only one report is selected. If a 
different report is chosen for the query, the system prompts the user is to change. The 
system permits the user to associate many reports with a single query.

■ The user can select any query from any library (QBE/Filters/AC) and click 
Associate.

■ The user can use the Query Library and the Associated Query Library to schedule 
an association.

■ Since multiple reports can be associated with a single query on these Query pages, 
the Execute button does not open any pre-filters page after generating the case 
series.

When you select a query and click Associate, the Scheduled Report Groups window is 
displayed.

This window includes the following features:

■ This window displays information about all the report groups scheduled by the 
logged-in user.

■ Sorting and Search functionality is available for all columns.

■ Pagination is also available.

■ Each group can contain one or more reports. "Group" means that all the reports are 
scheduled at the same time.

■ This window has the following buttons:
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– New: Redirects the user to the Report Scheduling page with blank values. The 
system presents the context menu to enable the user to choose Report 
Association Only or for Scheduling.

– Modify: Redirects the user to the Report Scheduling page and enables the user 
to modify an existing scheduled report group.

– Delete: Deletes a selected scheduled report group.

– Execute: Closes the window and executes the query in parent window to 
show case series and launch pre-filter for the selected report on this page. This 
button is enabled on if the scheduled report group has a single report.

– Close: Closes the window without any other action.

■ The system opens the Schedule Information page when the user selects 
Association Only from the drop-down list.

■ This the main scheduling page in Insight. On this page, user can select any 
number of reports for scheduling.

■ The Reports Scheduling page has four (4) sections as follows:

– Group Information: The user provides the group name and description.

– Schedule Information: The user provides the scheduling frequency.

– Email Information: The user provides e-mail information for the receivers.

– Available Reports: The user selects the reports to schedule. Select any report 
and click Add to add the report to Selected reports. The user can select 
multiple reports and add them at the same time.

– Selected Reports: Reports associate with the query (as per the selection by the 
user from Available Reports section) are listed in this field.
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* User can remove a selected report by clicking the X button against report's 
row in the grid from the Selected Reports section.

* Sorting and Search functionality is available for all the columns in the 
Available Reports Section.

* Pagination is also available on the Available Reports Section.

– The system does not permit the user to save a schedule without entering the 
pre-filter information for each report. The system uses the value in the 
Pre-Filters Configured? Column in the Selected Reports section to detect 
whether the pre-filter configuration is complete.

– The user can enter pre-filter information by selecting any report in the Selected 
Reports section. When the user selects the report, the system loads the 
pre-filter information for the report in the sidebar and enables the user to enter 
the information.

– Side bar has OK and Cancel buttons

* OK: Save the pre-filter information for the selected report.

* Clear: Reset the pre-filter page to blank values after confirming with user.

– The Schedule Information page has the following buttons:

* OK: Saves the scheduling information to the database and returns to the 
Scheduled Report Groups page.

* Cancel: Returns to the Scheduled Report Groups page without making any 
changes.

* Clear: Resets the Schedule Information page to blank values after 
confirming with user

Scheduling a Report without a Query  ■

Reports can be scheduled without a query from the Associated Library Page.

– This page has a button named "Associate to <All Cases>."

■ The user can configure Text All Cases can from the List Maintenance items.

– The system appends configured text to "Associate to <LM Text>". For 
example, if we configure All System Cases in the LM item, the text of this 
button would be "Associate to All System Cases".

■ The default value is All Cases.

■ The name of the LM Item is "All Cases Query Name".

■ When the user clicks this button, the system opens the Scheduled Report Groups 
window and behaves exactly the same way as described in the section, "Multiple 
Reports on a Single Query".

■ The Associated Reports Library page includes the following features:

– This page is the main status page for all scheduled reports.

– The user can see all reports in different/same groups at the same time. For 
example, if a user has two (2) report groups with three (3) reports in each 
group, the library has six (6) rows, one for each report association.

– The Status column displays the current status of the reports association.

– This page has the following buttons:



General Report Usage Information

Generating Standard Reports 6-9

* Modify: Enables the user to modify a selected association. This opens the 
Scheduled Report Groups page to query of the selected association. The 
system highlights the current group of the selected association.

* Execute: Executes the selected query to get the case series and opens the 
Pre-Filter page for the associated report.
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Standard Reports
The Standard Reports page displays a list of all the Standard Reports built into Argus 
Insight. Select Case Series Reports > Standard Reports > All to display the Standard 
Reports page. This page displays a list of the saved Standard Reports in a grid format. 
You can search for specific types of reports by specifying values for any of the columns 
as the search criteria and clicking Search.

The descriptions of the grid columns follow.

Standard Reports are grouped into six categories and can be accessed from the Argus 
Insight folder in the Installation CD. The following topics explain the various standard 
reports.

■ Compliance Reports

■ Configuration Reports

■ General Reports

■ Management Reports

■ Pharmacovigilance Reports

Reports - Cover Page
The following image displays the Cover page of the report when it is generated in PDF 
format.

Column Description

Name Displays the name of the Standard Report

Description Displays the Standard Report description

Last Modified Displays the date when the Standard Report was last modified

Author Displays the name of the Standard Report author

Category Displays the Standard Report Category
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The following table describes each component of the cover page shown in the above 
image.

Cover Page Component Description

Company logo 
(upper-left box)

Placeholder for a configurable logo. The image of the logo can be 
configured in the whitespace.

Report Category 
(upper-right box)

The name of the category to which the selected report belongs.

Report Execution 
Date (under ’Report 
Category’)

Report Execution Time (in GMT).

Report Title (under 
the Heading of the 
Report)

Title of the selected report, such as Serious Adverse Events Report.

Report Sub-Title 
(under ’Report Title’)

Configurable Sub-title of the selected report. You can enter a 
sub-title to further define the report. Example: 01-JAN-1900 to 
31-DEC-2007.

Report Filter A selected value from the Report Prompt.

MedDRA Version The MedDRA Version for the selected report.

Start Time of Last 
ETL Run

Start time of the last successful ETL run (in GMT).

Case Series Count A count of the total number of unique cases in the case series.
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Compliance Reports
The following table describes each Compliance Report.

Case Series Name The name of the saved case series on which the report has been 
executed. 
Reports that are run on frozen case series data indicate on the report 
next to the case series name that "The data in this report was frozen 
as of <particular date and time>". Time is the database system time 
with the GMT offset.

Reports that are run on normal case series data indicate on the 
report next to the case series name that "The case series was last 
modified on <Case series modification date and time>".

Case Series Criteria Query criteria to get case series on which the report has been 
executed.

User Name 
(bottom-left)

The name of the user who executed the report.

Confidential 
(bottom-centre)

Configurable Confidential text.

Page x of y 
(bottom-right)

Page Number (in Current Page number of Total Pages in the Report 
format).

Footer logo 
(bottom-right box)

Placeholder for a configurable logo. The image of the logo can be 
configured in the whitespace. This component may not appear in 
every report.

Report Title Description

Destination Report 
Submission Listing

Use this report to view the submission details based on an on-line country.

Global Audit Listing Use this report to view case information relating to adverse event.

This report is a listing of case information relating to adverse event, listedness, 
seriousness, and submission record information for suspect products, used to 
support external audit.

KPI List Report 
Country Group 1

Listing of case submission information for submissions in Group 1 countries 
(countries with clock starting from first receipt globally) grouped by Agency 
(submission destination) to support compliance KPI generation.

KPI List Report 
Country Group 2

Listing of case submission information for submissions in Group 2 countries 
(countries with clock starting from receipt in that country, i.e aware date for 
domestic cases and generated date for foreign cases) grouped by 
Agency(submission destination) to support compliance KPI generation.

KPI Overview Report 
Group 1

Table of submission count, late submission count and overall compliance figures 
for submissions in Group 1 countries (countries with clock starting from receipt 
globally) grouped by Agency(submission destination) to support compliance 
KPI generation.

KPI Overview Report 
Group 2

Table of submission count, late submission count and overall compliance figures 
for submissions in Group 2 countries (countries with clock starting from receipt 
in that country, i.e aware date for domestic cases and generated date for foreign 
cases y) grouped by Agency(submission destination) to support compliance KPI 
generation.

Labeling Detail 
Listing by Case 
Number

Use this report to check for consistency between Labeling and Seriousness 
Criteria. The report is a listing of cases with events and their labeledness for the 
licenses of selected countries. Only the first company suspect product is 
included in the report; however, all events are listed. This report is grouped by 
case numbers.
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Labeling Detail 
Listing by Preferred 
Term

Use this report to check for consistency between Labeling and Seriousness 
Criteria. This report is a listing of cases with events and their labeledness for the 
licenses of the selected countries selected. Only the first company suspect 
product is included in the report; however, all events are listed This report is 
grouped by Preferred Term.

Labeling Summary Use this report to verify the consistency of labeling assessment. This report is a 
summary tabulation of labeling for events based on the countries selected.

Outstanding 
Expedited Reports by 
Responsible Group

Use this report to view a listing of cases for which expedited reports are 
outstanding. The listing is grouped by the responsible group.

Outstanding Report 
Submission by 
Responsible Group 
Listing - Detail

Use this report to view a detailed listing of cases for which report submissions 
are coming up.

The listing is grouped by responsible group and again sub-grouped by agency. 
The listing is sorted in descending order of due-date.

Outstanding Report 
Submission by 
Responsible Group 
Listing - Summary

Use this report to view the outstanding report count for each reporting 
destination. Against each destination, the outstanding reported count is further 
broken up in these groups:

■ Due in greater than seven days

■ Due in 3-7 Days

■ Due in 0-2 days

■ Past the due date

Outstanding Report 
Submissions by 
Destination Listing - 
Detail

Use this report to obtain a detailed listing of upcoming report submissions based 
on report destinations.

Outstanding Report 
Submissions by 
Destination Listing - 
Summary

Use this report to obtain a summary listing of upcoming report submissions 
based on report destinations (Summary).

Reporting 
Compliance by 
Destination (Count)

Use this report to obtain a graphical overview of reporting compliance.

Reporting 
Compliance by 
Destination 
(Percentage)

Use this report to obtain a graphical overview of compliance expressed in 
percentages.

Reporting 
Compliance by 
Grouped Destination 
(Count)

Use this report to obtain a graphical overview of compliance grouped by 
reporting destination.

Reporting 
Compliance by 
Grouped Destination 
(Percentage)

Use this report to obtain a graphical overview of compliance grouped by 
reporting destination expressed in percentages.

Reporting 
compliance by 
Responsible Group

Use this report to obtain a graphical overview of compliance for a given 
reporting group. This report shows how many reports were assigned to a 
particular reporting group, that were submitted before the due date/ on the due 
date/ after the due date.

Reporting 
Compliance Listing - 
Detail

Use this report to view a detailed listing of submitted as well as outstanding 
reports for the selected cases and reporting destinations. The listing is grouped 
by destination; subtotals and compliance % are provided for each destination 
along with an overall total and total compliance %.

Report Title Description
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Configuration Reports
The following table describes each Configuration Report.

General Reports
The following table describes each General Report.

Reporting 
Compliance Listing - 
Summary

Use this report to view a summary listing of submitted as well as outstanding 
reports for the selected cases and reporting destinations. The listing is grouped 
by destination; subtotals are provided for each destination along with 
compliance percentage.

Reports Out of 
Compliance Listing - 
Detail

Use this report to view a detailed listing of all reports that were past the due 
date for the selected cases and reporting destinations. The listing is grouped by 
reporting destination; subtotals are provided for each destination apart from the 
overall total.

Reports Out of 
Compliance Listing - 
Summary

Use this report to view a summary listing of all reports that were past the due 
date for specific destinations. The listing is grouped by reporting destination; 
subtotals are provided for each destination apart from the overall total.

Reports Out of 
Compliance with 
Delayed Workflow 
Detail

Use this report to view a listing of late reports along with the details of the 
workflow states where they exceeded the maximum allotted time.

Report Title Description

ETL Log Argus to Staging 
Incremental

Displays the ETL Log for the latest Argus to Staging ETL Incremental 
Process.

ETL Log Staging to Mart 
Incremental

Displays the ETL Log for the latest Staging to Data Mart ETL Incremental 
Process.

ETL Log Summary Displays the ETL Summary for all the ETL Processes.

Listing of Licenses by Family and 
Product

Obtain an overview of defined licenses grouped by families.

Listing of Product by Family and 
Licenses

Obtain an overview of defined products grouped by families.

StudyConfiguration Obtain a listing of configured Studies.

Workflow Configuration by State Obtain a listing grouping the workflow states listing the incoming and 
outgoing states.

Workflow Configuration by 
Transition

Obtain a listing of the configured transitions sorted by From and Use the 
following procedure to states.

Reporting Rules Configuration Obtain a listing of configured Reporting Rules.

Report Title Description

Audit Review Listing This report provides a listing of case information in tabular format relating to 
adverse event, listedness, seriousness for Novartis suspect products, used to 
support internal audit.

Case Count By 
Reporter Type

This is a report for tracking the origin of all notifications.

Case Narrative 
Listing -English

This report is a narrative overview list of all cases per drug per report type with 
international and local narratives

Report Title Description
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Case Narrative 
Listing -Multilingual

This report is a narrative overview list of all the cases per drug per report type with 
international and local narratives

Case Origin Listing This report is a listing to track the origin of all case notifications.

CIOMS II Line 
Listing

This report prints the standard CIOMS II Listing report for all cases of the case 
series.

CIOMS Report This report prints the standard CIOMS I report for all cases of the case series.

Clinical Medical 
Review List

This report provides a listing of serious clinical trial events grouped by study ID.

Detailed Line Listing 
by Case Number

This report is a listing of case details (suspect drugs, concom drugs, events, 
outcome, indication, narrative, demographics, relevant history) grouped by study 
number, center number, patient number and sorted by case number. Used to 
support data reconciliation process.

Detailed Line Listing 
by SOC

This report is a listing of case details (suspect drugs, concom drugs, events, 
outcome, indication, narrative, demographics, relevant history) grouped by SOC 
and sorted by SOC to support medical review, analysis and documentation. This 
listing is used widely and often provided to internal and external customers.

Downgraded Reports 
Listing

This report obtains a listing of downgraded reports.

Literature Listing This report provides an overview including case number with literature reference 
and case details.

Lot Number Listing - 
Detail

Use the following procedure to investigate a correlation of events for a certain lot 
number (Listing).

Lot Number Listing - 
Summary

Use the following procedure to investigate a correlation of events for a certain lot 
number (Summary).

MSE Review List For 
Non Serious SR

This report lists the basic case information(events, suspect drugs) - grouped by 
MSE (based on MSE-Drug responsibility configuration) to assist MSE in weekly 
review of non-serious SR and unrelated CT cases

MSE Review List for 
Unrelated CT

This report lists the basic case information(events, suspect drugs) - grouped by 
MSE (based on MSE-Drug responsibility configuration) to assist MSE in weekly 
review of non-serious SR and unrelated CT cases

Relevant Medical 
History listing

This report is a listing of all relevant histories for the selected cases.

SAE Clinical Trial 
Co-Medication

This report is a listing of case concomitant medication details - sorted by case 
number. Used to assist medical investigation.

SAE Clinical Trial 
Detail Listing

This report is a listing of case details(events, demographics, study details, treatment 
details) - sorted by case number. Used to assist medical investigation.

SAE Clinical Trial 
Laboratory Test

This report is a listing of case laboratory tests - sorted by case number. Used to 
assist medical investigation

SAE Clinical Trial 
Medical Conditions

This report is a listing of case current conditions, family history, past medical 
history - sorted by case number. Used to assist medical investigation.

SAE Clinical Trial 
Narratives

This report is a listing of case narratives and study details - grouped by protocol 
number and sorted by case number. Used to assist medical investigation.

SAE Clinical Trial 
Project Overview

This report is in tabular data of number of distinct cases and receipt date range, 
create date range flags - grouped by protocol number, study number, report type.

Simple Line Listing 
by Case Number

This report is a listing of key case information - grouped and sorted by case number 
to provide high level overview and quick review.

Simple Line Listing 
by SOC

This report is a listing of key case information - grouped and sorted by SOC of 
primary event, drug, and case number to provide high level overview and quick 
review.

Report Title Description
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Management Reports
The following table describes each Management Report.

Study Reconciliation 
Report

This report provides a data-set to enable reconciliation between Argus and the 
company clinical database.

US FDA MedWatch 
3500A

Prints the standard US FDA MedWatch 3500A report for all cases of the case series.

Report Title Description

Case Load History by 
Day

Listing of the number of pending cases for given workflow states by Day

Case Load History by 
Month

Listing of the number of pending cases for given workflow states by Month

Case Load History by 
Quarter

Listing of the number of pending cases for given workflow states by 
Quarter

Case Load History by 
Week

Listing of the number of pending cases for given workflow states by Week

Case Load History By 
Year

Listing of the number of pending cases for given workflow states by year

Case Processing 
Times Listing

Obtain a listing of processing time per case and workflow state including 
the time to lock and closure of case.

Case Routing History Detailed listing of all states a case has been routed to.

Case Seriousness 
Distribution

Obtain a listing of cases by seriousness grouped by country of origin.

Case Seriousness 
Distribution 
Graphical Summary

Obtain a graphical representation of cases by seriousness grouped by 
country of origin.

Case Versions 
Processed

Obtain a summary tabulation of follow-ups processed.

Case Volume by 
Reporter Type

Listing to show the volume of cases that were received over a certain time 
period. Used to pick out trends in reporting sources.

Case Volume History 
- Initial and 
Significant 
Follow-ups

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by initial vs. follow-up reports.

Case Volume History 
- Product - All 
Company Suspect 
Products

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by key indicators (Product - All 
Company Products)

Case Volume History 
- Product - Primary 
Suspect Products 
Only

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by key indicators (Product - 
Primary Suspect Only).

Case Volume History 
(Reporter Type)

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by key indicators (Report Type).

Case Volume History 
(Seriousness)

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by key indicators (Seriousness).

Report Title Description
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Case Volume History 
split by Initial and 
Follow-up

Use the following procedure to obtain an overview of case volume by 
specified time period and broken down by initial vs. follow-up reports.

Case-Load Obtain a graphical representation of cases in each workflow state.

Case-Load Listing Obtain a listing of the number of cases received and processed per 
workflow state for a given time period.

Cases by Reporter 
Type Tabulation

Use the following procedure to compare the number of cases from each 
reporter type.

Delayed Workflow 
Listing by Case

Obtain a list of cases where the max time has been exceeded.

Delayed Workflow 
Listing by Workflow 
State

Obtain a list of cases where the max time has been exceeded.

First and Last 
Reporter Contact

Obtain a listing of case details including first and last contact from the 
reporter (Initial receipt and most recent follow-up date) for each case.

Follow-up Status 
Listing

Obtain a listing of cases requiring follow-up and the status of those cases.

Listing of Cases due 
for Lock

Obtain a listing of cases that due for lock

Listing of Cases Late 
for Lock

Obtain a listing that displays case work state milestones and lead times for 
workflow as well as minimal case information.

Open Action Items 
Listing

Obtain a list of cases with open action items by responsible group.

Product Tabulation 
by Site and Case 
Source

Obtain a summary that lists the number of cases by site and product 
(Ingredient) by Report Type with totals.

Receipt Latency of 
Cases by Site - Initial 
and All Follow-ups

Obtain a listing of latency from initial receipt date to central received date 
for initial and follow-up reports.

Receipt Latency of 
Cases by Site - Initial 
and Significant 
Follow-ups

Obtain a listing of latency from initial receipt date to central received date 
for initial and follow-up reports.

Receipt Latency of 
Cases by Site and 
Country of Origin

Obtain a listing of latency from initial receipt date to central received date 
for initial and follow-ups, broken down by country of origin.

Received AE Reports 
by Protocol

Obtain a line Listing of all cases received grouped by Protocol Number 
(Study ID).

Report Volume 
History

Listing to show the volume of reports that were submitted over a certain 
time period broken down by reporting destination.

Reports By Causality Graph of number of reports processed grouped by case causality to verify 
workload, productivity. The counts show the number of case locks (initial or 
follow-up) with initial or follow-up information during the report period.

Reports by Country Graph of number of reports processed - grouped by country of incidence 
and sorted by descending counts to verify workload, productivity. The 
counts show the number of case locks (initial or follow-up) for cases 
originating from that country during the report period.

Reports by Month Graph of number of reports processed - grouped by month and sorted by 
numeric month to verify workload, productivity. The counts show the 
number of case locks (initial or follow up) in that month.

Report Title Description
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Pharmacovigilance Reports
The following table describes each Pharmacovigilance Report.

Reports By Product 
Family

Graph of number of reports processed - grouped and sorted by descending 
counts to verify workload, productivity. The counts show the number of 
case locks (initial or follow up) where the primary suspect is in that Drug 
Family during the report period.

Reports by Report 
Type

Graph of number of reports processed - grouped by report type; such as 
Spontaneous Report, Clinical Trial(non-PMS), PMS, or Literature. The 
counts show the number of case locks (initial or follow-up) during the 
report period.

Reports by 
Seriousness

Graph of number of reports processed - grouped by case seriousness to 
verify workload, productivity. The counts show the number of case locks 
(initial or follow-up) during the report period.

Reports by Year Graph of number of reports processed - grouped by year and sorted 
chronologically. The counts show the number of case locks (initial or 
follow-up) in that year.

Total Case WorkLoad 
by Site

Obtain a listing of total number of cases in the system.

Total Case Workload 
by Site and COI - Init. 
and Sig. Follow-ups

Obtain a listing of total number of cases in the system grouped by site and 
country of origin.

Total Case Workload 
by Site and COI - 
Initial and All 
Follow-ups

Obtain a listing of total number of cases in the system grouped by site and 
country of origin.

Total Case Workload 
by Site Graphical 
Summary

Obtain a graphical overview of the total number of cases in the system 
broken down by seriousness.

Workflow 
Monitoring Report

Obtain a listing that displays case workflow milestones and lead times for 
workflow as well as minimal case information.

Workflow Report - 3 
months

Counts based on Groups over 3 month periods, based on a selected date 
range.

Workflow Report - 4 
quarters

Counts based on Groups over 4 quarters, based on a selected date range.

Report Title Description

AE Count Tabulation This report is a summary tabulation that displays a count of events and breaks 
them down by causality.

Age Group Vs. 
Gender

This report is an analysis of relationships between two or more attributes.

Aggregate Diagnosis 
Listing

This report is a summary of the event counts by Diagnosis and broken down 
by seriousness and listedness.

Annual Product 
Review

This report is a listing of all cases for a drug family grouped by primary 
suspect drug, SOC and sorted by drug, SOC to review cases potentially 
associated with quality compliant or lack of efficacy.

Case Listing This report is a case listing of cases with key Pharmacovigilance data elements 
for spontaneous cases.

Case Listing with all 
Regimens and Events

This report is a case listing of cases with all regimens and events for 
spontaneous cases.

Report Title Description
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Clinical Case Listing This report is a case listing for clinical cases

Clinical Trial 
Causality

This report captures the Table of event count grouped by selected MedDRA 
levels (SOC,HLGT,HLT,PT), administered drug, event causality to support 
medical investigation. Case counts for selected MedDRA levels and 
administered drug is also included

Clinical Trial 
Causality Tabulation

This report is required to tabulate the causality assessments for each occurring 
PT.

Count of Serious 
Related Cases by 
Product

This report provides an overview of serious related cases over a given time 
period.

Data Quality 
Indicator 
(Alphabetically by 
Quality Indicator)

This report provides a graphical summary of case data quality for the 
following key data elements

Data Quality 
Indicator Listing

This report provides a list that contains the cases that contributed to the data 
value as the graphical report

Data Quality 
Indicator (Ascending 
Order of Count)

This report provides a graphical summary of case data quality for the 
following key data elements.

Death Cases This report provides the listing of cases with death details, event details where 
the patient has had a fatal outcome - grouped by SOC.

Dechallenge and 
Rechallenge Listing

This report provides the Line Listing for Dechallenge and rechallenge 
information

Dosage Frequency 
Tabulation

This report captures the frequency of dosing for a particular product to see if 
there is an increase in frequency of various AEs.

Dose Formulation 
Product Relationship

This report captures the relationship between dosage formulation and events 
for a given suspect drug.

Duration of 
Treatment until Event 
(Time to onset) per 
Event

This report captures the table of event counts categorized by time to onset - 
grouped and sorted by event.

Event (PT) Vs Age 
Group

This report is required to analyze relationships between two or more attributes.

Event (PT) Vs Daily 
Dose

This report is required to analyze relationships between two or more attributes.

Event (PT) Vs 
Duration of 
Treatment Until 
Event

This report is required to analyze relationships between two or more attributes.

Event (PT) Vs Gender This report is required to analyze relationships between two or more attributes.

Event (PT) Vs Report 
Type

This report is required to analyze relationships between two or more attributes.

Event Term 
Frequency Listing by 
HLGT

This report is required o identify the frequency of events in descending order, 
grouped by SOC, HLGT, HLT, or PT.

Event Term 
Frequency Listing by 
HLT

This report is required to identify the frequency of events in descending order, 
grouped by SOC, HLGT, HLT, or PT.

Report Title Description
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Event Term 
Frequency Listing by 
PT

This report is required to identify the frequency of events in descending order, 
grouped by SOC, HLGT, HLT, or PT.

Event Term 
Frequency Listing by 
SOC

This report is required to identify the frequency of events in descending order, 
grouped by SOC, HLGT, HLT, or PT.

Event Vs Daily Dose This report is required to analyze relationships between two or more attributes.

Event Vs Report Type This report is required to analyze relationships between two or more attributes.

Event Vs. Age Group This report is required to analyze relationships between two or more attributes.

Event Vs. Duration of 
Treatment Until 
Event

This report is required to analyze relationships between two or more attributes.

Event Vs. Gender This report is required to analyze relationships between two or more attributes.

Fatal Case Listing This report is required to obtain a listing of cases with fatal seriousness criteria.

Fatal/Life-Threatenin
g Cases Listing

This report is required to obtain a listing of cases with fatal or life-threatening 
seriousness criteria.

Frequency Listing of 
Events

This report is a table of event counts - sorted by descending event count 
frequency to help support labeling or package insert review.

Gender Group by 
Age Group

This report is required to capture the Gender Group by Age Group

MedDRA SOC-PT 
group report type, 
event seriousness, 
causality

This report is required to capture the Table of event, case count categorized by 
report type, event seriousness, causality - grouped and sorted by preferred 
term to support medical analysis.

MedDRA SOC-PT 
Group by Age Group

This report is required to capture the Table of event, case count categorized by 
chronological Age group - grouped by preferred term to support medical 
analysis.

MedDRA SOC-PT 
Group by Daily Dose

This report is required to capture the Table of event, case count categorized by 
Daily Dose bands - grouped and sorted by preferred term to support medical 
analysis

MedDRA SOC-PT 
Group by Gender

This report is required to capture the Table of event, case count categorized by 
gender - grouped and sorted by preferred term to support medical analysis.

Product and Disease 
Listing

This report captures the concomitant medications and underlying disease

Product Interaction 
Tabulation

This report is a summary tabulation that displays a count of the incidence of 
other products involved in cases.

Quick Signal This report captures the event-reporting rates that might suggest a possible 
change in the safety profile of a product.

Seriousness Case 
Listing

This report provides a listing of cases by grouped by seriousness criteria.

SOC/PT Tabulation 
(Event Count)

This report compares events based on report type.

Temporal 
Relationships

This report captures a graphical overview of the temporal relationships of the 
dates recorded in the case.

Top 10 Substances This report captures a listing of the top 10 frequent substances occurring in 
cases for the specified time period.

Report Title Description
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7Creating Custom Reports

Creating Custom Reports
In addition to the preformatted Standard Reports, Argus Insight provides Report 
Writer, Cubes, and Dashboard Indicators tools that let you create custom reports for ad 
hoc/special reporting requirements.

Report Writer is used to create a custom report by directly selecting datamart fields 
and applying filters on them. The report output can be displayed in various layouts 
and can be saved in file formats, such as PDF, XLS, or CSV.

A Cube is a data model that contains multiple dimensions (key reporting elements). 
You can observe and analyze the interactions between reporting elements by 
performing operations such as nesting, drill, sort, count, and total. Argus Insight 
provides five built-in Cubes, pertaining to varied reporting aspects.

Dashboard Indicator reports are configured by the administrator and made available 
to users based on their profile. These reports pull the latest data from the datamart and 
provide information on key product performance and workflow efficiency parameters.

The topics that follow explain how to use the custom report tools.

■ General Report Writer Information

■ Creating a New Report

■ Editing Reports

■ Changing the Report Layout

■ Saving and Accessing Saved Reports

General Report Writer Information
In this version of Argus Insight, Report Writer utilizes the features of Cognos® 8 Query 
Studio to let you create custom reports by directly selecting datamart fields and 
viewing the result (report output) on the fly. The Report Writer interface provides a list 
of database fields organized in a tree structure. Use the following procedure to create a 
report, expand the trees corresponding to the required database fields and select the 
fields to be displayed as columns in your report.

Once you have created your report, you can edit the report, change the report layout, 
run the report in specific formats, and save the report.
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Creating a New Report
This topic explains how to start Report Writer and create a new report. Use the 
following procedure to create a new report.

1. In Argus Insight, select Case Series Reports > Report Writer > New. Query 
Analysis starts. In the left frame, the Insert Data menu option is selected.

2. Select the Active Case Series Filter.

3. In the left frame, expand the Report Writer control tree. The various datamart 
views are displayed.

Note: The report author must ensure to not use those 
enterprise-specific values in the report, which will also be shared with 
other enterprises.

Note: Select the Active Case Series Filter before selecting datamart 
fields for your report. This prevents Report Writer from querying the 
entire datamart and slowing down the report output generation.

Use the following procedure to view the Active Case Series, select 
Query Results > Case Series > Active in Argus Insight. If you want to 
make another Case Series active, select Query Results > Case Series > 
Library in Argus Insight. In the Case Series Library page that appears, 
check the Case Series you want to make active and click Make Active.
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4. Scroll down the list of views so that the Filters folder is visible.

5. Expand the Filters folder. The built in Active Case Series Filter is displayed.
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6. Select the Active Case Series Filter.

7. Click Insert. The selected filter appears in the right frame.

8. Select the datamart fields to include in your report.

9. In the left frame, expand the Report Writer control tree. The various datamart 
views are displayed.

10. Expand the datamart view tree, as appropriate. The datamart fields corresponding 
to the tree are displayed.
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11. Select the datamart fields, as appropriate.

12. Click the Insert button. The Report Writer queries the datamart, automatically 
executes the query for every field you selected, and displays the data for the 
selected fields in the report output area within the right frame. The fields you 
selected are displayed as columns in the report output.

13. Repeat the steps listed above to insert additional fields into the report.

14. Enter the report title.

15. Click Title above the report output. The Edit Title section appears below the 
report output in the right frame.

Tip: If your report consists of fields from the Event and Product 
tables, it will only display data for those cases where event assessment 
has been done. This is because event assessment is the only way of 
defining relationship between an event and a product.

Tip: Select multiple fields as follows:

■ Hold down the CTRL key and select the fields.

■ Insert an entire datamart view in your report by selecting the 
datamart view entity in the left frame and clicking Insert.

■ Drag the field entities to the report output area.

Tip: If you wish to delete a column from the report output, select the 
column and click the Delete button on the toolbar.

You can revert or repeat any actions you perform in Query Studio by 
using the Undoor Redotoolbar button, respectively.
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16. Enter the report title and subtitle in the respective text boxes.

17. Click OK. The page refreshes; the titles you entered appear above the report 
output.

Using Case Series Criteria and Case Series Name in new Report.
Use the following procedure to generate a report for displaying all the Case Series 
Criteria and Case Series Name.

1. Select the Case Series Criteria and Case Series Name objects from the Case Series 
class.

2. The Report Writer queries the datamart, to get all the Case Series Criteria and 
Case Series Name.

Using Case Series Criteria and Name with Other Objects
Use the following procedure to use the Case Series Criteria and Case Series Name with 
other objects.

1. In the left frame, expand the class folders under Report Writer.

Note: Temporary Case Series Criteria and Case Series names will not 
be displayed.
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2. The dimensions for the class category are displayed.

3. Scroll down the list of views so that the Filters folder is visible.

4. Expand the Filters folder.

5. The built in Active Case Series Filter is displayed.

6. Select the Filter.

7. Click Insert.

8. The selected filter appears in the right frame.

9. In the left frame, expand the Report Writer control tree.

10. The various datamart views are displayed.
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11. Expand the datamart view tree, as appropriate.

12. Select the datamart fields, as appropriate along with Case Series Criteria and Case 
Series Name from Case Series class.

13. Click the Insert button.

Tip: If your report consists of fields from the Event and Product 
tables, it will only display data for those cases where event assessment 
has been done. This is because event assessment is the only way of 
defining relationship between an event and a product.



Creating Custom Reports

Creating Custom Reports 7-9

14. The Report Writer queries the datamart, automatically executes the query for 
every field you selected, and displays the data for the selected fields in the report 
output area within the right frame. The fields you selected are displayed as 
columns in the report output along with Case Series Criteria and Case Series 
Name.

15. Select Case Series Criteria and click Create Sections icon.

Tip: Use the following procedure to select multiple fields, hold down 
the CTRL key and select the fields. You can also insert an entire 
datamart view in your report by selecting the datamart view entity in 
the left frame and clicking Insert.

You can also drag the field entities to the report output area.
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16. The Case Series Criteria displays as header.

17. Display the Case Series Name as header.



Creating Custom Reports

Creating Custom Reports 7-11

After you have selected the required datamart fields and generated the output, you 
can use the various Query Studio options toedit the report, change the report layout, 
run the report in specific formats, and save the report.

Editing Reports
You can access Query Studio's report editing options by selecting the Edit Data menu 
option. The report editing options let you control what data appears in your report as 
well as how it is formatted, calculated, and sorted. None of the edit operations you 
perform are stored in the database.

Note: Always use Active Case Series Filter while using Case Series 
Criteria and Case Series Name with other objects. As, it may leads to 
undesirable results.

Use the following procedure to view the Active Case Series, select 
Query Results > Case Series > Active in Argus Insight. If you want to 
make another Case Series active, select Query Results > Case Series > 
Library in Argus Insight. In the Case Series Library page that appears, 
check the Case Series you want to make active and click Make Active.
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This topic only explains the basic report editing operations in Query Studio. For 
detailed information, refer to the documentation supplied with the Cognos8 products.

Filtering Data
You can use the filtering option to reduce data in your report. Use the following 
procedure to filter your report.

1. In the report output area, click within the header of the column you want to use to 
filter the report output. The selected column is highlighted.

2. Select Filter from the Edit Data menu options in the left frame. The Filter section 
appears below the report output in the right frame. The Show only the following 
list displays all the values in the column you selected.
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3. In the Show only the following list, check the values by which you wish to filter 
the report output.

4. If you want the system to prompt you to select the filter values each time you run 
the report, check the Prompt every time the report runs checkbox.

5. If you want the report output to include those records which have a null value (no 
value) in the selected filter column, check the Show missing values checkbox.

6. Click OK. The system refreshes the report and displays the filtered output. The 
filter information is displayed above the report output.

Sorting Data
Use the following procedure to change the sort order in your report.

1. In the report output area, click within the header of the column that contains the 
values by which you wish sort the report output. The selected column is 
highlighted.

2. Select Sort from the Edit Data menu options in the left frame. The Sort section 
appears below the report output in the right frame.

Note: The Show only the following list may not display all the 
values if the list of values is very large. If you cannot find the desired 
values to filter on, click the Search for values link and search for the 
value by typing the value you are looking for.
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3. Select the required sorting option by using the Sort Order option buttons.

4. Click OK. The system refreshes the report and displays the sorted output.

Summarizing Data
You can use the predefined summary options to calculate the total, count, maximum, 
minimum, or average of the values in columns of your reports. The summary options 
available to you depend on the type of data in the column you wish to summarize. For 
example, you can only use the Count option if your column contains text data whereas 
you can use total, maximum, minimum, or average options if the column contains 
numeric data.

1. In the report output area, click the column that you wish to summarize. The 
selected column is highlighted.

2. Select the column to be grouped and click on the Group icon placed in the 
grouping menu in the top panel. The selected column is grouped.
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3. Select Summarize from the Edit Data menu options in the left frame. The 
Summarize section appears below the report output in the right frame.

4. From the Summary for footers list box, select the required summary option. The 
options available depend on the type of values the select column contains.

5. Click OK. The report output displays the column summary at the bottom of the 
report. Click the Bottom link to view the footer. If your report is grouped, the 
summary values are displayed for each group.

6. To remove summary information, select the relevant column and click 
Summarize. Select None from the summary option list box and click OK.
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Formatting Data in Cells
You can use predefined formats to change the appearance of numbers, dates, and 
times in your report. Formatting does not change the underlying data. The following 
table describes the various formatting options available.

1. In the report output area, click within the header of the column that you wish to 
format. The selected column is highlighted.

2. Select Format from the Edit Data menu options in the left frame. The Format 
section appears below the report output in the right frame.

3. Select the data format from the Category list box, as appropriate. The options for 
setting the format appear.

4. Set the formatting options, as appropriate.

5. Click OK. The report output is refreshed and displays the formatted data.

Performing Calculations
While the Summary option lets you display calculation results in report footers, the 
Calculate option lets you create a new column that displays the calculation results for 
one ore more columns. For example, you can perform the following types of 
calculations:

■ an arithmetic calculation between several columns in a report

■ analytic operations, such as maximum, minimum, average, or percentile, in 
grouped reports

■ percentage operations, such as percentage of total or percentage of difference

■ operations on text, such as concatenating text in two columns or abbreviating text 
in a column

The type of calculations or operations available to you depend on the type of 
information in a column.

Format Description

Default The default format is the format of the report item before any formatting is 
applied in Query Studio. Use default to remove formatting.

Text Use the text format to specify the number of characters that should be visible in 
the text string.

Number Use the number format to change the number of decimal places, to specify 
whether to use a thousands separator, to choose different symbols to represent 
negative numbers, and to scale large numbers.

Currency You can choose from many world currencies. Use either the currency symbol or 
the international code. For example the currency symbol for the euro is  and the 
international code is EUR. You can also change the number of decimal places, 
specify whether to use a thousands separator, choose different symbols to 
represent negative numbers, and to scale large numbers.

Percentage This format shows a number multiplied by 100, using two decimal places and a 
percent sign. For example, 0.7356 appears as 73.56%.

Scientific This format shows a number in exponential notation. For example, the number 
224,110 is 2.24110E+05 in scientific notation.

Date and Time ·You can choose from a list of date and time formats, including the 12 or 24 hour 
clock.
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1. In the report output area, select the columns on which you wish to perform 
calculations. The selected columns are highlighted.

2. Select Calculate from the Edit Data menu options in the left frame. The Calculate 
section appears below the report output in the right frame.

3. From the Operation Type list box select the type of operation you wish to 
perform. The operation types available depend on the type of information the 
selected columns contain, such as text or numeric.

4. From the Operation list box, select the operator. The operators available depend 
on the type of operation you specified.

5. Depending on the operator you selected, additional options may appear in the 
Calculate section. Specify those options.

6. Use the New item name option buttons to specify whether you want to the result 
column to have a new header title.

7. Click the Insert button in the Calculate section. The report output is refreshed and 
displays the calculation result.

Changing the Report Layout
You can access Query Studio's report layout options by selecting the Change Layout 
menu option. The layout options let you change the appearance of your reports 
without changing the underlying data. For example, you can convert your report into 
a chart or group the report into crosstab column headers. You can also group your 
report by a specific column, swap rows and columns, or create sections within your 
report.
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The sections explain how to use the various report layout options.

Creating a Chart
Use the Chart option to graphically see patterns and trends in data. Charts can only be 
created for reports that contain measures (numeric values). Use the following 
procedure to create a chart from a report.

1. While your report is displayed, select the Chart from the Change Layout menu 
options. The Chart section appears below the report output in the right frame.

Note: This topic only describes the basic layout operations in Query 
Studio. For detailed information, refer to the documentation supplied 
with the Cognos 8 products.
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2. Use the Chart Type list box to select the type of chart you want to create. For 
example, column, pie, radar, and so on.

3. Check the Show the values on chart checkbox if you wish to display the measure 
value in the chart.

4. Use the Show the following in the report option buttons to specify whether you 
want the output to display only the chart or both chart and table.

5. Click OK. The report output refreshes. The chart is displayed.

Grouping by Row Headings
Use the Group option to reorder the rows of a selected column so that identical values 
appear together. Grouping also suppresses display of duplicates. You can group only 
those columns that contain text data or numeric data that is not a measure. Use the 
following procedure to group a report

Tip: The legends are displayed at the bottom of the screen.
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1. In the report output area, click within the header of the column that contains the 
values you wish to use to group the report. The selected column is highlighted.

2. Select Group from the Change Layout menu options in the left frame. The system 
refreshes the report and displays the grouped output.

To Ungroup a Report
To ungroup a report, select the grouped column and select Ungroup from the Change 
Layout menu options.
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Creating Crosstab Reports
A crosstab report shows a measure at the intersection of each row and column. This 
type of report is useful when you need to display a large amount of data in a small 
area. For example, if a report shows Country as columns, Products as rows, and Case 
Count as the measure, the value at the intersection of each column and row shows the 
count of cases for that product and that country.

1. Select the following datamart fields to include in your report.

■ General - General Information > Case Number

■ General - General Information > Country of Incidence

■ Product - Product Information > Product Name

2. The Report Writer queries the datamart, automatically executes the query for 
every field you selected, and displays the data for the selected fields in the report 
output area within the right frame. The fields you selected are displayed as 
columns in the report output.

3. Convert the Case Number column values into counts.

4. Select the Edit Data menu. The Edit Data menu options are displayed.

5. Select the Case Number column by clicking within the column. The Case Number 
column is highlighted.

Summarize the Sections in the Report  
Use the following procedure to summarize the sections in a report.

Note: You cannot create crosstab reports directly in Query Studio nor 
does Query Studio permit you define measures. Use the following 
procedure to create sophisticated reports, such as crosstab reports, use 
the Cognos 8 Report Studio tool. The steps that follow explain how to 
create a crosstab report by performing the "Count" operation on each 
cell of the Case Number column to convert it into a measure. You can 
use this method to create similar crosstab reports in Query Studio.

Tip: To create a crosstab report using the Count operation
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1. Select the Summarize option from the Edit Data menu. The Summarize section 
appears below the report output.

2. Click the Advanced link in the Summarize section. Additional options appear.

3. Select Count from the Summary for cells list box.

4. Select Total from the Summary for footer list box.

5. Click OK. The report output refreshes. The Case Number column now shows the 
case count for each row.

Convert to a Crosstab Report  
Use the following procedure to convert to a Crosstab report.

1. Select the Change Layout menu. The Change Layout menu options are displayed.
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2. Select the Country of Incidence column in the report output. The column is 
highlighted. The values of the selected column will appear as columns in your 
crosstab report.

3. Select the Pivot from the Change Layout menu options. The report output 
refreshes. The crosstab report is displayed.

Creating Sections in the Report  
Use the Create Sections option to group your report into section headings. The section 
headings are based on the values within a column you select.

1. In the report output area, select the column you wish to use for creating sections. 
The selected column is highlighted.



Creating Custom Reports

Creating Custom Reports 7-24

2. Select Create Sections from the Change Layout menu options. The report output 
refreshes. The report is grouped into sections.
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Swapping Rows and Columns  
The Swap Rows and Columns option in the Change Layout menu lets you 
interchange rows and columns in a crosstab report or a chart based on a crosstab. 
However, this option does not let you swap rows and columns in a list report.

Swapping rows and columns is useful in situations where a crosstab report has few 
rows and many columns.

Use the following procedure to make the report shown above easier to read, you can 
select the Swap Rows and Columns and interchange rows with columns.

If there are multiple rows or columns in a crosstab report, the outermost rows become 
the outermost columns, and the outermost columns become the outermost rows.

Running the Report in Specific Formats
Query Studioprovides you many options to run or preview a report. You can access 
Query Studio's various run and preview options by selecting the Run Report menu 
item. Select the desired option to run the report.
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The following table describes the various Run Report options available in Query 
Studio.

Saving and Accessing Saved Reports
Use the Manage File menu option to save the reports you create by using Report 
Writer. You can save your reports in either Personal or Public folders. The reports you 
save are not a snapshot of the data displayed in the report output. Instead, the system 
stores the specific set of instructions (datamart fields you select) for extracting data 
from the datamart when you run the report. For example, if you run a report that you 
saved a week ago, the data in the report reflects any changes in the datamart as a result 
of the ETL process.

Option Description

Run with All Data Select this option to run the report using the full datamart. Running a 
report with all data can take a long time. If you plan to make several 
changes to a report, you may run the report by selecting the Preview 
with Limited Data option to limit the rows of data that your report 
retrieves.

Preview with Limited 
Data

Select this option to preview the report by retrieving limited data from 
the datamart. The report output has a torn border at the top and bottom 
of your report.

Preview with no Data Select this option to preview your reports with no data. The system 
displays junk characters in the report and the datamart is not queried at 
all.

View in PDF Format Select this option to save a snapshot of your report data in PDF format. 
Select Specify PDF Options to set the display options for the PDF 
output.

View in Excel Single 
Sheet Format

Select this option to save a snapshot of your report data in a single 
datasheet in XLS format.

View in Excel Format Select this option to save a snapshot of your report data in XLS format.

View in CSV Format ·Select this option to save a snapshot of your report data in comma 
separated values (CSV) format.

View in XML Format ·Select this option to view list reports in XML format. You cannot view 
charts or a crosstab reports in XML format.
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The sections that follow explain how to save reports and access saved reports.

Saving Reports
Use the following procedure to save a report.

1. Select the Manage File menu option in the left frame. The options for saving the 
report appear.

2. Select the Save from the Manage File menu options. The Save As section appears 
below the report output in the right frame.

3. Enter the report name in the Name text box.

4. Enter the report description in the Description text area.

5. In the Screen tip text box, enter the screen tip text that should appear when a user 
points at the report in the Report Writer interface.

6. Select a Location option button to specify the location where the report needs to be 
saved:
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■ Select the Public Folders > Report Writer option button if you want all users 
to be able access the report

■ Select the My Folders option button if you wish to save the report as a 
personal document.

Saving a Report in a New Folder  
Use the following procedure to save a report in a new folder within Public Folders > 
Report Writer or My Folders

1. Select the Select Another Location link. The Select a Location section appears.

2. Select the Public Folders or My Folders tab and click the New Folder link.

3. Specify the name, description, and screen tip for the new folder and click Finish.

4. Click OK to save the report in the location you specified.

Accessing Report Writer Library
The reports you save can be accessed from the Report Writer Library. Use the 
following procedure to open the Report Writer Library, select Case Series Reports > 
Report Writer > Library in Argus Insight. My Folders is the default location that 
appears when you open the Report Writer Library. All the reports you save as personal 
documents are listed in the My Folders location.

To view the reports saved as public documents select the Public Folders tab. You can 
navigate the public folders and display the desired report.

To run the saved report, check the checkbox next to the report name and click the Run 
icon . If there are any filtering prompts associated with the report, they are displayed. 
Specify the prompt values and click OK to view the report output.

You can edit a saved report by clicking the report name. The report opens in the Query 
Studio interface. After you edit the report, you can save it by another name by using 
the Save As option in the Manage Files menu.

Using SMQs in Report Writer
If a user selects an SMQ, all the cases based on that SMQ are displayed. The following 
section explains how to use SMQs in report writer.
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Using SMQs

Use the following procedure to use SMQs in report writer.

1. Go to Case Series Reports > Report Writer > New. The following window is 
displayed.

2. In the left frame, expand the Report Writer control tree. The various datamart 
views are displayed.
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3. Under Events - Event Information, either double-click Event SMQ (Broad) or 
drag-and-drop it to the right pane.
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4. Perform a similar operation as shown in the above step for Event SMQ (Narrow). 

5. Under Events - Event Information, either double-click Case Number or 
drag-and-drop it to the right pane. This displays all the case numbers that 
correspond to the selected SMQ.

Using Case Annotations
The term Case Annotation means the addition of notes to a case. An annotated case 
makes for better understanding about the case, due to the presence of notes added to 
describe anything relevant and important about the case. 

Users can annotate cases within a case series as shown in the first row of the Notes 
column below.

The Annotate option for a case allows you to add a Note field for the respective case. 
This note is saved with the case series, and gets copied to a new case series if the case 
series where it was created is also copied.

While entering the notes, ensure that you do not exceed 200 characters. The note is 
then added through a context menu. 

The created note remains with a case if the case series has been subsetted. Once 
entered, a note is saved for the case series. This means that you do not need to 
explicitly save a case series to save the note entered in it.

This note is applicable for the case in only the same case series where it was saved. It is 
not applicable even for the same case, if the case is in a different case series. This note 
also gets exported to Microsoft Excel when the Export to Excel functionality is used.
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As shown in the following image, notes of a case series are retained when the case 
series merges with another case series. The text in the header "Notes from this series 
will be preserved in the merged case series" also displays the same.

A note can be frozen along with a frozen case series. Therefore, you cannot edit, add, 
or delete a note in a frozen case series. Similarly, if a user can access a case series, its 
corresponding notes can also be accessed and vice versa. 

To use notes in Advanced Conditions, go to Case Series > Cases > Case Annotations. 
This field is a free hand text type field and supports single select only. 

This Note is not available in Argus Safety and does not impact the case series there. 

Using Case Annotations

Use the following procedure to use case annotations in report writer.

1. Go to Case Series Reports > Report Writer > New. The following window is 
displayed.

2. In the left frame, expand the Report Writer control tree. The various datamart 
views are displayed.
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3. Under Case Series, click Case Annotation.
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4. Click Insert. This displays all the case numbers that correspond to the selected 
SMQ.
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8Using Cubes

Using Cubes
A Cube is a data model that consists of dimensions and measures. The dimensions 
represent key reporting aspects in rows and columns headers of the data model. At the 
intersection of each row and column (a cell), the Cube shows a measure, such as case, 
report, or event count. In this version of Argus Insight, you access Cubes through the 
Cognos® Analysis Studio Web Explorer interface. The interface uses a web browser and 
provides access to available dimensions and measures.

Using cubes enables you to run complex queries by selecting various datamart fields 
as dimensions and display the output on the fly. You can also select the desired 
measures. Use the following procedure to display the exact data you require, you can 
add filters, add calculations, drill down hierarchical dimensions, and statistically 
analyze the measures. Cubes also let you explore the interactions between different 
dimensions by letting you nest dimensions.

Argus Insight lets you create demand Cubes (Cubes on the Fly) based on existing 
standard Cubes in Argus Insight. The difference between the two types of cubes is-

Standard Cubes: These cubes are built-on the entire database.

Demand Cubes: These cubes are built on only specific case series for the required data.

The structure of a demand Cube is similar to the structure of the standard Cube you 
select to build the demand Cube.

The following topics explain how to work with Cubes.

■ Cubes Available in Argus Insight

■ Creating Demand Cubes

■ Saving Cubes Views

■ Refreshing Cubes

Cubes Available in Argus Insight
Argus Insight provides five different Cubes grouped in categories to let you analyze 
your safety data from Compliance, Management and Pharmacovigilance perspectives.

Category Cube Name

Compliance Submission Statistics
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The dimensions available in a Demand Cube depend on the type of analysis that the 
Cube lets you perform. The following types of measures are available.

The sections that follow describe the various Cubes available in Argus Insight. For 
information on executing and working with Cubes, see theWorking with Cubestopic.

Compliance Cubes
The Compliance category consists of the Submission Statistics Cube

Submission Statistics
The Submission Statistics standard cube can be generated only for cases that have an 
initial or follow-up date within the last 365 days. The Submission Statistics cube lets 
you explore these dimensions:

Management Administration Statistics

Pharmacovigilance Clinical Trial Analysis

Medical Analysis

Overdose-Pregnancy-Interaction

Measures Available in

Case Count All Cubes in Pharmacovigilance, Management and Compliance 
categories.

Case Version Count Available in Management category, Administration Statistics 
Cube.

Record Count Available in Compliance category, Submission Statistics.

Event Count Available in Pharmacovigilance and Management categories.

Case Creation Date Year (YYYY) Quarter 
(Q1, Q2, Q3, Q4) Month

Reporting Destination Country of Agency Agency

Dom/Frgn Country of incidence 
Domestic/Foreign indicator (Country of 
Incidence = Country of Agency or not)

Initial / Follow-up Initial Follow-up Significant or 
Not
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Management Cubes
The Management category consists of the Administration Statistics Cube.

Administration Statistics
The Administration Statistics cube lets you explore these dimensions:

Receipt Year Year (YYYY) Quarter (Q1, Q2, 
Q3, Q4) Month

Submission Indicator 
(Not-Required/Non-Blank/Blank Submission Date) 
Submission Year Month

StudyProtocol Number Study Number 
Center Number

Report Type: (SR/LIT/CT/PMS- based on derivation 
rule)

Reporter Type (HCP/Non-HCP/Unknown) 
(Primary Reporter only)

Intermediary

Fatal/LT: Fatal/LT indicator (Any event with 
Death or LT)

Case Seriousness (Serious/Non-Serious)

Case Outcome (Died/Improving/…) Case Causality (Related / Not Related)

Case Listedness (Listed / Unlisted / 
Unknown)

Case Listedness Notes

Elapsed Time to Submission(Aware): Time to 
Submission

Elapsed Time to Submission(Generated): Time to 
Submission

Case Creation Date Year (YYYY) 
Quarter (Q1, Q2, Q3, Q4) Month

Country of Incidence: Country of incidence

Initial / Follow-up: Initial 
Follow-up Significant or Not

Receipt Year Year (YYYY) Quarter (Q1, Q2, Q3, Q4) 
Month

Study Protocol Number Study 
Number Center Number

Report Type: (SR/LIT/CT/PMS- based on 
derivation rule)
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Pharmacovigilance Cubes
Pharmacovigilance (PV) Cubes let you perform data mining for cases based on events, 
medical history, cause of death, and other key indicators. The Pharmacovigilance 
category has three Cubes: Clinical Trial Analysis, Medical Analysis and 
Overdose-Pregnancy-Interaction.

Clinical Trial Analysis
The Clinical Trial Analysis Cube can be generated only for clinical trial cases and 
enables you explore these dimensions.

Case Seriousness 
(Serious/Non-Serious)

Case Outcome (Died/Improving/…)

Case Causality (Related / Not 
Related)

Case Listedness (Listed / Unlisted / Unknown)

Case Listedness Notes Product Family: Family Name (Primary Suspect 
Drugs)

Time to Entry (In days, based on 
derivation rule)

Time to Central Receipt

Time to Lock Lock Date Lock Year Lock Month

Blinding Status: Unblinded Status 
(Blinded / Broken by sponsor / 
Broken after study / Open Label 
Trial / Not Blinded)

Site: Master owned by Site

Workflow Status Workflow Group Workflow group User Name

Initial Receipt Date Year (YYYY) 
Quarter (Q1, Q2, Q3, Q4) Month

Report Type: (SR/LIT/CT/PMS- based on 
derivation rule)

Country of Incidence Age Group

Gender Relevant History: Description PT

Events: (all events) SOC HLGT HLT 
PT LLT

Case Seriousness (Serious/Non-Serious)

Case Listedness (Listed / Unlisted 
/ Unknown)

Case Causality (Related / Not Related)

Case Outcome 
(Died/Improving/…)

Leading Event/Diagnosis: Diagnosis (Yes/No)

Event Seriousness: (Yes/No) Event Death: (Yes/No)
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Medical Analysis
You can generate the Medical Analysis standard cube only for Priority Drugs as 
configured by the administrator. The Medical Analysis Cube lets you explore these 
dimensions.

Event LT: (Yes/No) Event Hospitalized: (Yes/No)

Event Disability: (Yes/No) Event Congenital Anomaly: (Yes/No)

Event Medically Significant: 
(Yes/No)

Conservative Event Causality Conservative 
Event Causality (Derived field for the Study 
Drug)

Event Listedness Event Listedness 
(for the Administered/Blinded 
Drug and Datasheet with Name 
"IB")

Study Drug: (Investigational Products) Family 
Name Study Number Center Number

Administered Drug Family Name 
or "Blinded" <Drug> (Administered 
Drug or "Blinded")

Drug Type: (Suspect / Concomitant / Treatment)

Additional Products (only WHO 
Drugs) Chemical subgroup: ATC 
Code Pharmacological subgroup: 
ATC Code (ATC Text) <WHO Drug 
Name> (Preferred Term)

Blinding Status: Unblinded Status (Blinded / 
Broken by sponsor / Broken after study / Open 
Label Trial / Not Blinded)

Treatment Duration - Hours Treatment Duration - Days

Treatment Duration - Weeks Treatment Duration - Months

Treatment Duration - Years Daily Dose Daily Dose

Route of Administration: Route of 
administration

Time to Onset from First Dose - Hours

Time to Onset from First Dose - 
Days

 Time to Onset from First Dose - Weeks

Time to Onset from First Dose - 
Month

Time to Onset from First Dose - Years

Time to Onset from Last Dose - 
Hours

Time to Onset from Last Dose - Days

Time to Onset from Last Dose - 
Weeks

Time to Onset from Last Dose - Months

Time to Onset from Last Dose-Years

Initial Receipt Date Year (YYYY) 
Quarter (Q1, Q2, Q3, Q4) Month

Report Type (SR/LIT/CT/PMS- based on 
derivation rule)
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Overdose-Pregnancy-Interaction
The Overdose-Pregnancy-interaction standard cube can be generated only for cases 
where at least one of the following fields is mentioned: Overdose Interaction 
Pregnancy Lack of Efficiency.

Reporter Type 
(HCP/Non-HCP/Unknown)

Country of Incidence

Age Group Gender

BMI ( as per Derivation Rule) Relevant History: Description PT

Events: (all events) SOC HLGT HLT 
PT LLT

Case Seriousness (Serious/Non-Serious)

Case Causality (Related / Not 
Related)

Case Outcome (Died/Improving/…) (Died is a 
derived value based on derivation rule)

DechallengeResult 
(Pos/Neg/NA/Unk)

RechallengeResult (Pos/Neg/NA/Unk)

Leading Event/Diagnosis: Diagnosis 
(Yes/No)

Event Seriousness: (Yes/No)

Event Death: (Yes/No) Event LT: (Yes/No)

Event Hospitalized: (Yes/No) Event Disability: (Yes/No)

Event Congenital Anomaly: (Yes/No) Event Medically Significant: (Yes/No)

Conservative Event Causality: 
Conservative Event Causality

Event Listedness: BPI Event Listedness (for all 
Company suspect drugs and Datasheet with Name 
"BPI")

Company Product: Family Name 
Product Name

Drug Type: (Suspect / Concomitant / Treatment)

Additional Products (only WHO 
Drugs) Chemical subgroup: ATC 
Code Pharmacological subgroup: 
ATC Code (ATC Text) <WHO Drug 
Name> (Preferred Term)

Treatment Duration - Hours

Treatment Duration - Days Treatment Duration - Weeks

Treatment Duration - Months Treatment Duration - Years

Daily Dose: Daily Dose Indication: (for Company Suspect Drugs) 
Indication (for Company Suspect Drugs)

Route of Administration: Route of 
administration

Time to Onset from First Dose - Hours

Time to Onset from First Dose - Days Time to Onset from First Dose - Weeks

Time to Onset from First Dose - 
Month

Time to Onset from First Dose - Years

Time to Onset from Last Dose - 
Hours

Time to Onset from Last Dose - Days

Time to Onset from Last Dose - 
Weeks

Time to Onset from Last Dose - Months

Time to Onset from Last Dose - Years
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The Overdose-Pregnancy-Interaction Cube lets you explore these dimensions.

Initial Receipt Date: Case Creation 
Date Year (YYYY) Quarter (Q1, Q2, Q3, 
Q4) Month

Age Group

Gender BMI (As per Derivation Rule)

Relevant History Events: (all events) SOC HLGT HLT PT LLT

Case Listedness: (Listed / Unlisted / 
Unknown)

Case Outcome: (Died/Improving/…)

Leading Event/Diagnosis: Diagnosis 
(Yes/No)

Event Seriousness: (Yes/No)

Event Death: (Yes/No) Event LT: (Yes/No)

Event Hospitalized: (Yes/No) Event Disability: (Yes/No)

Event Congenital Anomaly: (Yes/No) Event Medically Significant: (Yes/No)

Event Outcome (Fatal/Improving/…) · Event Listedness BPI Event Listedness (for all 
suspect drugs and Datasheet with Name 
"BPI")

Company Product Family Name 
Product Name

Drug Type: (Suspect / Concomitant / 
Treatment)

· Additional Products (only WHO 
Drugs) Chemical subgroup: ATC Code 
Pharmacological subgroup: ATC Code 
(ATC Text) <WHO Drug Name> 
(Preferred Term)

Daily Dose Daily Dose

Indication: (for Company Suspect 
Drugs) Indication (for Company 
Suspect Drugs)

Route of Administration: Route of 
administration

Time to Onset from First Dose - Hours Time to Onset from First Dose - Days

Time to Onset from First Dose - Weeks Time to Onset from First Dose - Month

Time to Onset from First Dose - Years Time to Onset from Last Dose - Hours

Time to Onset from Last Dose - Days Time to Onset from Last Dose - Weeks

Time to Onset from Last Dose - 
Months

Time to Onset from Last Dose - Years

Overdose (as per Derivation Rule) Interaction (as per Derivation Rule)

Pregnancy (as per Derivation Rule) Lack of Efficacy (as per Derivation Rule)
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Working with Cubes
This section provides information about using and executing Cubes. Be aware, 
however, that this section only discusses the basic features of Standard and Demand 
Cubes. For detailed information, refer to the documentation supplied with the 
Cognos8 products.

Refer to the section onCreating Demand Cubesfor detailed information on creating 
Demand Cubes

Executing a Cube
Use the following procedure to execute a Cube.

1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays 
all the built-in Cubes in Argus Insight and the Demand Cubes which the group 
users have created.

2. Select the Cube you wish to execute.

3. Click Execute. A separate Analysis Studio Explorer window displays the option to 
view the cube in either the Default Analysis or Blank Analysis state.
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4. Select Default Analysis to view the Cube in the interface similar to the one shown 
in the following figure.

The left frame of the Cognos Analysis Studio Web Explorer window displays the 
available dimension categories (reporting aspects) in a tree hierarchy.

The Measures folder in the tree structure contains the available measures for the Cube. 
The report output area in the right frame displays the Cube structure, which is similar 
to a crosstab report. The dimensions from the first two categories appear as rows and 

Tip: Alternatively you can select the Blank Analysis option. This is 
useful when you want to select the Cube dimensions and measures 
based on your analysis requirements.

The Default Analysis option is helpful when you need to perform 
Cube analysis on the default dimensions and measures displayed in 
the Cube.
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columns in the Cube, respectively. Use the following procedure to explore dimensions 
from other available categories, you can replace the existing dimensions in the Cube or 
nest other dimensions with the existing dimensions. You can also filter the output or 
drill down the dimensions in the Cube to display specific data.

The sections that follow explain the basic Analysis Studio Web Explorer options that 
let you work with Cubes.

Performing Drill Operations
You can drill-down and drill-up hierarchical dimensions to explore different aspects of 
your work and to move between levels of information. You can drill-down and 
drill-up multiple levels at a time. When you drill-down on a dimension that groups 
other dimensions in a row or column, some information may be removed from the 
Cube. For example, in a Cube that shows years and quarters asgrouped dimensions, 
drilling down on a specific year removes the redundant years levels.

An example to demonstrate the drill functionality follows.

Use the following procedure to drill down to the next level in a hierarchical 
dimension, such as Product.

1. Click in the area between the top-left cell (measure cell) and the first header cell of 
the dimension row/column as shown in the following figure.

2. Click the Down a Level icon in the context menu that appears. The Cube output 
changes to display the data for all the next level dimensions.

3. If the dimension has another lower level, you can drill down further by 
performing step 2.

4. While the above steps let you display the data for all the lower levels for all the 
products, you may change the reporting focus by only displaying the lower-level 
data for a specific product. Use the following procedure to do this, simply click on 
the dimension in the Cube output.
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Filtering Data
You can select a dimension to filter a Cube in order to reduce the data displayed in the 
Cube output. Unlike thedrilloperation, filtering does not change the existing Cube 
layout. Instead, it changes the measure values displayed in the Cube output according 
to the dimension you select as the filter. An example follows.

In the Medical Analysis Cube, the default row dimensions are from the Initial 
Receipt Date category and the default column dimensions are from the Report Type 
category. At the intersection of each row and column dimension the Cube displays the 
total Case Count. However, instead of viewing the total Case Count for the existing 
dimensions, you may wish to view the Case Counts for a specific country of incidence.

1. While the Medical Analysis Cube is open, the left panel in the Analysis Studio 
web browser window lists all the dimension categories available for the Medical 
Analysis cube.

2. Drag and drop Country of Incidence > Canada, from the left-panel into the 
Context drop-down list as shown in the following figure.
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3. While the layout of the Medical Analysis Cube remains the same, the data in the 
Cube output changes to display the measure values specific to the selected 
country. Additionally, the Context drop-down displays Canada to indicate that the 
Cube output is filtered by the Canada dimension.

4. You can filter the output further by selecting another dimension as the filtering 
criterion.

Removing the Filter
You can eitherresetthe Cube output or click the undo icon or in the Context drop-down 
list, right click to view the delete option. For example, to remove the filter described in 
the example above, select Country of Incidence>Canada in the Context drop-down 
and click Delete.

Replacing Rows and Columns
You may want to replace the existing row or column dimensions with dimensions 
from another category to observe the interaction between dimensions from different 
categories. Use the following procedure to do this, you can drag a category or a 
dimension from the left-panel of the Cognos Analysis Studio Web Explorer window 
into the middle of any header cell of the column or row you want to replace. An 
example follows.

In the Medical Analysis Cube, the default row dimensions are from the Initial 
Receipt Date category and the default column dimensions are from the Report Type 
category.
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Use the following procedure to replace the existing row dimensions.

1. With the Drug Type dimensions , select and drag the Drug Type dimension from 
the left panel to the middle of any row header cell in the Cube.

2. The existing row dimensions in the Cube are replaced with the Drug Type 
dimension.

Similarly you can replace the existing column dimensions with other dimensions. 
You can also replace the existing row/column dimensions with a single category 
from a dimension by dragging the category from the left panel into the middle of a 
row/column header cell.

Grouping Multiple Rows and Columns by a Dimension or Category
You can have multiple rows and columns in a Cube by dragging additional entities 
(dimensions or categories) from the tree structure into the Cube. When you add a new 
entity to a Cube, the output is automatically grouped to let you view data easily. Row 
grouping happens by the leftmost row entity and column grouping happens by the 
topmost column entity.
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Obtaining a New Row Grouping  
Select an entity from the tree structure in the left frame of the Analysis Studio Web 
Explorer window and drag it into the left or right edge of the row header area within 
the Cube.

The Cube output refreshes to show the grouping depending on the edge of the row 
header area where you dragged the new entity. 

Obtaining a New Column Grouping  
Use the following procedure to obtain a new column grouping.

1. Select an entity from the tree structure in the left frame of the Analysis Studio Web 
Explorer window.

2. Drag the entity to the upper or lower edge of the column header area in the Cube.

3. The Cube output refreshes to show the grouping depending on the edge of the 
column header area where you dragged the new entity. 
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Removing a Dimension Row from a Cube  
Use the following procedure to remove a dimension row from a Cube.

1. Click in the white space between the top-left cell (measure cell) and the first 
header cell of the dimension row.

2. In the context menu that appears, click the Delete icon to delete the dimension 
row.

Removing a Dimension Column from a Cube  1.
Click in the white space area between the top-left cell (measure cell) and the first 
header cell of the dimension column.

2. In the context menu that appears, click the Delete icon to delete the dimension 
column.

Creating Charts
You can display a Cube as a chart to graphically see patterns and trends in data.

1. Perform the necessary operations on the Cube to get the desired reporting focus.

2. Click the arrow next to the Chart icon on the Analysis Studio Web Explorer 
toolbar. A context menu displays the available chart types.
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3. Select a chart type from the context menu, as appropriate. The report output 
refreshes; the chart is displayed.

Swapping Rows with Columns

You may want to swap the rows with columns in a Cube that has few rows and many 
columns. This improves the readability of the Cube output.

Use the following procedure to interchange rows and columns in a Cube, click the 
Swap icon on the Analysis Studio Web Explorer toolbar. If there are multiple/grouped 
rows or columns in the Cube, the outermost rows become the outermost columns, and 
the outermost columns become the outermost rows.
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Exporting the Cube Output to Specific Formats
You can export the Cube output to formats, such as PDF, XLS, CSV and XML and save 
the file on the local machine.

1. Perform the necessary operations on the Cube to get the desired reporting focus.

2. If required, change the Cube layout to a crosstab or chart ,as appropriate .

3. Click Run in the Analysis Studio Web Explorer toolbar. A context menu displays 
the available export options.

4. Select the desired run option. The file appears in the selected format in a new 
window.
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Changing Measures
The reporting focus of Cubes that have multiple dimensions available can be changed 
by replacing an existing measure within the Cube with another measure. For example, 
Pharmacovigilance Cubes have both Case Count and Event Count as available 
measures. While the default measure displayed in these Cubes is Case Count, you can 
replace it with Event Count to change the reporting focus.

1. In the left panel displayed in the Analysis Studio Web Explorer window, select 
Measures. The measures available for the Cube are displayed.

2. Click and drag the category required under Measure. Alternatively you can also 
right-click the measure in the cross-tab output and select the required option.
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3. The crosstab output is refreshed; Event Count is the new measure added to the 
Medical Analysis Cube.

Modifying a Cube
Use the following procedure to modify a cube.

1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays 
all the built-in Cubes in Argus Insight and the Demand Cubes which the group 
users have created.
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2. Select the required Cube and click Modify.

3. The Modify cube interface appears. This interface helps you to capture 
information to modify the Demand Cube.

■ Expiration Date informs you about the expiration date of the cube. You are 
notified when the expiry date is due and you can save or delete the existing 
cube as per preference. This field is visible only for Demand cubes.

■ Initial Creation Date captures the date when the Cube was loaded in the 
repository for the first time.

■ Modify Date captures the date when the Cube was last modified.

■ ETL Run captures the date of ETL run on which the case data is based. This 
field is visible only for demand cubes. This field is visible only for Demand 
cubes.
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■ Case Series captures the name of the case series on which the cube was built. 
This field is visible only for Demand cubes.

Deleting a Cube
Use the following procedure to delete a cube.

1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays 
all the built-in Cubes in Argus Insight and the Demand Cubes which the group 
users have created.

2. Select the required Cube and Click Delete.

3. The Delete cube confirmation dialogue appears. Click OK to confirm the 
operation.

Setting Access Permissions
You can set group-level access permissions for the Demand Cubes. This determines 
which user groups will be able to view, modify, or delete a Demand Cube.

Use the following procedure to set Demand Cubes permissions.

1. In the Argus Insight page, select the Datamart Reports > Cubes > All.

2. Click Permissions. The Permissions dialog box appears. A list in this dialog box 
displays the names of all the groups (except the Administrator group) that the 
system administrator has created.

Note: Standard Cubes cannot be modified/deleted.

Note: You can set permissions only on Demand Cubes you have 
saved to the system.
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3. Use the list box next to a group name to assign permissions to the group members 
on the Demand Cube you have selected. You can select from these options:

4. Click OK. The system saves the permission settings.

Creating Demand Cubes
Argus Insight lets you create demand Cubes based on existing standard Cubes in 
Argus Insight. The structure of a demand Cube is similar to the structure of the 
standard Cube you select to build the demand Cube. For more information on 
performing operations on Cubes refer to the section onWorking with Cubes.

Demand Cubes are based on a specificCase Seriesinstead of the entire datamart. 
Therefore, you can use demand Cubes to analyze a reduced data set based on a 
specific Case Series and quickly obtain the desired reporting focus without having to 

Permission Description

No Access (Default) No group members will be able to access the Case Series

Full Access You can modify/delete/view the Cube
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drill down or filter data. However, this feature makes the demand Cubes static, which 
means that each time the Case Series is modified, you need to delete the demand Cube 
and create a new one.

1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays 
all the built-in Cubes in Argus Insight.

2. Select the standard Cube using which you wish to create the demand Cube. The 
Cube name is highlighted; the Build button becomes active.

3. Click Build. The Cube Properties dialog box appears.

4. Enter the demand Cube name in the Cube Name text box.

5. Enter the demand Cube description in the Description text area.

6. Use the Case Series list box to select the Case Series on which you want to create 
the demand Cube. The description of the selected Case Series appears in the 
associated Description text area.

7. Click Build Cube. The Cubes - Build dialog box notifies you that the Cube has 
been scheduled for generation on the Cognos8 server.
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8. Click OK. The Cubes page displays the demand Cube name in grey.

9. When the Cognos8 server generates the demand Cube, the Cubes Generated 
dialog box notifies you. After the Cube is generated, you can execute it by 
selecting the Cube name and clicking Execute.

Demand Cube Life Span
Demand Cubes have a limited life span on the system. The system deletes the demand 
Cube after 14 days (default) from the date of creation. You can configure the 
Cube-on-the-fly Lifespan list maintenance item to set the expiration period.

When the demand Cube has reached the expiration date, the system notifies you 
through the following dialog box.

Note: The maximum number of cases for creating Demand Cubes is 
configured on the List Maintenance items.
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At this point, you can either delete the demand Cube or retain it for another 14 days 
(default).

Saving Cubes Views
This section describes the procedure to save Cube views (based on the drilled-down 
data).

Use the following procedure to save Cube views.

1. Click Datamart Reports->Cubes All to view all the cubes

2. Select the Cube view that you want to save. The name of the cube is highlighted.

3. Click Execute. The Cognos Analysis Studio web explorer is displayed.

Tip: You can also search for specific Cubes by using any of the search 
options displayed on the screen.
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4. Perform the desired drill through operation. The cube view is displayed.

5. From the File menu, click Save. The Save As dialog appears.

6. Select My Folders>CubeViews to save the cube view in the CubeViews folder.
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7. Enter and save the Name of the Cube view. The Cube view is now saved.

Viewing Saved Cubes
Use the following procedure to view the saved Cube view.

1. Click on Datamart Reports ->Cubes -> Library option. The Cube view name 
appears in the list of cubes saved in the library.

The Cube views can only be viewed by the owner or author of the Cube View.

Refreshing Cubes
Although the ETL process updates the datamart on a regular basis, you need to 
separately update each Cube after the incremental ETL process is completed. Use A 
batch process needs to be set up to update the Cubes installed as part of the Argus 
Insight application. The batch process performs the following tasks:

■ Updates Cube data- the data in the Cube is updated with the latest data from the 
datamart

■ Copies the updated Cubes in the backup folder- the updated Cubes are copied 
into a backup folder that contains subfolders for each Cube; the backup folder 
path is: <Argus Insight Installation 
path>\PowerReports\cognos\backup\PPESCubesFor example:C:\Program 
Files \Relsys\PowerReports\Cognos\backup\PPESCubes

■ Copies the updated Cubes in the published folder - the updated Cubes are copied 
into the published folder at this location: <Argus Insight Installation 
path>\PowerReports\cognos\PPESCubes For example: C:\Program 
Files\Relsys\PowerReports\Cognos\PPESCubes

Individual tasks need to be scheduled to update each Cube. Use the following 
procedure to improve the performance of the batch process, make sure that 
individual batch execution processes do not overlap with each other.

Tip: If the CubeViews folder is not visible, create the CubeViews 
folder by clicking on the create new folder icon.

When naming the folder, do not leave a space between the letters.

Note: Standard Cubes: If the data mart has been updated since the 
last saved view, the information displayed within the cube will reflect 
the updated data as the view of the Cube is saved.

Demand Cubes: If the data mart has been updated since the last 
saved view, the information displayed within the cube will remain 
static as it is based on static case series.
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Setting up Batch Generation through Task Manager  
This section provides instructions for scheduling batch generation using Windows 
Task Manager. You must perform this procedure for each of the five Cubes.

1. On the Cognos8 Server, select Start > Settings > Control Panel. The Control Panel 
window appears.

2. Double-click the Scheduled Tasks item. The Scheduled Tasks window opens.

Note: Demand Cubes are refreshed sequentially.
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3. Double-click the Add a Scheduled Task item. The Scheduled Task Wizard starts.

4. Click Next. The next screen of Scheduled Task Wizard appears.
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5. Click Browse. The Select Program to Schedule dialog box appears.

6. Navigate to the following location: <Argus Insight Installation 
Path>\PowerReports\Cognos\Cubes\BatchGeneration-Cubes

7. Select the Cube_Generation_Driver.bat file.

8. Click Open. The next screen of Scheduled Task Wizard appears.
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9. In the text box for entering the task name, type Cube Generate 1. The task name 
should be entered in the format Cube Generate <Cube ID>. The Cube IDs are 
listed in the table below.

10. Use the Perform this task option button group to set the frequency of the task, as 
appropriate.

11. Click Next. The next screen of Scheduled Task Wizard appears.

Cube Name Cube ID

Medical Analysis 7

Clinical Trial Analysis 8

Overdose-Pregnancy-Interaction 9

Submission Statistics 10

Administration Statistics 11
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12. Set the start time and day.

13. Click Next. The next screen of Scheduled Task Wizard appears.

14. Enter the user name and password of the user authorized to run this task.

15. Click Next. The next screen of Scheduled Task Wizard appears.

16. Check the Open advanced properties for this task when I click finish checkbox.

17. Click Finish. The dialog box for setting advanced properties for the task appears.
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18. In the Run text box within the Task tab, enter the run-time parameter for this task 
in p[the following format: <Argus Insight Installation 
Path>\PowerReports\Cognos\Cubes\ BatchGeneration-Cubes\Cube_
Generation_Driver.bat" <Cube ID> <Cognos user name> <Cognos password> 
where CubeID is the ID of the Cube for which you are scheduling the batch 
generation, Cognos user name is the user name of the Cognos admin user, and 
Cognos password is the password for the Cognos admin user. Include the double 
quotation marks (" ") while entering the runtime parameter. The following table 
lists the Cube ID for each cube and provides examples of the run-time parameter 
to be entered.

19. Click Set Password. The Set Password dialog box appears.

Note: The Cognos administrator password is blank in the following 
examples. To reset the Cognos login password, the administrator 
should log in to Argus Console, uncheck the LDAP authentication, 
reset the password, and save the change.
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20. Enter the password for the Cognos8 Server admin user.

21. Click OK.

22. Select the Schedule tab. The Schedule tab page appears.

23. Set the schedule options, as appropriate.

24. Select the Settings tab. The Settings tab page appears.
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25. In the Scheduled Task Completed and Power Management sections, set the 
options as shown in the figure above.

26. Select the Security tab. The Security tab page appears.

27. Verify that the user has full permissions assigned.

28. Click OK. The system creates the new scheduled task Cube Generation 1. Repeat 
the above steps to schedule batch generation for the remaining cubes.
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9Multi Tenancy

This chapter describes the Argus Insight features that are specifically applicable 
during multi-tenancy. These features have been listed and elaborated further in the 
following sections.

Assumptions and Constraints
This section lists the following assumptions and constrains with which the Argus 
Insight application works:

■ Single Sign On: SSO needs to be enabled to have the capability to switch client 
context and to open Argus Insight application from the Application Access Portlet.

■ Accessing Argus Insight directly via URL: It is expected that the customer will 
pass the internal Enterprise ID as a URL parameter for the Argus Insight 
application to open with the appropriate Enterprise context. If Enterprise ID is not 
passed, the user shall be validated against the default enterprise.

■ Global User Management: In order to apply updates to the "Synchronizable" fields 
to all the enterprises in the system, a customer should maintain some 
administrative users with the Argus Insight 'Admin Tools' Security tab 'Groups' 
Group Administration: Administration: Users: Modify User Accounts access 
enabled for all enterprises in the system.

■ User-Enterprise Association: When a user is copied from one enterprise to another, 
it is expected that the customer has set up the appropriate user groups in the target 
enterprise. Otherwise the user-association will fail with the appropriate error 
message.

■ New User creation/association: Argus Insight allows same UserID to be used to 
create different users across multiple enterprises. It is recommended that this 
feature shall only be used if users are not expected to be shared across enterprises. 
Otherwise, if users are expected to be shared across multiple enterprises, then 
same UserID shall not be used to create different users across different enterprises. 
Instead of that, a user created in one enterprise shall be associated to other 
enterprises through Global User Management.

■ New Enterprise Setup: It is expected that customer shall create and choose 
appropriate Enterprises with generic configuration data which can be used as 
source for copying the configuration data for creation of a new enterprises. The 
following is a list of items that the customer is recommended to ensure that the 
values being copied from the source enterprise are appropriate for the newly 
created enterprise:

a. Power Queries used within any configuration item
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b. Reports scheduling data

■ The following is the list of items that are common for all enterprises:

a. MedDRA and WHO dictionaries

b. Common Profile Switches ' Enable/disable LDAP 

c. Common Profile Switches ' LDAP Server configuration

d. Common Profile Switches ' Enable/disable SSO

e. Common Profile Switches ' SSO Header Configuration

f. Default Enterprise

■ Pre-Database Upgrade Considerations for existing customers:

a. It is required that Argus Safety be upgraded to 7.0 before starting the upgrade 
from Argus Insight 5.1 to 7.0.

■ Post-Database Upgrade Considerations for existing customers:

a. None.

Data Segregation
Having a system that can partition client data within a single, access-driven database 
significantly reduces operational and ownership costs for the client. Argus Insight 
achieves this objective through database segregation.

The entire Argus Insight application, including all its components and data, have been 
partitioned by an Enterprise ID. This ID is a unique, customer-specified identifier.

Module-wise Impact
The following table describes the modules in Argus Insight as per their data 
segregation status in Clinical Research Organization (CRO)-mode and hosting 
installations.

S. No. Module Data Segregation Notes

1 Power Query Yes Displays QBEs, Filters, and Advanced 
Conditions only for one enterprise at a 
time, to the logged-in user. The type of 
display is based on the selected enterprise. 

2 Case Series Yes It retrieves cases only from the logged-in 
Enterprise.

The Case Series library displays the case 
series belonging to the logged-in enterprise 
only.

3 Standard Reports Yes All the standard reports are available to all 
the enterprises.

An enterprise can configure reports from 
Admin Tools -> Security -> Group Access 
Rights tab of Argus Insight.

An executed report retrieves cases from the 
logged-in Enterprise.

4 Custom Reports Yes It displays all the reports that are set 
up/created by a specific enterprise.
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5 Report Writer Yes The Report Writer module displays only 
those reports that are created by the 
logged-in user (irrespective of the 
enterprise).

A report retrieves cases from the logged-in 
enterprise only.

6 Cubes No The Standard Cubes and demand cubes are 
not available in Insight 7.0 in CRO and 
Hosting mode.

The Standard Cubes are available in 
single-tenant installations of Insight 7.0.

The user can create demand cubes in single 
tenant installation of Insight 7.0

It is necessary that Cubes should not be 
configured in CRO and Hosting 
environment, because the Cubes 
functionality does not support data 
segregation.

7 Dashboards No The Dashboard function has been retired 
from the AI 7.0 application in CRO mode, 
as also from single-tenant installations.

8 MedDRA Dictionary and 
SMQ’s

No Each enterprise can configure a specific 
version of the MedDRA dictionary.

A single copy of each version is to be 
shared by the enterprises.

9 WHO Dictionary No Each enterprise can configure a specific 
version of WHO Drug dictionaries (B2 as 
well as C formats).

A single copy of each version is to be 
shared by the enterprises.

10 ETL No The ETL schedule is universal across all 
enterprises.

The Admin users having access to this 
portlet can view/modify the schedule.

When an enterprise is added to an existing 
CRO setup, the Initial ETL can also run for 
individual new enterprises.

The Initial/Re-Initial/Incremental ETL 
cannot be run in parallel at any point of 
time in the application.

11 Cognos No A Single Cognos server supports all the 
enterprises. 

On logging in to Cognos directly, a user can 
see all the common objects as well as the 
enterprise-specific objects which are 
accessible to the user. 

When a report is executed, the user can 
only access the cases for a specific 
enterprise only. 

Any report that a user has access to, can be 
executed against any enterprise data for 
which the user has access.

S. No. Module Data Segregation Notes
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Enterprise Short Name in Argus Insight
All the screens in the entire Argus Insight application and its components display, if so 
configured by the customer, the Enterprise Short Name. This is a unique, abbreviated 
name of a client in the header of the application.

The Display Enterprise Short Name in Application Header checkbox in Global 
Enterprise Management controls the display of the Enterprise Short Name.

If this checkbox is not checked, the Enterprise Short Name is not displayed in the 
header of the Argus Insight application.

If this checkbox is checked, the Enterprise Short Name is displayed in the Argus Safety 
header along with database name (<DB Name> - < Enterprise Short Name>) where < 
Enterprise Short Name> is the unique short name of the enterprise.

The Enterprise Short Name is also displayed in the window bar of the Argus Insight 
application.

Single Sign On
With Single Sign On (SSO), users’ log-in authentication is done using a centralized 
authentication system. With this, users do not need to enter their log-in credentials for 
each application they access, every single time.

When Argus Insight is configured for SSO, Cognos still uses the PowerReports 
namespace. This is the same implementation that already exists in the Argus Insight 
6.0 application.
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Login and Navigation
Clinical Research Organization (CRO) users can operate on only specific enterprises 
and not on all. User now have access to only certain Argus Insight modules.

Having a Single Sign On (SSO) login mechanism for the various modules that users 
have access to, and by providing navigation to these modules, simplifies the login, 
authentication and navigation process for a user. 

The ability to switch enterprises within the same session also provides significant 
usability benefits to the user.

Description
■ In multi-tenant installations, Global Homepage and Argus Insight application are 

two different applications that are available for end-users and CRO/Hosting 
administrators.

■ Both these web applications have separate web URLs, which can be accessed 
independent of each other.

■ When the user enters the URL of any of these web applications, the SSO module 
authenticates the user credentials and allows access to these applications without 
asking for any user credentials.

■ In case of Global Homepage, if the SSO authentication fails for the user, it displays 
an appropriate error message returned by SSO module to the end user.

■ In case of Argus Insight application, if the SSO authentication fails for the user, it 
displays an appropriate error message returned by SSO module to the end user on 
the regular Argus Insight login screen.

■ Users can access the Argus Insight application through:

a. Global Homepage > Application Access Portlet or Insight link in Argus Safety. 
In this scenario, the Argus Insight application opens in a separate browser 
window for the enterprise selected by the user in the Application Access 
Portlet, or as per the enterprise selected by the user in the Safety application.

b. In this scenario, Argus Insight does not display Argus Safety buttons on the 
top navigation bar. This is because the user is expected to access these 
applications from the Application Access Portlet from the Global Homepage. 
These applications are available to be opened in separate windows.

c. If the user clicks the Logout button in Argus Insight application, it closes 
Argus Insight and its child windows after prompting for saving any unsaved 
changes. The Global Homepage window is not affected at all by Argus Insight 
logout.

d. If the user clicks the Close button in Global Homepage application, it closes 
only the Global Homepage. The Argus Insight application window is not 
affected at all by Global Homepage logout.

e. If Argus Insight is defined as the default application in Argus Console for a 
user, then when the user tries to log in to Argus Safety application via direct 
Safety link, the Argus Insight application shall open. It shall display the Argus 
Safety button on the top navigation bar, based on whether the user has 
logged-in via SSO and has access to Argus Safety.
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■ Enterprise Switching:

a. Switching Enterprise context and opening Argus Insight application from 
Safety application or Application Access Portlet from the Global Homepage 
requires SSO to be enabled.

b. The system allows a user to open the Argus Insight application in a separate 
window with the context set to a specific active Enterprise from Safety and 
Application Access Portlet from the Global Homepage.

c. The user can switch the context to a different enterprise from the Global 
Homepage without logging out.

d. When the Argus Insight application is already opened for an enterprise, and 
when the user switches to a different enterprise from the Application Access 
Portlet, a message is displayed before switching.

■ Directly by using the Argus Insight application URL - Users can access Argus 
Insight directly by using the Argus Insight application URL. Argus Insight checks 
if Enterprise ID is already present in the request coming to it. If the Enterprise ID 
exists, it opens Argus Insight for that enterprise.

Changes to Power Queries and Case Series
The following changes have been made in the Argus Insight 7.0 release for Power 
Queries and Case Series. Power Queries include QBE’s, Filters, Filter Value Sets, and 
Advance Conditions.

■ A new Power Query/Case Series created and being saved stores the value of the 
Enterprise along with the other details:

a. The value for the Enterprise is derived from the logged-in Enterprise.

b. The Query and Case Series Libraries display only the Power Query/Case 
Series specific to the logged-in Enterprise.

c. The 'Active' function retrieves the active Power Query/Case Series for the user 
within the enterprise.

■ The Permissions on a Power Query/Case Series can be granted to the groups that 
belong to the currently logged-in Enterprise.

a. The Permissions pop-up displays the User Groups that are associated with the 
logged-in Enterprise.

■ The Power Query/Case Series created by users that are currently disabled or has 
been disassociated from the enterprise through which the Power Query/Case 
Series was created, are displayed in the respective library for users who have 
access to the respective Power Query/Case Series.

a. The Power Query/Case Series created by the users are deleted when the user 
is deleted.

■ When a Power Query is executed, it displays the cases from the currently 
logged-in enterprise only.

■ All the library screens of Power Queries and Case series display the data 
pertaining to the logged-in enterprise only.

Note: The Default Enterprise in Argus Insight is the same as the 
default enterprise configured in Argus Safety.
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Importing a Case Series
■ When a Case Series is imported, the system validates whether the cases being 

imported belong to the logged-in enterprise.

■ If the case does not belong to the current Enterprise, it is rejected and the log 
displays the value as 'Case Rejected' against the specific case number.

■ If the case belongs to the current Enterprise, the case series is imported into 
the system.

Modifying a Case Series
■ When a Case Series is modified to add a new case number, the system validates 

whether the cases being added belong to the logged-in Enterprise.

■ If the case does not belong to the current Enterprise, the case is not added and 
the existing message 'Case Number does not exist' is displayed.

■ If the case belongs to the current Enterprise, the case is added into the case 
series.

■ There are no changes while deleting a case from the case series.

■ Single Sign On: SSO needs to be enabled to have the capability to switch client 
context and to open Argus Insight application from the Application Access Portlet.

■ Pre-Database Upgrade Considerations for existing customers:

a. It is required that Argus Safety be upgraded to 7.0 before starting the upgrade 
from Argus Insight 5.1 to 7.0.

■ Post-Database Upgrade Considerations for existing customers:

a. None.

Exporting a Case Series

■ Single Sign On: SSO needs to be enabled to have the capability to switch client 
context and to open Argus Insight application from the Application Access Portlet.

■ Pre-Database Upgrade Considerations for existing customers:

a. It is required that Argus Safety be upgraded to 7.0 before starting the upgrade 
from Argus Insight 5.1 to 7.0.

■ Post-Database Upgrade Considerations for existing customers:

a. None.

When a Case Series is exported to an excel document, the Enterprise is included as 
part of the export details.

■ A new column named 'Enterprise' is added in a tab named 'Case Series 
Details'. The Enterprise Short name is displayed in this column value. The 
value for this column is derived from the currently logged in 'Enterprise'. 

■ The Enterprise short name is displayed in CRO, hosting and single tenant mode of 
installation.

■ The Enterprise column and its value is not displayed when the value to display 
the enterprise short name is 'Unchecked' or 'No' for the 'Display Enterprise Short 
Name in Application Header' column for the logged-in Enterprise.
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Importing a Case Series
When a Case Series is imported, the system validates whether the cases being 
imported belong to the logged-in enterprise. 

If the case does not belong to the current Enterprise, it is rejected and the log displays 
the value as ’Case Rejected’ against the specific case number.

If the case belongs to the current Enterprise, the case series is imported into the 
system.

Modifying a Case Series
When a Case Series is modified to add a new case number, the system validates 
whether the cases being added belong to the logged-in Enterprise. 

If the case does not belong to the current Enterprise, the case series is not added and 
the message ’Case Number does not exist’ is displayed.

If the case belongs to the current Enterprise, the case series is added into the case 
series. 

There are no changes while deleting a case from the case series.

Exporting a Case Series
When a Case Series is exported to an excel document, the Enterprise is included as 
part of the export details.

A new column called 'Enterprise' is added in a tab named 'Case Series Details'. The 
Enterprise Short name is displayed in this column value. The value for this column is 
derived from the currently logged in 'Enterprise’.

The Enterprise short name is displayed in CRO, hosting and single tenant mode of 
installation.

The Enterprise column and its value is not displayed when the value to display the 
enterprise short name is 'Unchecked' or 'No' for the 'Display Enterprise Short Name in 
Application Header' column for the logged-in Enterprise.

Global Homepage
This release of Argus Insight provides a Global Homepage that can host multiple 
portlets. With this feature, CRO users can now access different views of their work 
items for Argus Safety. 

A CRO can access the following modules from the Global Homepage:

Argus Insight application for different enterprises from the Application Access Portlet

Global Enterprise Management

Global User Management

Application Access Portlet
The Applications Access Portlet within the Global Homepage allows users to launch 
the Argus applications for an enterprise that they can access.

If you have access to both Argus Safety and Argus Insight, this portlet displays a 
drop-down list from where you can select between Argus Safety and Argus Insight.
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To access the application, select the required option(s) from the Enterprise and 
Application drop-down menus, and click Open, as shown above.

Global Enterprise Management Portlet
The Global Enterprise Management Portlet allows users to easily define and manage 
enterprises, as per the configuration of the already existing enterprises. This portlet is 
also part of the Global Homepage and is available only to those users who have been 
configured to access the Portlet.

This portlet allows you to do the following:

Copy the Enterprise created in Argus Safety to Argus Insight

Copy the Configuration data from an existing enterprise in Argus Insight

As shown in the following figure, the Global Enterprise Management portlet 
comprises two panes. 

Note: The Argus Insight module in this portlet can be available only 
when the Safety to Insight database link is set up in the database. 

If this link is not created, the Copy Enterprise to Insight button can 
not appear on the Global Enterprise Management screen. 

It is recommended that on clicking 'Copy Enterprise to Insight', the 
same enterprise should be selected as the source enterprise, with 
which the Argus Safety enterprise has been created.
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The left-hand pane lists all the enterprises of the portal user, in a tree-view structure. 
The right-hand pane is loaded, by default as blank, in disabled mode. 

When an enterprise from the left-hand pane is clicked, its details are displayed in the 
right-hand pane.

The following features and actions are applicable to this page:

Add New Enterprise in Insight

Click Add New Enterprise from the left-hand pane to create a new enterprise in 
Insight. 

Copy Enterprise to Insight

On clicking the Copy Enterprise to Insight button, a new pop-up is displayed as 
shown below, that allows you to enter detailed information about the enterprise that is 
being copied. This button is disabled for the default enterprise.

Note: A new enterprise can be created in Argus Insight only after the 
enterprise and its details are entered and saved in Argus Safety.
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When enterprise creation is completed for an enterprise, the Copy Enterprise to 
Insight button is disabled for that enterprise forever. This is because enterprise 
creation in Insight is a one-time operation.

The Setup button in this screen is enabled only after all the mandatory fields have 
been populated. This button copies all the configuration data from the enterprise 
selected from the drop-down list in the screen, under Copy Configuration Data 
Source.

Note: The Copy Enterprise to Insight button can be created in Argus 
Insight only after the enterprise and its details have been entered and 
saved in Argus Safety. 

The details in the Enterprise Name and Enterprise Short Name fields 
appear in read-only mode.



Common Profile Switches

Multi Tenancy 9-12

Once all the configuration data has been successfully copied, the user who is setting 
up the new Enterprise, is associated as a new user an Enterprise Manager, to the newly 
created Enterprise partition.

The user attributes of the user get copied from the source Enterprise.

Refer to the Argus Safety Administrator’s Guide for additional details about this 
portlet.

Global User Management Portlet
The Global User Management Portlet within the Global Homepage allows users to 
associate themselves to multiple enterprises, and also keep their user attributes 
consistent across all the enterprises.

All the Argus Insight users are created from Argus Safety Console only. Refer to the 
Argus Safety Administrator’s Guide for additional details about this tab. 

Common Profile Switches
None of the Cubes-related profile switch are available in the application for 
multi-tenant installation. 

All the Global-level switches are displayed, updated, and audit logged in the default 
enterprise.

From Argus Insight 7.0 onwards, two new enterprise-level profile switches, called 
’Cognos Enterprise Folder and Role Creation’ and ’Populate Study Reconciliation 
Report Table Data’ have been added.

To view or edit Profile Switches, log in to the Argus Insight application and select 
Admin Tools > List Maintenance tab > Profile Switches at the global (application) level 
or at the enterprise level, as mentioned in the table below:

S. No. Profile Switch
Enterprise-Level 
Switch Notes

1 POPULATE WHO Drug C 
DATA

Obsolete Not required from 7.0 onwards.

2 POPULATE 
INTERCHANGE DATA

Yes

3 POPULATE AFFILIATE 
DATA

Yes

4 POPULATE BLOB DATA No

5 POPULATE 
INTERCHANGE CLOB 
DATA

No

6 CUSTOM ROUTINE 
BEFORE INCREMENTAL 
ETL

No

7 CUSTOM ROUTINE 
AFTER INCREMENTAL 
ETL

No

8 POPULATE DLL SLL 
REPORTS TABLE DATA

Yes
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9 DOSE CATEGORY UNITS No Not required for Multi-tenant installation.

10 COGNOS NAMESPACE No    

11 COGNOS USER ROLE 
NAME

No    

12 SINGLE SIGN ON 
ENABLED

Obsolete The value should be consistent with the 
Argus Safety application.

13 SINGLE SIGN ON HTTP 
HEADER

Obsolete The value should be consistent with the 
Argus Safety application.

14 POPULATE NARRATIVE 
LANGUAGES TABLES

Yes  

15 POPULATE DATA 
QUALITY INDICATOR

Yes  

16 POPULATE RPT_REG_
REPORTS COLUMNS

Yes  

17 LOGO IMAGE Yes  

18 ALL CASES QUERY 
NAME

Yes  

19 MAXIMUM EMAIL 
ATTEMPTS

No  

20 COGNOS EXCEL 
VERSION

Yes  

21 SET REPORT PRE-FILTER 
POPULATION

Yes  

22 ETL DATA EXCLUSION No  

23 CONFIDENTIALITY 
TEXT

Yes  

24 DAYS TO LOCK Yes  

25 PASSWORD EXPIRATION Obsolete  

26 RESET PASSWORD Obsolete  

27 FOLLOW-UP ACTION 
CODE

Yes  

28 CAUSALITY 
ASSESSMENT. R

Yes  

29 CAUSALITY 
ASSESSMENT. C

Yes  

30 CAUSALITY 
ASSESSMENT. R+C

Yes  

31 CAUSALITY 
ASSESSMENT. UD FIELD

Yes  

32 COMPANY LOGO PATH Yes  

33 CUBE-ON-THE-FLY-LIFES
PAN

No Not required for Multi-tenant installation. 

34 DATASHEET PI Yes  

35 DATASHEET IB Yes  

S. No. Profile Switch
Enterprise-Level 
Switch Notes
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36 DATASHEET EMEA Yes  

37 DATASHEET BPI Yes  

38 REPORT PROMPTS Yes  

39 CIOMS 
MANUFACTURER

Yes  

40 MEDWATCH 
MANUFACTURER

Yes  

41 ALPHANUMERIC 
PASSWORD

Obsolete  

42 PASSWORD LENGTH Obsolete  

43 CUSTOM HELP URL Yes  

44 ARGUS INSIGHT SERVER No  

45 DATASHEET FLAG Yes  

46 MARKETED DATASHEET Yes  

47 INVESTIGATIONAL 
DATASHEET

Yes  

48 DATE DIFFERENCE 
BAND

No Not required for Multi-tenant installation. 

49 REPORTING TOOL No  

50 COGNOS CUBE 
PASSWORD

No Not required for Multi-tenant installation. 

51 COGNOS CUBE SERVER No Not required for Multi-tenant installation. 

52 COGNOS ADMIN 
PASSWORD

Yes  

53 COGNOS SERVER Yes  

54 COGNOS ADMIN USER Yes  

55 COGNOS REPORT 
WRITER MODEL

Yes  

56 COGNOS CUBE USER No Not required for Multi-tenant installation. 

57 COGNOS CUBE 
VERSION

No Not required for Multi-tenant installation. 

58 WHO DRUG BROWSER 
FORMAT

Obsolete  

59 ETL EMAIL SETUP No  

60 ETL EMAIL SENDER 
ADDRESS

No  

61 ETL EMAIL RECEIVER 
ADDRESS

No  

62 CASE REFERENCE TYPE 
ID

Yes  

63 ENABLE COMPANY 
HOLIDAY

Yes  

64 PRODUCT LOGO PATH Yes  

S. No. Profile Switch
Enterprise-Level 
Switch Notes
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ETL Scheduler
From Argus Insight 7.0 onwards, ETL Scheduler is a Role, added under Admin Tools > 
Security. It is available across all enterprises at a Global level.

The ETL Scheduler screen can be displayed, updated, and audit logged from the 
default enterprise in multi-tenancy. Only those users who have been assigned the ETL 
Scheduler role can view this screen.

Changes to Reports
This section lists the changes that are applicable from this release onwards, for Argus 
Insight reports. 

Report Changes in the Argus Insight User Interface
The Standard Reports Library displays all the reports configured in the Argus Insight 
application.

The Argus Insight administrator can assign enterprise-specific access rights (by 
enabling or disabling report access) to standard reports. This can be done from Admin 
Tools > Security > Group Access > Data Rights tab.

On being executed, the reports now display the Enterprise Short Name, along with the 
User ID in the footer of the report output, in both PDF and Excel formats.

Report Changes in the Cognos Environment
Users can log into the Cognos environment after specifying an enterprise with their 
user credentials. If no enterprise is mentioned while logging in, the default enterprise 
is assigned to the user.

A set of standard reports are available in the ’Argus Insight’ folder, which is common 
across all enterprises. Users have write-access to this folder.

65 REPORT FOOTER LOGO 
PATH

Yes  

66 UDN Column for 
SUPPLIER NAME

Yes  

67 DELAY IDENTIFIER Yes  

68 POPULATE CUBES FACT 
DATA

No Not required for Multi-tenant installation. 

69 POPULATE PERCEPTIVE 
DATA

Obsolete Not required from 7.0 onwards. 

Note: The Enterprise Short Name is not displayed if the value to 
display the enterprise short name is 'Unchecked' or is set as 'No' for 
the logged-in enterprise. The Enterprise Short Name will also not get 
displayed in the footer of the report output for CIOMS, CIOMS II Line 
Listing and Medwatch reports.

S. No. Profile Switch
Enterprise-Level 
Switch Notes
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On executing or running a report, it displays only the data that pertains to the 
logged-in enterprise.

Changes in Custom Reports
Custom Reports can be created as either specific to an enterprise or across all 
enterprises. 

To make custom reports available across all enterprises: 

■ Add the report in the Argus Insight folder in Cognos. Cognos comprises 
category-specific folders such as Pharmacovigilance, Management, etc. under the 
enterprise folder, where the custom report can be saved. 

■ Any user can add custom reports in the Argus Insight/Category folder.

To create custom reports specific to a particular enterprise:

■ Add the report in the enterprise/category-specific folder at the root level in 
Cognos. On doing so, the report cannot be viewed if you log in with a different 
enterprise.

■ Argus Insight users can view the enterprise/category-specific Custom Reports 
created through Cognos report studio along with the other available standard 
reports in their respective report category in the report library, based on the 
logged-in enterprise.

■ Custom Reports display data for only the logged-in enterprise. 

Report Changes while Saving and Accessing Report Writer Reports through Cognos 
Query Studio and Argus Insight

The 'Enterprise' is not available as an object while creating a new report in the report 
writer.

The reports created through report writer can be saved in the user specific folder.

The data that is displayed, is fetched from only the logged-in enterprise.
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Changes to Cubes
This section lists the changes that are applicable from this release onwards, for Argus 
Insight Cubes. 

Changes in Standard Cubes and Demand Cubes
Standard and Demand cubes cannot be configured for any of the enterprises in the 
CRO mode or Hosting mode. This is because enterprise-specific data segregation is not 
supported in Cubes.

In CRO or Hosting mode, the Datamart Reports tab is not displayed. This tab and its 
menu items are available for single-tenant mode and not for multi-tenant mode.
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Glossary

Glossary Term Element Structure is GlossEntry Followed by GlossTerm

The definition follows in a GlossDef element and a child Para or other appropriate 
element. The GlossDef element can contain informal examples, lists, and so on.

A LINE_OF_SYNTAX

Or you might have a line of code as part of your definition.

#

.CSV

In computers, a CSV (comma-separated values) file contains the values in a table as a series of ASCII 
text lines organized so that each column value is separated by a comma from the next column's value 
and each row starts a new line.

A

Adverse Experience

Any adverse event (AE) associated with the use of a drug or biological product in humans, whether 
or not considered product-related, including the following: An adverse event occurring in the course 
of the use of a drug product in professional practice;An adverse event occurring from drug overdose 
whether accidental or intentional; An adverse event occurring from drug abuse; an adverse event 
occurring from drug withdrawal; and any failure of expected pharmacological action. Reporting an 
adverse experience does not necessarily reflect a conclusion by the applicant or the FDA that the 
product caused or contributed to the adverse experience. Adverse experience is synonymous with 
adverse drug experience, adverse biological experience, adverse product experience, and adverse 
event.

Affiliate

Any individual or entity related by employment or organizational structure to the applicant, 
including all subsidiaries, whether domestic or foreign.

Applicant

An individual or entity who holds the new drug application (NDA), abbreviated new drug 
application (ANDA), or the biologics license application (BLA). For purposes of this glossary, this 
term includes any person whose name appears on the label of a marketed drug or licensed biological 
product as its manufacturer, packer, distributor, shared manufacturer, joint manufacturer, or any 
participant involved in divided manufacturing.

C

Causality Assessment

Determination of whether there is a reasonable possibility that the product is etiologically related to 
the adverse experience. Causality assessment includes (for example) assessment of temporal 
relationships, dechallenge/rechallenge information, association with (or lack of association with) 
underlying disease, presence (or absence) of a more likely cause, and physiologic plausibility.
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Challenge

Administration of a suspect product by any route

Chart

A picture defined in graphics primitives and graphics attributes.

Column

A character position within a print line or on display. The positions are numbered consecutively from 
1, starting at the leftmost character position and extending to the rightmost position. In relational 
database, a field defined for a given record.

Command

A way to start database administration functions to access and maintain the database manager. A 
statement used to initiate an action or start a service. A command consists of the command name 
abbreviation, and its parameters and flags if applicable.

D

Data Mart

A subset of a data warehouse that contains data that is tailored and optimized for the specific 
reporting needs of a department or team. A data mart can be a subset of a warehouse for an entire 
organization, such as data that is contained in online analytical processing (OLAP) tools.

Data Mart ETL

In Data Warehouse, the extract, transform, and load (ETL) process that extracts a subset of data 
from the central data warehouse, transforms it, and loads it into one or more star schemas. These 
schemas then can be included in data marts to answer specific business questions.

Data Mining

The process of collecting critical business information from a data warehouse, correlating the 
information and uncovering associations, patterns, and trends.

Data Warehouse

A central repository for all or significant parts of the data that an organization's business systems 
collect. A subject-oriented nonvolatile collection of data used to support strategic decision making. 
The warehouse is the central point of data integration for business intelligence. It is the source of 
data for data marts within an enterprise and delivers a common view of enterprise data.

Dechallenge

Withdrawal of a suspect product from the patients therapeutic regimen.

Disability

A substantial disruption in one's ability to conduct normal life functions.

E

Electronic Document

A document that is stored on the computer, instead of printed on paper.

Encode

Use the following procedure to convert data by the use of a code in such a manner that 
reconversion to the original form is possible.

Event Log

A log that contains information about events for a particular system or group, for a particular 
metric, or for all the events that are associated with a specific monitor.
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Expected Adverse Experience

Adverse experience listed in the current FDA-approved labeling for the drug or licensed biological 
product. This would include any section of the labeling that refers to adverse experience 
information.

F

Field

In a record, a specified area used for a particular category of data. For example, a record about an 
employee might be subdivided into fields containing the employee's name, address, and salary.

Field Description

Information that describes the characteristics of data in a field.

Field Format

A format in which the output consists of structured field introducers and variable data rather than 
output in line format.

Filter

A device or program that separates data, signals, or material in accordance with specified criteria.

Form

In query management, an object that describes how to format the data for printing or displaying a 
report. A display screen, printed document, or file with defined spaces for information to be 
inserted.

H

Home Page

The top-level web page of a portal. Sometimes used as a synonym for default portal page.

I

Initial Reporter

The original source of information concerning an adverse experience (e.g., consumer, healthcare 
professional).

L

Life-threatening Adverse Experience

An adverse experience that in the view of the initial reporter, places the patient at immediate risk of 
death from the adverse experience as it occurred. It does not include an adverse experience that, 
had it occurred in a more severe form, might have caused death.

N

Negative Dechallenge

Continued presence of an adverse experience after withdrawal of the suspect product.

Negative Rechallenge

Failure of the product, when reintroduced, to produce signs or symptoms similar to those observed 
when the suspect product was previously introduced.

P

Positive Dechallenge

Partial or complete disappearance of an adverse experience after withdrawal of the suspect 
product.

Positive Rechallenge

Reoccurrence of similar signs and symptoms upon reintroduction of the suspect product

Q
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Query

A request for information from the database based on specific conditions.

R

Rechallenge

Reintroduction of a suspect product suspected of having caused an adverse experience following a 
positive dechallenge.

Report

In query management, the formatted data that results from running a query and applying a form to 
it. Data that has been selected and extracted according to the reporting tool, the type of report 
desired and formatting criteria

Report Type

A data source and how it is mapped.

Role

A job function that identifies the tasks that a user can perform and the resources to which a user 
has access. A user can be assigned one or more roles. A definition of the access levels that users 
have and the specific resources that they can modify at those levels. Users are limited in how they 
can access information if they do not have the proper role. Multiple roles are permissible.

S

Serious Adverse Experience

An adverse experience occurring from any dose that results in any of the following outcomes:· 
Death· Life-threatening adverse experience · Initial inpatient hospitalization· Prolongation of 
hospitalization Significant or persistent disability/incapacity Congenital anomaly/birth defect 
(including that occurring in a fetus);· Important medical events, based upon appropriate medical 
judgment, that may jeopardize the patient or subject and may require medical or surgical 
intervention to prevent one of the outcomes listed above.

Spontaneous Report

A communication from an individual (e.g. health care professional, consumer) to a company or 
regulatory authority that describes a suspected adverse experience. It does not include cases 
identified from information solicited by the applicant such as individual cases or findings derived 
from a study.

Study

Any organized data collection system (e.g., adverse experience information derived from a clinical 
trial, patient registry including pregnancy registries). Reports from company sponsored patient 
support programs and disease management programs should be handled as if they were study 
reports and not as spontaneous reports.

Suspect Product

Drug or biological product associated with an adverse experience as determined by the initial 
reporter, regardless of the opinion of the applicant.

T

Type Ahead

The functionality that offers you to type-in a value and the like values are displayed in the listbox. 
It also enables you to select the desired value from the list of values.

U
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Unexpected Adverse Experience

Adverse experience not included in any section of the current FDA-approved labeling for the drug 
or licensed biological product. This includes an adverse experience that may differ from a labeled 
adverse experience because of greater severity or specificity (e.g., abnormal liver function versus 
hepatic necrosis). Adverse experiences listed as occurring with a class of drugs or biological 
products but not specifically mentioned with a particular drug or biological product are considered 
unexpected (e.g., rash with antibiotic X would be unexpected if the labeling said "rash may be 
associated with antibiotics"). This is because the labeling does not specifically state "rash is 
associated with antibiotic X." Reports of death from an adverse experience are considered 
unexpected unless the possibility of a fatal outcome from that adverse experience is stated in the 
labeling.

W

Web-based application

An application that is downloaded from the Web each time it is run. The advantage is that the 
application can be run from any computer, and the software is routinely upgraded and maintained 
by the hosting organization rather than by each individual user.

Web browser

A client program that initiates requests to a Web server and displays the information that the server 
returns.

Web page

Any document that can be accessed by a URL on the World Wide Web.

Web Server

A software program that is capable of servicing Hypertext Transfer Protocol (HTTP) requests.

Web Site

A related collection of files available on the Web that is managed by a single entity (an organization 
or an individual) and contains information in hypertext for its users. A Web site often includes 
hypertext links to other Web sites.

World Wide Web ( WWW Web)

A network of servers that contain programs and files. Many of the files contain hypertext links to 
other documents available through the network
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